Using
ADOBE® DIGITAL PUBLISHING SUITE
Legal notices
# Contents

## Chapter 1: Digital Publishing Suite overview
- Prepare to use the Digital Publishing Suite ........................................ 1
- Overview of digital publishing workflow ........................................... 1
- Installing digital publishing tools ...................................................... 3
- Using Adobe IDs for digital publishing ............................................. 5
- Getting started with the Digital Publishing Suite ............................... 7
- Digital Publishing Suite resources .................................................... 7
- Digital Publishing Suite pricing options .......................................... 8
- Single Edition overview .................................................................. 9
- What’s new in this release ............................................................... 11
- History of new feature release notes ............................................... 12
- New feature release notes (all languages) ........................................ 28
- Supported feature list ..................................................................... 28

## Chapter 2: Document Design
- Layout design overview ................................................................. 32
- Designing digital publications ......................................................... 32
- Smooth scrolling articles ............................................................... 33
- Swiping articles horizontally ........................................................... 34
- Using HTML for DPS .................................................................... 35
- Enabling pinch and zoom for articles .............................................. 35
- Creating source InDesign documents for DPS ............................... 36
- Creating documents for multiple devices ....................................... 39
- Creating DPS content for different iPad models ............................ 41
- Creating DPS content for the iPhone ............................................. 41
- Creating multi-rendition PDF articles for iOS devices ..................... 42
- Differences between iOS and Android viewers ............................. 44
- Structuring folders for imported articles ....................................... 45

## Chapter 3: Interactivity
- Overview of interactive overlays .................................................... 49
- Supported interactivity features ...................................................... 50
- Best practices for creating overlays ................................................ 51
- Hyperlink overlays ....................................................................... 52
- Slideshow overlays ....................................................................... 58
- Image Sequence overlays .............................................................. 60
- Panorama overlays ....................................................................... 61
- Audio & Video overlays ............................................................... 64
- Web Content overlays .................................................................. 66
- Pan and Zoom overlays ............................................................... 67
- Scrollable Frame overlays ............................................................ 68
- Nesting interactive overlays ......................................................... 69
## Chapter 4: Folios and Articles
- Create and manage folios ........................................ 71
- Create articles and layouts .................................. 78
- Import HTML articles ........................................... 81
- Create and manage articles .................................. 83
- Preview folios and articles .................................. 89

## Chapter 5: Assemble and Publish
- Produce and publish folios .................................. 94
- DPS publishing overview .................................... 94
- DPS Dashboard .................................................. 98
- Folio Producer Organizer ..................................... 99
- Assemble folio articles ........................................ 100
- Change folio settings ......................................... 100
- Create library filters .......................................... 100
- Folio Producer Editor ......................................... 101
- Create Sections ................................................ 103
- Import HTML Resources ..................................... 104
- Embed fonts in HTML articles ............................... 104
- Publish folios to the Distribution Service ............... 105
- Export folios for single-folio viewers ...................... 108
- Create folio renditions ....................................... 108
- Updating folios published with prerelease tools ........ 110
- Checklists for custom viewer apps ......................... 110
- DPS App Builder ................................................ 113
- Create a custom viewer app for the iPad and iPhone .. 113
- Create a custom viewer app for the iPad (Single Edition) .................................................. 122
- Create a custom viewer app for Android and Amazon devices ........................................ 123
- About custom viewer apps for PlayBook devices ....... 127
- Create a custom Adobe Content Viewer for iPad and iPhone ........................................ 127
- Creating an enterprise-signed viewer app ................. 128
- Creating a custom library (Enterprise) ................. 129

## Chapter 6: Analytics and Services
- Omniture analytics ............................................. 130
- Sell digital content ............................................. 131
- Account Administration tool ................................ 132
- Maintaining your DPS subscription ....................... 136
- Subscriptions and entitlement ............................... 137
- Push notifications .............................................. 137
- Using social sharing .......................................... 139
- Social media download counts ......................... 142

Last updated 2/8/2013
Chapter 1: Digital Publishing Suite overview

The Adobe Digital Publishing Suite lets mobile device viewers engage with interactive content in a magazine format. Creative designers who publish print magazines using Adobe® InDesign® CS5, InDesign CS5.5, or InDesign CS6 can make that content available on mobile devices. Publishers can supplement their designs with interactive content, allowing their audience to view media in an entirely different way. Customers can use hand gestures to flip through a slideshow, pan and zoom images, rotate objects 360°, and more.

Prepare to use the Digital Publishing Suite

Before you start creating digital publications, install the required tools, obtain and use the appropriate Adobe ID, and learn the essentials.

Related Articles

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Go here:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understand the digital publishing workflow</td>
<td>“Overview of digital publishing workflow” on page 1</td>
</tr>
<tr>
<td></td>
<td>“Getting started with the Digital Publishing Suite” on page 7</td>
</tr>
<tr>
<td>Install the Folio Producer tools</td>
<td>“Installing digital publishing tools” on page 3</td>
</tr>
<tr>
<td>Use a valid Adobe ID</td>
<td>“Using Adobe IDs for digital publishing” on page 5</td>
</tr>
<tr>
<td>Install Adobe Content Viewer on mobile devices</td>
<td>“Preview folios and articles” on page 89</td>
</tr>
</tbody>
</table>

Overview of digital publishing workflow

Adobe InDesign is the central component of the workflow. Using InDesign, design teams create layouts and add interactivity. With layouts in hand, production teams assemble the layouts, add metadata, and publish them into a “folio” format.

Anyone who uses InDesign CS5 or later can author, preview, and share digital publishing folios. However, to create custom apps for commercial use, you need to do one of the following:

- Subscribe to the Digital Publishing Suite with a Professional or Enterprise account. A DPS subscription lets you create unlimited apps for Apple App Store, Google Play Store, and Amazon Appstore.
- Obtain an Adobe Creative Cloud membership. With a Creative Cloud membership, you can create unlimited single-folio apps (iPad only).
- Obtain a Single Edition license to create a single viewer app (iPad only).
Getting your InDesign layout onto your iPad

**Step 1: Install Folio Producer tools**
If you’re new to the Digital Publishing Suite, install the newest version of DPS tools. For InDesign CS6, choose Help > Updates, and install the DPS Desktop Tools. For InDesign CS5/CS5.5, install both the Folio Producer tools and the Folio Builder panel. The Folio Producer tools installer installs or updates the Folio Overlays panel, a required plug-in, and the Desktop Viewer. The Folio Builder panel installer installs only the Folio Builder panel. See “Installing digital publishing tools” on page 3.

If you have an iPad or an Android device, install the most current version of the Adobe Content Viewer from the store (Apple App Store, Google Play Store, or Amazon Appstore).

**Step 2: Create source documents in InDesign**
Create InDesign documents as the base layout for the digital content. With InDesign CS5/CS5.5, you can create both a portrait (vertical) and landscape (horizontal) layout in separate documents for each article. With InDesign CS6, you can create horizontal and vertical layouts within the same document. You can also limit your design to a single orientation. See “Designing digital publications” on page 32.

In addition to using InDesign files as source content, you can also create articles based on HTML. See “Import HTML articles” on page 81.

**Step 3: Add interactive objects**
Use the Folio Overlays panel to create and edit interactive objects. Not all InDesign interactivity features are supported. See "Interactivity" on page 49.

💡 To see examples and how-to instructions for each overlay type, download the Digital Publishing Suite Tips app on your iPad or other mobile device.
Step 4: Use the Folio Builder to create folio and articles
Signing in to the Folio Builder panel is optional. If you sign in using a verified Adobe ID, folios you create are uploaded to an acrobat.com site. You can then download these folios to the Adobe Content Viewer app by signing in using the same account. If you have a Creative Cloud membership, sign in using your Creative Cloud account. If you do not have a verified Adobe ID, go to https://digitalpublishing.acrobat.com/, click Create Account, and follow the prompts.

Use the Folio Builder panel to create or open a folio and add articles. Each article can have two layouts for horizontal and vertical orientations. See “Folios and Articles” on page 71.


Step 5: Preview and share articles
To preview the folio using the Adobe Content Viewer for the Desktop, select a folio or an article in the Folio Builder panel and click Preview. See “Use the Desktop Viewer to preview content” on page 90.

To preview the folio on mobile devices such as the iPad, install the free Adobe Content Viewer on the device, and then sign in using the same Adobe ID you used to sign in to the Folio Builder panel. Use the viewer library to download and view folios. See “Preview folios and articles” on page 89.

Use the Share command in the Folio Builder panel to share a folio with other people. Anyone with a valid Adobe ID can view the folio you share with them for free. When they use the Adobe ID to sign in to the Adobe Content Viewer, any folios you shared with them are available for downloading. See “Share folios” on page 78.

Step 6: Make folios available to customers (Subscribers and Single Edition only)
If you’re a Professional or Enterprise customer, use the Folio Producer Organizer to put the finishing touches on the folio and publish it to the Distribution Service to make it publicly available. See “Assemble and Publish” on page 94.

Use the DPS App Builder to create a custom viewer app that you can submit to the Apple Store, Google Play Store, or Amazon Appworld. If you have a Creative Cloud membership or if you obtain a Single Edition license, you can create a single-issue app for the iPad. If you have a Professional or Enterprise account, you can enable subscriptions (iOS and Amazon), push notifications (iOS only), and Omniture analytics. See “DPS App Builder” on page 113.

Step 7: Analyze customer data and add and update folios (DPS Subscribers only)
After you publish your folio, use the Analytics page on the Digital Publishing Suite Dashboard to track user data. See “Omniture analytics” on page 130.

Continue to add folios to your multi-folio custom viewer.

Installing digital publishing tools
The Adobe Digital Publishing Suite is available for InDesign CS5, InDesign CS5.5, and InDesign CS6. To install the full set of tools for InDesign CS6, run the DPS Desktop Tools installer by choosing Help > Updates in InDesign. To install the full set of digital publishing tools for InDesign CS5/CS5.5, two separate installations are required. Install both the Folio Producer tools and the Folio Builder panel.

AIR 2.x is required to run AIR applications such as the Desktop Viewer. The most current version of AIR is available at http://get.adobe.com/air/.

If you experience problems installing the tools, see Installation Issues.
Installation links
CS6 DPS Desktop Tools (Windows)
CS6 DPS Desktop Tools (Mac OS)
CS5.5/CS5 Folio Producer tools (Windows)
CS5.5/CS5 Folio Producer tools (Mac OS)
CS5.5/CS5 Folio Builder panel (Windows)
CS5.5/CS5 Folio Builder panel (Mac OS)
Archive of older Folio Producer tools (Windows)
Archive of older Folio Producer tools (Mac OS)

Installing the DPS Desktop Tools (InDesign CS6)
❖ In InDesign, choose Help > Updates, and update DPS Desktop Tools.
   The DPS Desktop Tools installer installs the Folio Overlays panel, the Folio Builder panel, a required InDesign plugin, and the Desktop Viewer.
   
   **Note:** Whenever a new version is released, it can take a few days for the newest installer to be included in the InDesign Updates installer. During this period, you can update the DPS Desktop Tools by clicking the link in the Folio Builder panel or by downloading the most current installer from the DPS Dashboard or the Adobe Downloads page.

Installing the Folio Producer tools and Folio Builder panel (InDesign CS5/CS5.5)
1 Exit InDesign.
2 Install the DPS Tools.
   Windows: Download Folio Producer tools (Windows)
   Mac OS: Download Folio Producer tools (Mac OS)
3 Install the Folio Builder panel.
   Windows: Download Folio Builder panel (Windows)
   Mac OS: Download Folio Builder panel (Mac OS)

Installing the Adobe Content Viewer on a mobile device
If you have an iPad, an Android device, or a PlayBook, install the most current version of the Adobe Content Viewer from the store. In the store, search for “Content Viewer.”

Updating the DPS Desktop Tools (InDesign CS6)
Whenever a new set of tools is released, choose Help > Updates in InDesign and update the DPS Desktop Tools. If you need to create folios that are compatible with an earlier viewer (v20 or later), you can use the Folio Builder panel to target that viewer version.

Updating the Folio Builder panel and/or the authoring tools (InDesign CS5/CS5.5)
The Digital Publishing Suite tools are updated frequently. Whenever there is a new release, the Folio Producer Service is updated on the web. There is a separate installer for the Folio Builder panel so that you can update the panel without updating your tools. Whenever Adobe updates the web client, update the Folio Builder panel to make sure that the web client and the Folio Builder panel remain in sync.
Using Digital Publishing Suite

Digital Publishing Suite overview

Note that updating the Folio Builder panel does not update your authoring tools. The Folio Builder panel updates are available on the Adobe Downloads pages:

Windows: Download Folio Builder panel (Windows)

Mac OS: Download Folio Builder panel (Mac OS)

You also have the option of updating the authoring tools when a new version is released. When you update the authoring tools, any folio you publish is not compatible with any pre-v20 viewer version. For v20 viewer versions and later, update the authoring tools, and you can specify the viewer version when you create a folio. See “Create a folio” on page 72.

With InDesign CS5/CS5.5, you may need to revert to a previous set of Folio Producer tools to be compatible with an older custom viewer (v19 or earlier). Uninstall the Folio Producer tools, and then download and install the appropriate version. Older tools are available on these pages:

Windows: Archive of older Folio Producer tools (Windows)

Mac OS: Archive of older Folio Producer tools (Mac OS)

To see a table that matches tool versions to viewer versions, see the Please update your app tech note.

Uninstalling the digital publishing tools (InDesign CS5/CS5.5)

To uninstall the Folio Producer tools, do either of the following:

- In Windows, use the Control Panel (Add/Remove Programs) to uninstall the tools.
- In Mac OS, use the uninstaller located in Applications > Utilities > Adobe Installers.

In InDesign CS6, the digital publishing tools are integrated with InDesign. You can remove the DPS tools only by uninstalling InDesign.

Using Adobe IDs for digital publishing

The Folio Builder panel, Digital Publishing Suite Dashboard, and DPS App Builder all require a verified Adobe ID to sign in.

Signing in to the Folio Builder panel is optional. If you don’t sign in, you can create local folios and preview them using the Desktop Viewer or the Adobe Content Viewer on a mobile device. Signing in to the Folio Builder panel lets you upload folios to the acrobat.com server. You can download these folios to your mobile device or share them with other users.

Creating and verifying an Adobe ID (non-subscribers)

If you’re not a subscriber to DPS or Creative Cloud, you can use DPS tools to create and share folios. To create individual Adobe IDs, go to https://digitalpublishing.acrobat.com/ and click Create Account. Sign up for an account using a valid email address. Adobe will send you a verification message. Open that message and verify it. Use the Adobe ID to sign in to the Folio Builder panel, Dashboard, or DPS App Builder.

Creative Cloud membership

If you have a Creative Cloud membership, use the Creative Cloud account to sign in. When you sign in to the DPS App Builder using the Creative Cloud account, you can build iPad apps that you can submit to Apple.
Adobe ID tied to application (Professional and Enterprise subscribers)

You can use an Adobe ID for an individual (such as “johnsmith@gmail.com”) to sign in to the Folio Builder panel and create folios. However, if you're publishing a multi-folio viewer app, such as a monthly magazine, we recommend that you use an Adobe ID specifically for that application, such as “dps.publication@publisher.com”). Use the Account Administration tool to assign the application role to an email account.

The Adobe ID you use to sign in to the Folio Builder panel is tied to the Adobe ID (called the “Title ID”) you specify when creating the viewer app in DPS App Builder.

For example, suppose that you belong to a company called Sporty and you publish magazines about kayaking and cycling. For best results, create one Adobe ID called “dps.kayaking@sporty.com” and another called “dps.cycling@sporty.com.”
When creating and publishing folios about kayaking, use the kayaking Adobe ID to sign in to the Folio Builder panel and Folio Producer. When creating the custom viewer app for kayaking, you specify the kayaking Adobe ID in the Title ID field in DPS App Builder. (The Adobe ID you use to sign in to the DPS App Builder may be a different Adobe ID, depending on the settings in the Account Administration tool.)

Similarly, for the cycling app, you would use the cycling Adobe ID to create and publish folios, and you would specify the cycling Adobe ID as the Title ID in DPS App Builder.

Folios you publish using the kayaking Adobe ID appear in the kayaking app. Folios you publish using the cycling Adobe ID appear in the cycling app.

Creating delegate Adobe IDs (subscribers)
A delegate Adobe ID is attached to a specific publishing account and can be used only for that account. If you want to use an email address as a delegate Adobe ID, use the Account Administration tool to create the Adobe ID. If you use a different method to make an email address an Adobe ID, that email address cannot become a delegate Adobe ID.

If you’re a Professional or Enterprise subscriber, use the Account Administration tool to assign a different role to the Adobe ID so that you can use it to create an application or to sign in to the DPS App Builder. See "Account Administration tool" on page 132.

Getting started with the Digital Publishing Suite

Video tutorials
Colin Fleming created a series of videos on using the Digital Publishing Suite tools. These video tutorials and others are available on AdobeTV.

AdobeTV - Learn Digital Publishing Suite
In addition to the videos in the DPS Learn channel, a number of other videos are also available in the AdobeTV - Digital Publishing Channel

Web tutorials
To get a basic overview of the DPS workflow, download sample assets and step through Authoring Tutorials.

For more extensive learning, download a different set of assets and step through Digital Publishing Suite hands-on tutorial.

More Help topics
“Overview of digital publishing workflow” on page 1
“Digital Publishing Suite resources” on page 7

Digital Publishing Suite resources
In addition to this help system, the following digital publishing resources are available:

User forums
Go to the public Digital Publishing Suite user forum to ask questions and participate with other customers.
Adobe websites
- The Digital Publishing Suite Help and Support page provides common support questions and links to useful articles and content.
- The Digital Publishing Suite product page offers overview examples, pricing information, a digital publishing FAQ page, and more.
- The Digital Publishing Gallery provides links to publications created using the Digital Publishing Suite tools.
- The Digital Publishing Suite Developer Center offers resources for advanced tasks such as understanding analytics and setting up push notifications.
- The DPS Status page provides information about ongoing server outages and planned maintenance.

Learning resources
The Digital Publishing Suite Tips app is available in the Apple App Store. It’s like a combination of a user guide, a blog, and a cookbook. This app is also available in Google Play Store and Amazon Appstore (search for “DPS Tips”). If you don’t have an iPad or mobile device, you can view DPS Tips issues on a computer.

To learn about the digital publishing process and experiment with sample files, go to DPS Authoring Tutorials or Digital Publishing Suite hands-on tutorial.

Follow the Digital Publishing Suite Twitter feed or the Digital Publishing Suite Facebook page.

Documents about publishing viewer apps
- The iOS Publishing Companion Guide for Professional and Enterprise PDF and the Step-by-Step iPad Publishing Guide for Single Edition PDF walk you through the process of creating the required certificates, splash screens, and icons for submitting a custom viewer app to the Apple App Store. You can download these guides from the Help menu in DPS App Builder.
- The Publishing Process for Android Mobile Devices Guide explains how to create a custom viewer app to submit to the Google Play Store or Amazon Appstore.

More Help topics
“Getting started with the Digital Publishing Suite” on page 7

Digital Publishing Suite pricing options
How much does it cost to use the Digital Publishing Suite? It depends on what you’re trying to do. Here are the options:

Free  If you have InDesign CS5 or later, you can install the digital publishing tools for free. You can create folios, preview them on your desktop and mobile devices, and share them with individuals. Using the DPS tools costs additional money only if you want to publish folios and create custom viewer apps that you can submit to stores.

Creative Cloud Membership  Obtain an Adobe Creative Cloud membership. With a Creative Cloud membership, you can create unlimited single-folio apps for the iPad.

Single Edition  If you’re not a Creative Cloud member, you can pay a one-time fee to create a custom application for the iPad that contains a single folio. See “Single Edition overview” on page 9.

Professional Edition  With the Professional Edition subscription, you pay a monthly fee to create an unlimited number of custom viewer apps and folios. You can build either single-folio apps or multi-folio apps for the iPad. You can build multi-folio apps for Android, Amazon, and iOS (iPad and iPhone) platforms. You can also create multi-folio
subscription apps for the iPad and Amazon stores. With the Professional Edition, you get basic analytic reports to track user data.

**Enterprise Edition** Enterprise Edition includes everything in Professional Edition, plus the ability to customize the viewer UI, create custom entitlement servers, and create in-house (private) enterprise apps.

Click here for more information on pricing: www.adobe.com/products/digitalpublishingsuite/pricing/

**More Help topics**

“Types of custom viewer apps” on page 94

“Getting started with the Digital Publishing Suite” on page 7

**Single Edition overview**

The Single Edition model provides small to midsize design studios and freelance designers a way to deliver brochures, catalogs, portfolios, and training materials to the iPad. To create a custom app for the iPad that contains a built-in folio, either become an Adobe Creative Cloud member or pay a one-time fee. If you have a Creative Cloud membership, you can create an unlimited number of Single Edition iPad apps.

**Requirements**

What you’ll need to create your folio:

- InDesign CS5, InDesign CS5.5, or InDesign CS6.
- DPS Desktop Tools (Folio Overlays panel and Folio Builder panel).

What you need to build your app:

- A Mac OS computer running Mac OS X 10.6 (Snow Leopard) or 10.7 (Lion). Apple requires a Mac OS computer to create required certificates and upload the app. You can use a Windows computer to build your folios in InDesign.
- DPS App Builder.
- A Creative Cloud membership or a Single Edition serial number.

**Single Edition videos and resources**

Use your Creative Cloud account to sign in to the Getting Started page, watch videos, and download useful assets.

https://creative.adobe.com/#dpsse

These videos and more appear on AdobeTV.

**DPS Single Edition Learn Channel**

The “DPS Tips” iPad app includes a “Single Edition” issue that steps through the end-to-end process of using the Single Edition model to create and submit an app to Apple. In App Store or the iTunes Store, search for “DPS Tips.”
Steps to create a single-folio viewer app
Follow these general steps to create your custom viewer app and submit it to the Apple Store.

**Step 1: Understand the Basics** Before you start using InDesign to create content, get a basic understanding of the process. Watch videos, step through tutorials, and browse through help topics. See “Getting started with the Digital Publishing Suite” on page 7.

**Step 2: Install the digital publishing tools** For InDesign CS6, install the DPS Desktop Tools. For InDesign CS5 or CS5.5, run two separate installers. First, install the Folio Producer tools to add the Folio Overlays panel, a required InDesign plugin, and the Desktop Viewer. Then install the Folio Builder panel. See “Installing digital publishing tools” on page 3.

**Step 3: Create and Preview Your Folio** Use the Folio Builder panel to create your folio. Preview your folio using the Adobe Content Viewer app on the iPad. When your folio is complete, select it, and choose Create App from the Folio Builder panel menu.

**Step 4: Subscribe to Creative Cloud or Obtain Single Edition Serial Number** If you have a Creative Cloud membership, you can create an unlimited number of iPad Single Edition apps. Or, use the Adobe website to purchase your Single Edition serial number. If Single Edition is not yet available in your region, sign up to be notified when it becomes available.

In addition, download the Adobe Content Viewer to your iPad. When you create a folio, the content is uploaded to a web client powered by acrobat.com. Use the viewer to download and preview that folio. Search for “Adobe Content Viewer” in the iPad App Store or in the iTunes Store.
Obtain the Single Edition serial number required to build the app.

**Step 5: Download the Step-by-Step Guide** The Step-by-Step iPad Publishing Guide for Single Edition includes the information you need to create the required images and certificates, sign up as an Apple developer, build the iPad app, and submit it to Apple.

You can also download the Step-by-Step Publishing Guide from the Help menu in DPS App Builder.

### What’s new in this release

The following features are available for the v25 release. For a compilation of release notes, see “History of new feature release notes” on page 12. For a list of bug fixes, see DPS Bug Fix Release Notes.

**Library UI improvements (iPad only)** The iPad viewer library was redesigned to include larger grid cover images. Tapping a cover image of a downloaded folio opens the folio. Tapping a cover image of a folio not yet downloaded opens a preview pane. Readers can use the gear menu button to select and remove folios.

Folio view includes several changes. The Home button is now the Library button in multi-folio apps. The function of the Browse button and the bottom scroll bar are now combined. Use the scroll bar to swipe through articles in browse mode. The arrows next to the scroll bar that jump to the next or previous article have been removed.

In DPS App Builder, you can also remove the Subscribe and Sign In buttons that appear in the upper left corner of the library in Enterprise subscription apps. The redesign requires larger subscription tile images for subscription apps.

**First retail folio free** By selecting an option in the Account Administration tool, publishers can make the most recently published retail folio available to users who download the app for the first time. See “Account Administration tool” on page 132.

**Conditional HTML content (Enterprise only)** Designed to be used with the first folio free feature, this feature enables a publisher to create either an HTML article or a Web Content overlay that displays different content depending on how the folio was obtained. For example, if a user downloads a complimentary folio, the content can include a subscription offer. If a user obtains the folio through a subscription, the content can offer additional products.

To set up this conditional HTML content, do two things. First, select the Allow Access to Entitlement Information option for the Web Content overlay or the HTML article (see “Web Content overlays” on page 66). Second, add a custom JavaScript API to your HTML code. For more information about this JavaScript API, contact your Adobe representative.

**Auto-download latest entitled issue** When this DPS App Builder setting is selected, the most recent entitled issue is downloaded automatically—either the first free retail folio if enabled or the most recently published free folio. The purpose of this option is to provide a better experience for first-time app users. See “App Details panel” on page 114.

**Automatically open background-downloaded issue** When this DPS App Builder setting is selected, any folio that is downloaded in the background since the previous viewing session opens on app launch. If this option is not selected, the most recently viewed folio is opened in its last reading position. See “App Details panel” on page 114.
Open folio to last-read article  When you switch between folios, the previously viewed folio is no longer reset. Instead, the viewer remembers the reading position of all folios. To reset a folio, display the navigation bars in an article and triple-tap the title bar.

Dynamic subscriptions (Enterprise only)  Publishers can add or remove subscription options on an ongoing basis without having to update the app. This allows publishers to evaluate subscription durations to determine the best set of options. For details about editing the custom library API to enable dynamic subscriptions, contact your Adobe representative.

Streamlined testing of Amazon apps  When you use DPS App Builder to create an app (.apk file) for Amazon, you can now load and test the .apk file on the Amazon device without having to load a separate .json file. Using a .json file is now required only to test retail content. For details, see DPS Publishing Process for Amazon and Android Devices.

Local storage support on Android apps  In previous versions, Android viewers did not support local storage. Quitting an app resulted in losing the reading position or form fill-in data. With v25 Android apps, this information is now preserved, as it is in iOS apps.

goto:// navigation (Enterprise only)  The goto:// format lets Enterprise publishers create links in folio view to any custom icon content in the library. For example, if you create a custom icon in DPS App Builder with a “Store” label, you can create a button with a “goto://ApplicationViewState/Store” action that automatically opens the Store HTML content—just like tapping the custom Store icon. See “Create goto links to custom icons” on page 56.

Hide top navigation bar  When this DPS App Builder setting is selected, only the bottom navigation bar is displayed when a user taps an article. This enables publishers to create a persistent navigation bar on all article pages for navigating within the folio.

Automated workflow API improvements (Enterprise only)  When using APIs for automated DPS publishing workflows, you can now publish and update folios and update article metadata (updating articles is planned for a future release).

Facebook sharing enhancements for iOS6  If users have entered their Facebook account information in their iOS Settings, they will be seamlessly signed in when sharing an article to Facebook instead of receiving a sign-in prompt.

SiteCatalyst analytics improvements  SiteCatalyst includes enhancements such as reporting the playback duration of videos.

Generate fulfillment download reports  Publishers can now generate reports to view download data from the Adobe Distribution Service. If you sign in to the DPS Dashboard using an Application account, you can choose the Fulfillment Report option to download a .csv file that includes billable download statistics from the Adobe Distribution Service for that app. If you sign in using an Admin account, you can click a link in the Dashboard to obtain a report that shows your fulfillment download balance. See “Omniture analytics” on page 130.

iOS4 no longer supported  The v25 viewers no longer support iOS4. The v25 viewers support only iOS5 or later.

History of new feature release notes

The Digital Publishing Suite tools are updated frequently. For a list of bug fixes, see DPS Bug Fix Release Notes.

Release 25 (current)  
To view a description of the new features in the current set of tools, see “What’s new in this release” on page 11.
Release 24

Library background downloading (iOS) When your customers are downloading any folio in a v24 app, they can leave the app, check email or view a different folio, and then come back later to find the folio downloaded. Note that the download pauses after ten minutes. Only one folio can be downloaded at a time.

Update multiple articles at a time You can select multiple articles in the Folio Builder panel and choose Update to update all the selected articles. To select articles, Shift-click or Ctrl/Command-click the articles.

Sections The new Sections feature will eventually allow your customers to download individual sections of a folio. For example, you can divide a folio into News, Sports, Business, Style, and Money sections, and your customers could download only the articles in the Sports and Money sections if they so choose. See “Create Sections” on page 103.

Disable Cover View in iPad viewer library By default, all iPad viewer libraries include both a Grid View and a Cover View, which displays only one folio at a time. With the v24 DPS App Builder, you can select an option to include only the Grid View or both the Grid View and Cover View on iPads. (With Android viewers, you can already choose Grid View, Cover View, or both.)

DPS UI enhancements When you create a folio, an Orientation setting is no longer selected by default. If you click OK without selecting an Orientation setting, a red box appears around the option. This change should help avoid mistakenly creating a folio with an incorrect orientation setting.

In addition, many error messages now include links that direct you to a tech note.

Folio publishing enhancements When a folio fails to publish properly due to a server error, you can click a Retry button to resume the publishing process after the server issue is resolved.

Improvements to DPS servers The bandwidth of the Adobe Distribution Service has been increased, resulting in improved stability and performance.

In addition, DPS servers are now in a separate cluster on acrobat.com, allowing folios to be uploaded and downloaded even if acrobat.com is undergoing maintenance.

“Restore Purchases” change The “Restore Purchases” dialog box now appears only when users choose Restore Purchases from the library options menu.

Enable caching of folio information in library (iOS) In DPS App Builder, you can cache folio information to improve performance for apps with large libraries. Note that selecting this option can cause folio information to become out of date. For example, if you select this option and change the cost of retail folios, your library will display misleading information. This option is currently available only for subscription apps.

Improvements for Enterprise-signed apps (iOS, Enterprise only) You can now sign an in-house application with an enterprise mobileprovision file that contains an explicit (non-wildcard) application ID. This change lets you manage the application independently from other apps in your organization.

Analytics enhancements SiteCatalyst now makes a distinction between different types of mobile devices and different operating systems. A new URL tracking report allows you to track actual URLs, URL clicks, the source of the URL (Hyperlink overlay, Web Content overlay, or application) and how the URL is opened (in Web Wiewer, in application viewer, or in device browser). App usage reports let you track peak day/time usage of the apps and number of launches since last update. These changes affect only SiteCatalyst analytics, not baseline analytics.

Release 23

Updated Distribution Service infrastructure Publishing folios to the Distribution Service is now significantly faster. These server changes should result in fewer timeout errors and increased reliability in background downloads for iOS Newsstand.

Folio Builder panel UI improvements The Folio Builder panel is wider, the navigation icons are larger and more intuitive, there are more tooltips and information bubbles, options are renamed for clarity, and other improvements
make the panel easier to use. You can also launch the DPS App Builder (previously called Viewer Builder) from the panel menu.

**Changes to DPS App Builder (previously called Viewer Builder)** The DPS App Builder includes several interface improvements. The InDesign CS6 installer now installs the DPS App Builder.

**Drag and drop files into DPS App Builder** You can now drag and drop icons, splash screens, and other files from Finder into App Builder.

**Choice between vector and bitmap for slideshows and scrollable frames (iOS only)** In overlays for PDF articles, you can select Vector or Bitmap. Vector images look sharper but require a small load time. For overlays in JPG/PNG articles, slideshows and scrollable frames are always bitmap.

**Multi-rendition articles (iOS only)** You can now create PDF articles that look great and perform well on both SD and HD versions of devices. When creating overlays, you can include both SD and HD assets in the folio. The viewer uses the appropriate overlay assets for the specific iOS device.

If you’re creating a single-folio app, you can create a folio using PDF articles that work well for all iPad models. If you’re creating a multi-folio app, you can choose between creating multi-rendition articles in a folio or creating separate folio renditions. See “Creating multi-rendition PDF articles for iOS devices” on page 42.

**Unlimited Single Edition folios with Creative Cloud membership (iPad only)** With an Adobe Creative Cloud membership, you can create unlimited single-folio apps for the iPad.

**Play audio in background (iOS only)** Audio clip can play while users browse through articles in the folio. An audio button appears in the top navigation bar to let users pause and play the audio. See “Audio & Video overlays” on page 64.

**Stop on Last Frame (iOS only)** The Folio Overlays panel now includes an option for stopping the inline video at the last frame.

**Disable controls for inline videos (iOS only)** If you create an inline video set to Auto Play, you can select the Do Not Allow Pause option to disable playback controls. This feature is especially useful for cover videos.

**New Adobe Content Viewer behavior for invalid folios** In previous releases, invalid folios failed to appear in the Adobe Content Viewer. With the new release, invalid folios appear in the library and result in an error message on download. This change improves the Adobe Content Viewer library performance and provides more detailed preflighting information. For example, if you create a dual-orientation folio with one or more single-orientation articles, the error message indicates the problem rather than leaving you to guess.

**PDF support for Smooth Scrolling articles (iOS only)** You can use the PDF image format for Smooth Scrolling articles regardless of their length. However, article pinch and zoom is not supported in any Smooth Scrolling article.

**“Rate the App” option** When you create a custom viewer, you can select an option that allows a “Rate the App” prompt to appear. You can customize settings for this feature in the DPS App Builder.

**Hot Zones for displaying navigation bars** In addition to the hot zones on the sides of the article page, there is a new hot zone option for the bottom of the article page. Tapping in the hot zone area at the bottom of the page displays the navigation bars (also called the “HUD”). Tapping anywhere above the bottom hot zone does not display the navigation bars. See “App Details panel” on page 114.

Buttons take precedence over the bottom hot zone, the bottom hot zone takes precedence over the side hot zones, and hot zones take precedence over all non-button overlays.

**Go To Next/Previous Page support** When you create a button, the Go To Next Page and Go To Previous Page actions are now supported.

**Analytics opt out option** In the DPS App Builder, you can allow your customers to turn off analytics while using your app. This option is especially useful in certain regions with strict controls over data collection.
Customizable viewer strings You can customize all strings stored in the viewer in all supported languages, including button text in the library and text in dialog boxes. The DPS App Builder lets you download an XML template. You can then edit this XML file and specify it while building your app. See “App Details panel” on page 114.

Social Sharing enhancements (iOS only) Note the following Social Sharing improvements. See “Using social sharing” on page 139.

- Support for Web Viewer direct entitlement (Enterprise only). When customers hit the paywall limit in Web Viewer, they can now sign in using their subscription account to continue viewing articles.
- Web Viewer supports Internet Explorer 10/Windows 8.
- You can also set up a paywall for free folios.
- The Web Viewer supports all overlays except for panoramas and audio clips.
- If you create a 1024x768 folio using PDF image format, the content is now uploaded to the Web Viewer server in PNG format.


Library Filters If you create v22 folios or later, you can use the Folio Producer Organizer to specify a filter category for each folio, such as “English,” “Spanish,” “French,” and “German.” In your viewer library, users can then choose filter options. For example, they can display only Spanish and German folios and hide English and French folios in the viewer library. See “Create library filters” on page 100.

Custom HTML library Enterprise publishers can create their own library instead of using the default viewer library. See “Creating a custom library (Enterprise)” on page 129.

Hot Zone enhancements Both Enterprise and Professional publishers can now enable Hot Zones in DPS App Builder. Hot Zones let users tap the edges of the article to browse to the next or previous articles. The logic for overriding overlays has also changed. Hot Zones take precedence over all overlays with the exception of buttons. See “App Details panel” on page 114.

Strict renditions for Android 7” devices By default, viewers on Android devices display folios of any size. To ensure that the viewer displays only folios that match the device size, you can select an option in Viewer Builder. At this time, strict renditions displays only 1024x600 folios for devices such as the Kindle Fire and 1280x800 folios for XLarge Android devices. This option is primarily useful for preventing unwanted folio renditions from appearing on Kindle Fire devices. If you have created Android renditions such as 1232x752 folios, do not turn on strict renditions when you create the viewer for the Android marketplace. See “Create a custom viewer app for Android and Amazon devices” on page 123.

Auto Hide Scrollbars By default, a 6-pixel scrollbar area appears on the right side of articles in a folio. If you select this option in Viewer Builder, the scrollbar appears only when the user is scrolling in the article. See “App Details panel” on page 114.

HTML video improvements You can now make videos in HTML articles behave like video overlays. For example, rotating the device in a single-orientation HTML article also rotates the full-screen video. See “Import HTML articles” on page 81.
AIR captive runtime in Android viewers  Instead of relying on AIR to be installed on Android devices, viewers now include a built-in version of AIR (3.2 or later). While this change increases the size of viewers from about 2 MB to 10 MB, it should improve stability and performance.

Improvements to Android viewer UI  Icons and other UI elements in library view and folio view are now larger, making it easier to tap icons, especially on the Kindle Fire.

Two-finger swiping enabled for iOS  The two-finger swipe gesture is now enabled for iPad and iPhone viewers. This gesture is especially useful for “flattened” articles in which Horizontal Swipe Only is enabled, allowing readers to bypass the rest of the article pages to jump to the next or previous article.

Social Sharing enhancements  Note the following Social Sharing improvements. See “Using social sharing” on page 139.

- Social Sharing is now supported in iPhone viewers.
- Rendition mapping is now supported. When the shared article is viewed in a desktop web browser, only 1024x768 PNG or JPG articles appear properly in the Web Viewer. In previous versions, any folio shared from an iPad HD rendition (2048x1536) could not be viewed in Web Viewer. If you create renditions for iOS devices, sharing the article from any device will now map to the 1024x768 version of the article in Web Viewer. For best results, make sure that your renditions are set up properly and that your Article Name values are identical in each folio rendition.
- Facebook deep-linking is now supported. When a customer views the wall post in the Facebook app on an iPad, tapping the article link opens the article directly. Make sure that you enable deep linking when configuring your app on the Facebook developer site. See Setting up a DPS App for Social Networking.
- The new Enable Fulfillment Limit option in the Account Administration tool lets you limit the number of article views in Web Viewer, similar to a “Sold Out” feature. See “Account Administration tool” on page 132.
- The Web Viewer now supports scrollable frames.
- Enabling a paywall affects only retail folios.

Release 21
Viewer Version control  When you create a new folio using the v21 Folio Builder panel, you can target either the v20 or v21 viewer version. This option is especially useful if either the newest version of the Adobe Content Viewer is awaiting approval or if you’re creating folios for a v20 viewer app. By default, the v20 version is selected. If you create a v20 folio, you can edit the folio’s properties to update it to v21. However, you cannot roll back a v21 folio to v20. You also cannot specify a viewer version earlier than v20. See “Create a folio” on page 72.

Preview on Device for active layout (iOS)  Before v21, Preview on Device was available only for entire folios. With v21, you can now use Preview on Device in the Folio Overlays panel to preview the current layout (iOS only). Connect your iPad or iPhone to your computer and open the Adobe Content Viewer app. In the Folio Overlays panel, choose Preview on [device name]. See “Use Preview on Device” on page 93.

Social Sharing improvements  Several Social Sharing limitations have been addressed. Nested overlays, buttons, videos, HTML articles, and scrollable frames now work much better in the Web Viewer. In addition, the Web Viewer now displays articles marked as Advertisement or Hide from TOC properly. See “Using social sharing” on page 139.

You can use the Account Administration tool to turn off Web Viewer while still enabling social sharing through the iPad. See “Account Administration tool” on page 132.

Auto-view during folio download  When the Download or Buy button is tapped in the viewer library, the viewer displays the folio while remaining articles continue to download. Before this release, the View button became active during download, but the user had to tap it to begin viewing the folio.

Auto-download on subscription purchase  When a user successfully subscribes to a viewer app, the most recent folio begins downloading automatically. Users no longer need to tap the Download button.
Cover Date  The Cover Date option is now available in the Folio Producer Organizer. This option gives Enterprise publishers additional metadata control in direct entitlement of subscription content.

Release 20

InDesign CS6 compatibility  InDesign CS6 includes several new features that simplify creating InDesign source files. With the Alternate Layout and Liquid Page Rules features, you can create layouts for different orientations and target devices within the same document. Flexible Column Widths, Auto Size Text Frames, and Split Layout View also help with dynamic layouts. In addition, Insert HTML lets you quickly create a Web Overlay by copying code, and packaging an InDesign document now includes overlay assets. See “Create source InDesign documents (InDesign CS6)” on page 37.

iPhone support  DPS now supports the iPhone 3GS, 4, and 4S (the iPhone 3G is not supported). When you use the Viewer Builder, you can create a custom viewer that works for the iPhone, the iPad, or both. When you create an app for both the iPad and iPhone, your customers are entitled to purchased folios on any supported iOS device. The iPhone viewer includes a new settings page, enhanced browse mode, and welcome screen that publishers can control.

Social sharing, bookmarks, and auto archiving are not yet supported for the iPhone. At this time, you cannot create a single-issue viewer app for the iPhone. See “Creating DPS content for the iPhone” on page 41.

Web viewer for social sharing  If you enable social sharing in your app, representations of folio articles are uploaded to a web server for viewing in desktop browsers. Use the Protected setting in the Folio Producer Editor to determine which articles are available for desktop viewing. Use the Account Administration tool to limit the number of viewable unprotected articles and to set up a paywall. See “Using social sharing” on page 139.

Social Sharing Enhancements  Social sharing is now available through Facebook, Twitter, email, and copy/paste. If you enable social sharing in your app, a customer can browse to an article and share it via Twitter, for example. If the article is protected, the link in the tweet points to the publication URL. If the article is unprotected, a person who clicks the link in a supported desktop browser sees the folio in the web viewer. And a person who clicks the link on an iPad can download the app, download or buy the folio, or view the article, depending on what is already downloaded. See “Using social sharing” on page 139.

Hide From TOC Option  The Hide From TOC article settings lets you hide an article from the TOC without having to mark it as an advertisement. See “Change article properties” on page 84.

Background Publishing  When you use the Folio Producer Organizer to publish or update an article, the job is added to the publishing queue, and you can continue to use the Organizer and add other folios to the queue. You can check the status of the queue by choosing View > Publish Requests in the Organizer. See “Publish folios to the Distribution Service” on page 105.

Display Download Counter  Professional and Enterprise customers can now see a download counter in the DPS Dashboard. The download counter appears only for accounts that have been audited for accuracy.

Desktop Viewer now resizeable  If you use the Desktop Viewer to preview a 2048x1536 folio, you can press Command+1 to view the actual size or press Command+0 to fit in window. You can also zoom in or out. See “Use the Desktop Viewer to preview content” on page 90.

Simplified Preview on Device  When you use the Viewer Builder to create a custom Adobe Content Viewer for the iPad, the Preview on Device feature no longer requires the Phone Disk utility. See “Use Preview on Device” on page 93.

UI Improvements  In the Folio Builder panel, the folio size appears below the folio name, making it easier to identify renditions. The Viewer Builder design makes it easy for you to check that the right icons are used for the various iPhone and iPad models. The Folio Producer Organizer and the Folio Producer Editor windows have also been redesigned.
**URL Scheme setting**  The Optional URL Scheme setting in the Viewer Builder is now available for all iOS viewer app types, not just subscription apps. The URL Scheme lets you link to a viewer app from another app or from mobile Safari.

**Lock orientation for HTML of custom icons**  If you’re an Enterprise publisher, you can specify the orientation of the HTML pages that appear when users tap the custom nav bar icons. See “Navigation Toolbar (Enterprise only)” on page 119.

**Improved Viewer Builder Speed**  The Viewer Builder now builds apps much faster, usually in a matter of seconds.

**Smooth Scrolling with limited PDF support**  If your Smooth Scrolling article is no longer than two page lengths, you can use the PDF image format. If the article is longer than two pages, JPG or PNG is used for the Smooth Scrolling article.

**“Hot zone” navigation**  Enterprise publishers can enable hot zones that appear on the left and right sides of every article. Tapping an invisible hot zone navigates to the next or previous article. See “Navigation Toolbar (Enterprise only)” on page 119.

**Release 19**

**iOS rendition support**  The new HD iPad model was recently announced. When you use Viewer Builder to create a new app, you can specify icons and splash screens for alternate sizes. Renditions are enabled for iPad devices, letting you create folio renditions at an alternate size. Each iOS model downloads folios that best match the display of the tablet.

**Enhanced Scrollable Frames**  The Folio Overlays panel has a new overlay type called Scrollable Frames, which replaces the Pan Only option in the Pan & Zoom overlay. When you create scrollable content, you can determine the scroll direction, base the initial view on the location of the content frame, and hide the scroll bar.

**Social Sharing**  If you register your app with Facebook, you can turn on a social sharing option in your custom viewer’s nav bar. Your customers can tap the Facebook option and type a message. This message and a link to your publication site is then posted on the user’s Facebook wall. At this time, only a link to the publication website is displayed, and Facebook is the only available social media site.

**Auto-Archive folios (iOS only)**  In Viewer Builder, you can enable auto-archiving of folios and specify the maximum number of downloaded folios for your viewer app. When the threshold number is reached, the least recently downloaded folios are archived automatically. Customers can enable or disable auto-archiving using device settings, but they cannot change the threshold number. Customers can re-download any archived folio.

**Smooth scrolling improvements**  In previous versions, creating dual-orientation smooth scrolling articles required you to creating the article by import. Now, when you create an article using the Add button, you can set Smooth Scrolling options. When importing smooth scrolling articles, make sure that you specify a Smooth Scrolling option.

**Bookmarks**  If you enable bookmarks in Viewer Builder, customers can mark an article as a bookmark and then choose that bookmark from a drop-down menu in the nav bar to jump to the bookmarked article. Bookmarks work across multiple folios within the same viewer app.

**Improved library update performance**  When you return to the viewer library, the viewer checks only for changes, resulting in faster processing. The “cannot update library” error message should appear less frequently — only when the library fails to update on first launch or when the library is empty and fails to update.

**Analytics for HTML5 files**  A Javascript API that captures analytics for HTML5 content on iOS and Android devices is now available. This JS API allows publishers to include HTML5 analytics in SiteCatalyst reports instead of viewing separate reports. For details, contact your Adobe representative.

**Restricted distribution of folios (Enterprise only)**  Enterprise publishers can now determine whether both free and retail folios appear in the library based on sign in. Publishers can set up the library so that only downloaded free folios
appear in the library. For retail folios, both downloaded and entitled retail folios can appear in the library. Publishers don’t need to use a custom web store to make retail folios available.

**Nav bar icon improvements (Enterprise only)** In Viewer Builder, Enterprise publishers can add as many as eight nav bar icons. You can now edit the appearance of the two default icons: Viewer and Library. In addition, the local HTML files used for these icons can include as many as five levels of nested asset folders. HTML assets are no longer required to be on the same level in the HTML structure.

**Link to Store from article (Enterprise only)** You can create a button or hyperlink that lets customers jump from an article to the store page. When creating a button or hyperlink, replace “http://” in the URL field with “ww.gotoStore” (“ww” is not a typo). You must also use Viewer Builder to create a “Store” label for the custom icon.

**Nested overlay improvements** Many of the bugs and limitations in nested overlays have been fixed. For example, anchored buttons in scrollable frames no longer lose their appearance when outside the container frame, and the workaround for renaming scrollable frame objects in the Layers panel is no longer necessary.

**Release 18**

**Embedded overlays in slideshows** Interactive objects are now supported in multi-state objects. All interactive objects (except other slideshows) are supported in slideshow states.

**Enhanced button overlays** The Video and Sound actions are now supported, so you can use buttons to play, pause, and stop videos. In addition, multiple actions are also supported in sequence. For example, a button can now play an audio clip and then change to a new slide when the audio ends.

**MSO buttons in scrollable frames** Button actions that trigger the state of a multi-state object now work in scrollable frames. Note that when you paste the content frame into the container frame, the state action is removed, so you need to add the action again after pasting.

**PDF pinch and zoom with all overlays** When you create a PDF article, you can pinch and zoom on any page even if it includes interactive objects. You can even pinch and zoom while an overlay is playing. PDF-based articles are still available only on iPad viewers, not the desktop viewer or other AIR-based viewers. When creating or updating your custom viewer, remember to select the “Enable PDF Zooming” option in the Viewer Builder.

**Custom-created Adobe Content Viewer** If you have a Professional or Enterprise account, you can use the Viewer Builder to create your own version of the Adobe Content Viewer for the iPad. The ability to build your own custom Content Viewer offers two advantages. First, when a new version of the Folio Producer tools becomes available, you can test the new features while the Adobe Content Viewer is awaiting approval. Second, the Preview on Device feature is enabled in the custom Adobe Content Viewer.

**Preview on Device support for iPad** When you use the Viewer Builder to create a Adobe Content Viewer, you can copy folio information directly to a connected iPad without going through the acrobat.com web client. However, Preview on Device for the iPad requires a third-party utility such as Phone Disk. Preview on Device for the iPad works only on Mac OS, not Windows.

**Relink** If you move or rename your source files, you can use the Relink command in the Folio Builder panel to reconnect the article layouts to the source files.

**Custom viewer apps for Amazon Appstore** Adobe and Amazon have resolved the issues that prevented custom viewers from being approved in the Amazon Appstore. In addition, folios are now stored in the App Data folder of the SD Card, thereby avoiding residual folios that might otherwise remain when an app is deleted.

**Free subscriptions enabled for Newsstand** Custom viewers you create now support Apple’s “Free Subscription” option.
Notify option for push notifications  Push notifications are no longer triggered automatically whenever you publish a folio. After you publish or update a folio, click the Notify button in the Folio Producer Organizer to trigger push notifications.

Third-party push notification servers  With an Enterprise account, you can create a custom server to control push notifications.

Restricted distribution of free folios  If you’re an Enterprise publisher, you can hide free content in the viewer library, allowing you to entitle customers to download specific content based on their sign-in accounts.

HTML store enhancements  If you’re an Enterprise publisher, you can set up an HTML store that interacts with the viewer library. For example, when customers sign in to your third-party store, they can be signed in to the viewer automatically.

Subscription improvements  The entire subscription tile is now an active tap area, not just the button area in the lower right corner. When a user subscribes to an app, subscription options are hidden. If a user purchases the most recent folio, subscription options now remain available.

Cover View only for Android viewers  For Android viewer libraries, you have the option of using Grid View, Cover View, or Both. For smaller Android devices, some publishers prefer allowing only Cover View.

Account Administration tool enhancements  You can now use the Admin tool to create limited accounts for in-house and contract designers. Accounts you create are tied to the company’s account without allowing access to features such as analytics.

Release 17

Single Edition  Instead of paying a monthly subscription to Adobe for a Professional or Enterprise account, you can now pay a one-time fee to create a single-folio viewer app that you can submit to the Apple Store.

Viewer Builder support for Amazon Appstore  In Viewer Builder, you can create a custom viewer app that you can submit to the Amazon Appstore. The Amazon Appstore is available on Android devices as well as the Amazon Fire tablet.

Account Administration tool  Use the Adobe Account Administration tool to create and provision accounts for your company rather than exchanging email messages with Adobe representatives. You can assign three types of accounts to an Adobe ID: Application, Viewer Builder, and Administrator.

Scrollable frames with interactive overlays  If you install the v17 Folio Producer tools, you can include any overlay in a scrollable frame overlay except slideshows.

PDF article enhancements  If a page in an article with a PDF image format includes URL-based buttons or hyperlinks, pinch and zoom works as long as there is no other interactive overlay type on the page.

Right Edge Binding option  Selecting this option in the Folio Producer Organizer displays articles from right to left rather than left to right in the viewer. This option is especially important for Asian languages.

Open Folio Producer Organizer from panel  Choosing the Folio Producer command from the Folio Builder panel menu opens the Folio Producer Organizer in your default web client.

Improvements to server reliability  The product team continues to make fixes to improve the acrobat.com upload/download issues.

Release 16

Offline workflow  You can now create a folio and articles without uploading the content to the web server. When you’re ready, you can upload the content.
**Newsstand support**  The updated Viewer Builder (version 1.5.1) includes Newsstand support for subscription viewer apps on the iPad. Newsstand-enabled viewers appear in the Newsstand folder, allowing quick access to newspaper and magazine publications.

**Private publishing for non-subscription users** If you don’t have an Enterprise or Professional subscription, you can use the Publish option in the Folio Producer Organizer to publish content as private. This option is especially useful if you are unable to download large folios using the acrobat.com server. Published folios downloaded from the Adobe Distribution Service are fast and reliable.

**New option for audio assets** If you’re using InDesign CS5.5, selecting the Show First Image Initially option resizes the audio overlay frame based on the first _play image in the specified audio controller assets folder. In InDesign CS5, you still need to manually resize the overlay frame to fit the poster image.

**Import HTML Resources option in Folio Builder panel** You can now import the HTML Resources file in the Folio Builder panel as well as the Folio Producer Editor.

**Enhanced Dashboard** The Digital Publishing Suite Dashboard includes links to videos and other useful content.

**Separate installers for authoring tools and panel** Use one installer to install the authoring tools (Folio Overlays panel, InDesign plug-in, and desktop viewer). Use a different installer to install the Folio Builder panel.

**Improvements to server reliability** The product team continues to make fixes to improve the acrobat.com upload/download issues. For example, publishing a folio now copies the folio contents directly from the acrobat.com server to the Adobe Distribution Service.

**New analytics categories** In analytics reports, you can view data regarding the type of downloaded folio: free, retail single, subscription, or external entitlement.

**Release 15**

**Custom viewers for PlayBook** With the Viewer Builder, you can create custom viewer apps for iPad, Android, and BlackBerry PlayBook platforms.

**Enhanced scrollable frames** You can now create scrollable content by pasting a text frame into a container frame. In addition, the performance of scrollable frames has improved.

**Hyperlinks in scrollable frames** Hyperlinks and hyperlink buttons in Pan Only scrollable frames are now supported. Hyperlinks in slideshows or in scrollable frames created using the Layers panel are not yet supported.

**Improved memory handling** In previous releases, creating memory-intensive overlays on adjacent pages caused performance problems in some situations. The viewer now handles these situations better, resulting in improved performance.

**Preview on Device** You can copy folio information directly to a connected mobile device without going through the acrobat.com web client. Until an updated Adobe Content Viewer is available in the App Store, the Preview on Device feature works only with Android devices. This initial offering requires additional setup effort.

**Customize all five nav bar icons** When using Viewer Builder to create a custom app, you can now replace the “Library” and “Viewer” buttons in the viewer nav bar (Enterprise only).

**Simplified creation of in-house viewer apps** You are no longer required to specify distribution certificates and provisioning files for Enterprise-signed viewer apps (Enterprise only).

**Improved Omniture analytics** User data is now available for single-folio viewer apps (DPS subscribers only). Also, analytics includes a more detailed breakdown of download statistics.

**Option to turn off “Sign In” button** If you’re an Enterprise customer creating a custom entitlement viewer, you can turn off the Sign In button to avoid redundancy.
Add certificates at download  You now use Viewer Builder to create a custom viewer app file without specifying certificates. You then specify certificates when you download the viewer file. This allows different people to download and sign the app with certificates.

When you create a custom viewer, you no longer need to click the Refresh button to see if the viewer build is complete.

Improved library performance  In some instances, folios from acrobat.com were appearing only intermittently in the library. The Adobe Content Viewer should display all available folios consistently.

Improvements to HTML articles in Android viewer  Scrolling is now enabled in HTML articles for the Android viewer.

Release 14 (Services and Viewer Builder only)
Rearrange article order  You can now rearrange the order of articles directly in the Folio Builder panel, not just in the web client. Simply drag and drop the articles to change their order.

Unshare folios  If you shared a folio with someone else, you can unshare the folio without having to delete it. You can also use the Folio Builder panel to remove a folio that was shared with you.

Change of article size limitation  With previous releases, the size limit of an article to be uploaded was 100MB. The article size limit is now 2GB. However, mobile devices may not handle large articles well.

In-app payments for Android viewers  You can now create retail folios for Android viewers. Customers can click a Buy button in the Android viewer library to purchase a folio.

Restore all purchases for Android viewers  Customers can now restore all purchases in Android viewers as they can do in iPad viewers.

Export option for single-folio viewers  An Export option now appears in the Folio Producer Organizer. Clicking Export creates a .zip file containing the contents of the selected folio. When using the Viewer Builder to create a single-folio viewer for the iPad, you specify this .zip file (or a .folio file created with the Content Bundler).

Sideloading option in development builds  When you use the Viewer Builder to create a development viewer for the iPad, you can turn on sideloading. This option lets you manually copy a .folio file (not a .zip file) to the development viewer through iTunes.

Control language listing in iTunes  In previous versions, the viewer app appeared in 20 languages in the iTunes Store. The Viewer Builder now lets you limit which languages the viewer app should appear in.

Restore purchases menu option  The library of custom viewers now includes a menu that lets customers choose a Restore Purchases option to manually restore purchases.

Analytics update  Subscription data is now captured in addition to individual folio statistics.

Release 13
Release 13 (June 2011) was the second public release of the Digital Publishing Suite. Release 13 tools used the 1.1.x installer and Viewer Builder 1.3.

Viewer download improvements  Customers can begin viewing a folio before it finishes downloading, and they can view partially downloaded folios offline. Interrupted downloads are automatically resumed when the iPad is regains its connection to the Internet. Use the Folio Producer Editor to determine the download priority for articles.

Stop on last image  With the Folio Overlays panel, you can now decide whether to stop slideshows and image sequences on the first or last image when played.

Horizontal Swipe Only articles in all viewers  Articles set to Horizontal Swipe Only (“flattened articles”) now work in the Adobe Content Viewer for the Desktop, as well as for Android and PlayBook viewers.
Restore Purchases option  If customers restore or replace an iPad, they can download content they’re entitled to more easily. When the viewer is started the first time, customers are prompted to restore purchases.

Custom navigation toolbar buttons  Enterprise customers can create as many as three buttons that display an HTML page in the viewer. In addition to the Library and Viewer buttons that appear in the navigation toolbar, you can create additional buttons such as Store, Help, and News that display an HTML page.

Hide the navigation toolbar or Home button  When using the Viewer Builder to create your viewer app, you can hide the navigation toolbar at the bottom of the viewer or the Home button in the upper left corner of the viewer.

Additional analytics reports  The Analytics page on the Digital Publishing Suite Dashboard now includes more reports for tracking user data.

Entitlement for Android  Enterprise customers can now provide entitlement for subscriptions.

Localized Android Content Viewer  The Adobe Content Viewer for the Android is now localized for the same languages as the iPad viewer.

Localized Viewer Builder  The Viewer Builder has been localized for the following languages: French, German, Italian, Spanish and Japanese.

Improved usability  The Folio Builder panel, Folio Producer website, and Viewer Builder include a number of adjustments to improve the user experience.

Release 12  Release 12 (May 2011) was the first public release of the Digital Publishing Suite. Release 12 tools used the 1.0.x installer and Viewer Builder 1.2.

New Folio Builder panel  The Folio Builder panel in InDesign replaces the Digital Content Bundler application. With the Folio Builder panel, you can add articles and article layouts and change folio and article properties.

Folios stored on web workspace  With the previous tools, you created a folio folder containing article folders. You bundled the folio folder to create .folio files that you either uploaded to the server or sideloaded to the iPad. With the new workflow, each folio is a workspace on a web server. The folios still consist of articles, but the articles can be copied to different folios and rearranged without bundling again. Click a Preview button to preview individual articles or entire folios. Or, sign in to the Adobe Content Viewer and download folios you created. You can use the Import feature to create articles based on existing folder structures.


- Use the Analytics page to track customer data.
- Use the Folio Producer to organize, edit, and publish folios. The Folio Producer includes an Organizer page that displays available folios and an Editor page that displays the articles in a selected folio.
- Use the Viewer Builder to create custom apps.

Sharing  Use the Share option to share folios with other DPS users. For example, a publisher can share a folio with a designer who is assigned to create an article for a magazine. Or, an ad agency can share a folio with various publishers to make ads available. The share workflow replaces the “sideloading” workflow.

Redesigned Folio Overlays panel  The Folio Overlays panel has been redesigned. 360 Viewer overlays are now called Image Sequence overlays. Web View overlays are now called Web Content overlays. You can reset objects to convert them from overlays to normal objects.

Terminology changes  “Stacks” are now called “articles.” The Flatten option is now Swipe Horizontal Only. The fulfillment server is now called the Distribution Service.
Release 11
Release 11 was the final prerelease version of the Digital Publishing Suite to use the Content Bundler workflow.

Folio download improvements  On iPads, the download speed has doubled. In addition, Viewer users can read one folio while downloading another.

Android Viewer enhancements  The performance of PNG and HTML articles on Android devices has improved. The Android Viewer supports in-app web view.

Navigation bar customization  Enterprise customers can add as many as three icons to the navigation bar that display a full-screen web view.

Subscription improvements  You can now set up an Apple (iOS) subscription without providing a custom entitlement server.

Release 10
Pinch and zoom in PDF folios  If you select the PDF export option while bundling, users can use the pinch gesture to zoom in on a page. At this time, pinch and zoom is not enabled on pages that have interactive overlays.

Content Viewer for Android  The Adobe Content Viewer is now available for Android devices. You cannot sideload folios to this Content Viewer. Instead, upload and download files using the fulfillment server. Although the Android Viewer more closely matches the iPad Viewer, some features are not yet supported. Unsupported features include flattened articles, inline videos, panorama overlays, and folios exported in PDF format. HTML articles and Web View overlays may have performance issues.

Localized viewers  The Adobe Content Viewer language interface changes based on the device’s locale settings. At this time, supported languages include English, French, German, Swedish, Spanish, and Japanese.

Additional subscription support  In-app subscription options are now available. Adobe supports Apple’s new subscription model for publishers who set up their own entitlement server.

Folio renditions  Mobile devices are now available in multiple dimensions. If you use the same 1024x768 folios for Android devices, the folios will be letterboxed with black bars. If you want to design for specific devices (such as 1024x600) or aspect ratios (16:9), you can create different renditions of the same folio. Create renditions by making the Magazine Title and Folio Number settings the same but the Dimension export settings different. The viewer offers only the rendition that most closely matches the device’s dimensions.

Pagination in HTML articles  HTML articles can now be divided into pages more elegantly.

Release 9
eCommerce subscription services in Viewer  Publishers can now set up their own subscription model that allows customers to subscribe to a magazine or newsletter and receive regular updates of folios. Customers can specify a range of folios that remain downloaded on the iPad—especially useful for news magazines.

Desktop Viewer enhancements  The Content Viewer for Desktop now supports many previously unsupported features such as single-orientation folios and Web View overlays.

Right-edge binding  The Content Bundler includes a Binding setting that enables right-to-left reading of articles for Asian languages. If Right Edge is selected, the first article appears as the right-most article, and users browse through the articles from right to left.

Folio update in viewer  An update message now appears in the library if a folio is updated on the fulfillment server. Tapping the Update button downloads new or edited mini .folio files.

Dual-orientation videos in single-orientation folios  Users can play a full-screen video in landscape orientation even if the folio is portrait only.
Data analysis enhancements  When using analytic data to track usage, you can distinguish between ads and articles. Offline viewer data is also preserved.

Release 7/8

New Folio Overlays panel  The Folio Overlays panel in InDesign CS5 replaces the Interactive Overlay Creator application. This change means that you now create all interactive overlays natively in InDesign. Use the Folio Overlays panel to create overlays and change overlay settings.

Desktop AIR Viewer  An AIR-based version of the Viewer is now available for testing the issues (now called “folios”) that you create. The Desktop Viewer currently does not support all the features, so use it only as a basic testing tool.

“Issue” -> “Folio”  The new term for “issue” is “folio.”

No ID options  Using the same overlay IDs in the horizontal and vertical layout is no longer required in most cases to provide continuity when the iPad is rotated. The Bundler uses the source assets and settings to determine related overlays.

Grid view in Viewer library  The Viewer library now lets you display eight folios at a time in a grid view. You can switch between grid view and single view.

Order option  The Content Bundler includes a new “Order” column that makes it less likely for you to change the order of articles accidentally. Enter a number where you want the article to appear in sequence, and it moves to that place.

Locked articles while bundling  The Content Bundler includes a new “Locked” column that lets you prevent articles from being updated when you bundle—especially useful when you just want to test the changes in one or two articles.

Sign Out button in Viewer  You no longer need to change your Adobe ID password to display the Sign In button.

3G download  Folios can now be downloaded to the iPad via a 3G connection.

Release 6

Flattened articles  When an article (called a “stack” at the time) is flattened, each page in the article essentially becomes a separate article, allowing customers to scroll horizontally to view the pages of an article. Only the first page of a flattened article shows up in the TOC, but all the pages appear in Browse mode and as scrubber thumbnails. You cannot flatten a article that is set to smooth scrolling.

Looser folder structure requirements  You can now build an entire interactive issue without an OverlayResources folder. In previous releases, the source files for overlays had to be in the OverlayResources folder, and the exported SWF files had to be in the Links folder of the documents in which they were placed.

Auto TOC generation  The PNG file for the table of contents that was previously required is now optional. If your article folder does not have a PNG file, the Content Bundler generates a TOC icon automatically based on the first page of the article.

PDF image format  In addition to PNG and JPEG, the Bundler can output page images in PDF format. Using the PDF image format significantly reduces the file size and offers additional possibilities for future releases such as pinch and zoom and searching and selecting text.

HTML articles  You can now use either InDesign files or HTML files to create articles in an issue. When you create an article using HTML files, you can use the same HTML file for both orientations, or you can create separate HTML files for horizontal and vertical orientations.

Specifying HTML thumbnails  For InDesign articles, the Viewer automatically generates the thumbnails that appear when you drag the scrubber. However, generating thumbnails for HTML articles takes more time, sometimes resulting in poorly rendered thumbnails. To improve thumbnail performance in HTML articles, you can allow the Bundler to generate thumbnail images based on the first page of each HTML article, or you can manually add image files to the HTML article folders.
Viewer UI improvements  Users complained that the scroll bar to the right of each article was too thin, so we widened the scroll bar. We also improved the appearance and performance of page thumbnails in Browse Mode.

Transparency in scrollable frames  Scrollable content frames are now transparent by default. If you don’t want the contents of the container frame to appear, apply a fill to the content frame.

Bundler changes  In the Content Bundler, the Issue Title metadata text never appeared anywhere in the Viewer, so this option was removed, as was the Dimension/Type Settings information. In addition, the Use Cover option was changed to Include Cover.

Release 5

Native slideshows and hyperlinks  The only way to create interactive slideshows and hyperlinks is through native features. Use the Object States panel, the Buttons panel, and the Hyperlinks panel to create interactive objects. Change settings by typing the appropriate lines in the Script Label panel. (We hope to include a UI for these settings in the next release.)

Enhanced native slideshows  You can create navigation buttons that jump to the next or previous slides in the slideshow. If you add the “SS_swipeEnabled=yes” line to the Script Label panel when the multi-state object is selected, users can swipe to scroll through slides in a slideshow.

Links to specific pages  You can now create hyperlinks or buttons that jump to a specific page within an article.

Simplified “navto” hyperlinks  You can specify navtos hyperlinks using either of the target article’s source document names, with or without the .html or .indd extension.

Single-orientation articles  You can create a portrait-only or landscape-only issue. Simply include only the portrait or landscape InDesign documents in the issue folder. The issue maintains its orientation even if the iPad is rotated.

Support of local HTML files for Web View  When creating a Web View overlay, you can specify an HTML file from your computer. In the previous release, you could only specify a URL on the web to create a Web View overlay.

aggable frames  Create a view area that lets users scroll vertically or horizontally through the content. For example, users can scroll through a list of ingredients.

Back button  The Viewer’s navigation bar includes a Back button between the Home and TOC buttons that lets users return to the page from where they jumped.

JPEG output in Bundler  The Export Options dialog box in Bundler now includes an option for specifying whether to export content in PNG or JPEG format.

Improved error handing in Bundler  The Bundler provides better feedback during the bundling process.

Release 4

Web View overlay  Embed a live web page within a view area that you specify. You can determine whether users can interact with the web content and change other settings.

Auto Start options  Make an overlay play automatically (or after a specified delay) when the page is turned to. Auto Start is available for 360 Viewer, Audio, Video, and Web View overlays.

New 360 Viewer options  In addition to the Auto Start option, the 360 Viewer includes new options that give you control over playing and pausing, swiping, and looping the images.

navto hyperlinks  It’s now much easier to create hyperlinks that jump from one article to another. While creating either a native button or hyperlink in InDesign, specify the URL as “navto://<vertical InDesign document name>,” such as “navto://WiFi_v” to jump to the WiFi article from either the portrait or landscape orientation.

Simplified native slideshows  Multistate objects no longer need to be grouped. The Script Label panel is necessary now only to change settings.

Last updated 2/8/2013
Adobe Content Viewer  The Adobe Content Viewer lets you upload and download content from an Adobe server, and sideload content from your desktop. (Note: sideloading is no longer available.)

Upload issues to a fulfillment server  Adobe created a temporary server site that lets you upload and manage issues. While exporting, choose Multiple Files from the Issue submenu, and then specify server upload options. After you upload test content to an Adobe server, you can download issues to the Viewer. For this release, the only way to download an issue is to log in using the same Adobe ID as the person who uploaded the issue.

Manage issues in Bundler  In the Bundler, you can preview the interface that lets you view and manage uploaded issues. For this release, you can add, view, and remove issues uploaded to the Adobe server.

Cover option  The first page of the first article can now be used as the cover of the issue in the library for issues you upload to the server.

Release 2.5/3
Bug fixes; no new features other than offering the Adobe Content Viewer through the Apple Store.

Release 2
More flexible overlay folder structure  In the previous version, each article folder required _h and _v InDesign files and a Links folder with the combined assets from the two files, and there was a single OverlayResources folder for the entire issue. While that structure is still valid, you can now have separate folders for the _h and _v files, with each folder containing a Links folder and an OverlayResources folder—especially useful for package folders. There are advantages to each method.

If you use the method in which the the InDesign files and Links folders appear in separate folders, you must also include a separate OverlayResources folder in each article folder rather than the single OverlayResources folder for the entire issue.

Regardless of which structure you use, the InDesign files can now include either _h and _v suffixes (for horizontal and vertical) or _l and _p suffixes (for landscape and portrait).

Native InDesign interactivity  Hyperlinks, buttons, and multi-state objects in InDesign files can now be included in the issue without requiring the Overlay Creator. You can use the Script Labels panel to change default settings for these objects.

Inline movies  Movies can now be played inline rather than full-screen only.

Panorama  The Overlay Creator now includes a Panorama option.

Sidecar.xml  You can avoid filling out the metadata each time you use the Bundler by creating a CSV file called "Info.csv." Because of problems with certain characters not being displayed correctly, an XML file replaces the CSV file.

Multiple issues  You can now add more than one issue to the viewer. Tapping the Home icon takes you back to the library of issues rather than to the beginning of the current issue. You can create preview images for the library issues. Currently, you can load only eight issues.

Smooth scrolling  You can determine whether each article in the issue scrolls continuously or on a page-by-page basis.

Release 1
The first release of the Digital Publishing Suite tools offered the AIR-based Content Bundler and the Interactive Overview Creator apps. The first Overlay Creator included Hyperlink, 360 Viewer, Slideshow, Audio, and Video overlay types. The Overlay Creator was the only method to create interactive objects.
New feature release notes (all languages)

The Digital Publishing Suite tools are updated frequently. To view a description of the new features in the current set of tools, see “What’s new in this release” on page 11.

What’s new in this release (English)
Neues in dieser Version (German)
Nouveautés de cette version (French)
What’s new in this release (Japanese)
Novità di questa versione (Italian)
Novedades de esta versión (Spanish)
What’s new in this release (Korean)
O que há de novo neste lançamento (Portuguese)
What’s new in this release (Simplified Chinese)
What’s new in this release (Traditional Chinese)
Nieuw in deze release (Dutch)
Nyheter i den här versionen (Swedish)
Milyen újdonságokat tartalmaz ez a kiadás? (Hungarian)
Bu sürümdeki yenilikler (Turkish)
Co je nového v této verzi (Czech)
Nyheder i denne version (Danish)
What’s new in this release (Russian)
Version uudet ominaisuudet (Finnish)
Nowooci w tym wydaniu (Polish)
What’s new in this release (Ukrainian)

Supported feature list

These tables indicate which features are supported.

✔️ = supported
❌ = not supported
⚠️ = not fully implemented or partially supported

Last updated 2/8/2013
### Article features

<table>
<thead>
<tr>
<th>Feature</th>
<th>iPad</th>
<th>iPhone</th>
<th>Android/Amazon</th>
<th>Desktop Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual- or single-orientation folio</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Horizontal View Only (flattened articles)</td>
<td>✔</td>
<td>✔</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>HTML articles</td>
<td>✔</td>
<td>✔</td>
<td>☑️</td>
<td>✔</td>
</tr>
<tr>
<td>PDF image format (pinch and zoom page)</td>
<td>✔</td>
<td>✔</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>Smooth Scrolling</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Social Sharing (Web Viewer)</td>
<td>✔️ (v19 or later)</td>
<td>✔️ (v22 or later)</td>
<td>☑️</td>
<td>✕</td>
</tr>
<tr>
<td>Bookmarks (Favorites)</td>
<td>✔️ (v19 or later; not enabled in Adobe Content Viewer)</td>
<td>☑️</td>
<td>☑️ (v19 or later; not enabled in Adobe Content Viewer)</td>
<td>☑️</td>
</tr>
<tr>
<td>Hot Zones</td>
<td>✔️ (v21 or later)</td>
<td>☑️</td>
<td>✔️ (v21 or later)</td>
<td>✔️ (v22 custom Adobe Content Viewer)</td>
</tr>
<tr>
<td>Right Edge Binding</td>
<td>✔</td>
<td>✔</td>
<td>☑️</td>
<td>☑️</td>
</tr>
</tbody>
</table>

### Viewer features

<table>
<thead>
<tr>
<th>Feature</th>
<th>iPad</th>
<th>iPhone</th>
<th>Android/Amazon</th>
<th>Desktop Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-folio app</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✕ (in limited beta)</td>
</tr>
<tr>
<td>Single-issue app / Single Edition license</td>
<td>✔</td>
<td>✕</td>
<td>✕</td>
<td>✕</td>
</tr>
<tr>
<td>Platform in-app purchase folios</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✕</td>
</tr>
<tr>
<td>Platform subscription</td>
<td>✔</td>
<td>✔</td>
<td>✔ Amazon</td>
<td>✕ Google Play</td>
</tr>
<tr>
<td>Custom entitlement (Enterprise)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✕ (in limited beta)</td>
</tr>
<tr>
<td>Custom HTML library</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✕</td>
</tr>
<tr>
<td>Custom nav bar icons and store</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✕</td>
</tr>
<tr>
<td>Library background downloading</td>
<td>✔</td>
<td>✔</td>
<td>☑️</td>
<td>☑️</td>
</tr>
<tr>
<td>Feature</td>
<td>iPad</td>
<td>iPhone</td>
<td>Android/Amazon</td>
<td>Desktop Viewer</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Progressive downloading (view</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>folio during download)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Renditions</td>
<td>✔️ (v19 or later)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Folios must match device aspect</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️ (Strict Renditions v22 or later)</td>
<td>✔️</td>
</tr>
<tr>
<td>ratio</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB Preview on Device</td>
<td>✔️ (Mac only)</td>
<td>✔️ (Mac only)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Auto archive</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Two-finger swiping</td>
<td>✔️ (v22 or later)</td>
<td>✔️ (v22 or later)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Filters</td>
<td>✔️ (v.22 or later)</td>
<td>✔️ (v22 or later)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Sections</td>
<td>✔️ (v24 viewer or later)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Push notifications</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Folio view hides system nav bar</td>
<td>N/A</td>
<td>N/A</td>
<td>✔️ Amazon</td>
<td>✔️</td>
</tr>
<tr>
<td>Newsstand background downloading</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Scrubber</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Browse</td>
<td>✔️ (combined with Scrubber)</td>
<td>✔️ (combined with Scrubber)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Back button</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>TOC</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Home</td>
<td>✔️ (Library)</td>
<td>✔️ (Library)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

Last updated 2/8/2013
## Interactivity features

<table>
<thead>
<tr>
<th>Feature</th>
<th>iPad</th>
<th>iPhone</th>
<th>Android/Amazon</th>
<th>Desktop Viewer</th>
<th>Web Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hyperlinks</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Slideshows</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔ (v23 or later)</td>
</tr>
<tr>
<td>Image Sequence</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Panoramas</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>⬗</td>
</tr>
<tr>
<td>Pan and Zoom</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Scrollable Frames</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔ (v23 or later)</td>
</tr>
<tr>
<td>Web Content</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Audio</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Audio in background</td>
<td>✔ (v23 or later)</td>
<td>✔ (v23 or later)</td>
<td>⬗</td>
<td>⬗</td>
<td>⬗</td>
</tr>
<tr>
<td>Full screen video</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>⬗</td>
</tr>
<tr>
<td>Inline video</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>⬗</td>
</tr>
<tr>
<td>Nested overlays (v18 or later)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔ (v21 or later)</td>
</tr>
<tr>
<td>Overlay support in PDF articles (v18 or later)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
Chapter 2: Document Design

Use InDesign CS5 or later to create layouts for mobile devices such as the iPad.

Layout design overview

A folio is a publication, such as an issue of a monthly magazine or the contents of a single-issue viewer app. A folio consists of one or more articles (sometimes called “stacks”). Using InDesign CS5 or later, create source documents for your articles. Use the Folio Builder panel to create folios and articles. Use the Folio Overlays panel to add interactive objects to your documents.

Related Articles

<table>
<thead>
<tr>
<th>To do this</th>
<th>Go here:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make design decisions</td>
<td>“Designing digital publications” on page 32</td>
</tr>
<tr>
<td>Use InDesign to create source documents for articles</td>
<td>“Creating source InDesign documents for DPS” on page 36</td>
</tr>
<tr>
<td>Add interactive overlays</td>
<td>“Interactivity” on page 49</td>
</tr>
<tr>
<td>Create folios and articles</td>
<td>“Folios and Articles” on page 71</td>
</tr>
<tr>
<td>Preview content</td>
<td>“Preview folios and articles” on page 89</td>
</tr>
<tr>
<td>Share folios with others</td>
<td>“Share folios” on page 78</td>
</tr>
</tbody>
</table>

Designing digital publications

For InDesign CS6, you can include horizontal and vertical layouts in the same InDesign document. For InDesign CS5/CS5.5, horizontal and vertical layouts must be in separate InDesign documents. You cannot mix and match orientations within folio; the entire folio must be dual, portrait, or landscape.

A dual-orientation article has two layouts—vertical or horizontal. When the user rotates the mobile device, the second orientation is displayed. A single-orientation folio is locked into that orientation. For example, if you create articles with only vertical InDesign files, that orientation remains in place even if the user rotates the mobile device. However, if a folio is portrait-only, full-screen videos can still be played in landscape mode.
Each document can have multiple pages and assets that differ in the horizontal and vertical orientation.

**Smooth scrolling articles**

You can turn on the Smooth Scrolling option for individual articles. Smooth scrolling is useful for long, single-page layouts such as a table of contents. If smooth scrolling is turned on, create your design accordingly. For example, for the iPad, you can create landscape and portrait documents that are 1024x2000 and 768x2000, respectively.

A document with multiple pages cannot be used for a Smooth Scrolling article. If you create Smooth Scrolling articles using the PDF image format, pinch and zoom is not enabled.

In InDesign, use the New Document or Document Setup dialog box to specify the page size.
To create a Smooth Scrolling article, do either of the following:

1. Create a one-page document with the appropriate dimensions, such as 1024x2000 for a landscape document or 768x2000 for a portrait document.

2. In article view of the Folio Builder panel, click Add to create an article.

3. In the New Article dialog box, specify the following options:

   - **Smooth Scrolling**: Select Horizontal Only if the article will contain only a landscape layout with Smooth Scrolling. This option is useful for an article in a horizontal-only folio or an article in which the landscape version is Smooth Scrolling and the portrait version is off (snap to page). Select Both Directions for dual-orientation folios in which both layouts are smooth scrolling.

   - **Portrait Layout/Landscape Layout (InDesign CS6)**: Specify the layout to be used for the article—especially useful if you created alternate layouts. If your portrait and landscape layouts are in separate documents, choose the appropriate layout for one option and None for the other. Then, open the other document and add it as the second layout.

   - **Portrait/Landscape (InDesign CS5/CS5.5)**: Specify the orientation of the document. For example, for a 768x2000 document, select Portrait. For a 1024x2000 document, select Landscape.

4. Click OK.

5. In a dual-orientation folio, add the second layout to the article.

**Additional Information**

You can also create a smooth scrolling article by importing it. Create _h and _v source files and use the Import Article option. See “Import InDesign articles” on page 80.

Smooth scrolling works only vertically at this time. To scroll an article horizontally, you can create a scrollable frame. See “Scrollable Frame overlays” on page 68.

To adjust the size of the smooth scrolling page, use the Page tool to select the page, and then adjust the page’s height.

**Swiping articles horizontally**

If you want one or more articles to flow horizontally only, select the Horizontal Swipe Only option in the Article Properties dialog box. Users navigate “flattened articles” by swiping left and right rather than up and down.
Only the first page of a flattened article shows up in the TOC, but all the pages appear in Browse mode. You cannot flatten an article that is set to Smooth Scrolling.

**Using HTML for DPS**

Here are three main ways to take advantage of HTML using DPS tools:

- **Links to websites** Use hyperlinks or buttons to display a website. You can display websites either in the external mobile browser or in an in-app browser in which users click a Close button to return to the folio. See "Hyperlink overlays" on page 52.

- **Web Content overlays** Create a Web Content overlay that displays a website or local HTML files within a view area. See "Web Content overlays" on page 66.

- **HTML articles** Instead of creating articles with InDesign documents, you can create a folder with HTML assets and import it as an article. See "Import HTML articles" on page 81.

An HTMLResources folder is useful for sharing the same assets (such as CSS, JavaScript, or image files) among multiple HTML articles or Web Content overlays. See "Import HTMLResources" on page 104.

**Enabling pinch and zoom for articles**

If you want users to be able to pinch to zoom in on article content, choose the PDF image format when creating articles. You can specify the PDF image format only when creating an article. Interactive overlays no longer disable pinch and zoom.

See Differences Between PDF and JPG/PNG Image Format for DPS.
Pinch-and-zoom PDF articles work only on the iPad viewer. Pinch and zoom is not supported in Smooth Scrolling articles at this time.

When creating or updating your custom viewer, make sure that you select the Enable PDF Zooming option in the DPS App Builder.

Creating source InDesign documents for DPS

If you’re basing a digital magazine article on an existing print article, creating a new document is usually the easiest approach. To repurpose a document, you can change settings in the Document Setup dialog box. Specify a page size (such as 1024 x 768 for the iPad SD) and orientation (portrait or landscape). For dual-orientation folios in which customers can view content either horizontally or vertically, you can create two separate documents for each article—one portrait and one landscape. If you’re using InDesign CS6, you can also create alternate layouts within the same document.

Do not use facing pages in your source documents—use only one page per spread.

Guidelines for creating InDesign documents

- Turn off facing pages. Do not use the Page tool to change the page size, unless the page is smooth scrolling.
- When creating your design, remember that a 6-pixel scroll bar crops the right edge of the article layout. Consider adding a guide or object on the master page to mark this area.
- To avoid large folio files, use properly sized JPEG and PNG files for interactive assets such as image sequences, pan & zoom images, and panoramas. For non-interactive images or slideshow images, you can use any format, including PSD, TIFF, AI, PDF, and JPEG. When you create an article or layout, the non-interactive objects on each page are compressed and converted into a single PNG, JPEG, or PDF background image file. Similarly, slideshow and button images are compressed into PNG files.

  ![When creating images to be used in interactive overlays, use the Save for Web & Devices option in Photoshop for best results.](image1.png)

- If you place PDF files in your InDesign document, use non-flattened PDF 1.4 or later to avoid unwanted white lines.
- For InDesign CS6, you can set up links between text frames in different layouts. For InDesign CS5/CS5.5, you can use an InCopy-based feature to share text between portrait and landscape documents. See Rufus Deuchler’s video Using InCopy Assignments for DPS.
- To get the best color fidelity, use RGB color images instead of CMYK or LAB.
- For non-interactive content, you can use any image type. Non-interactive content is resampled as an image with the same dimensions as the folio size. For guidance on creating interactive content, see “Best practices for creating overlays” on page 51.

Create source InDesign documents (InDesign CS5 and CS5.5)

1. In InDesign CS5 or InDesign CS5.5, choose File > New > Document.
2. (Optional) For Intent, choose Web.
   Choosing Web makes the layout easier to work in for mobile devices. If you’ve already created a document with Intent set to Print, you cannot change it to Web. However, you can manually change the settings.
3. For Page Size, specify the dimensions of the device reader.
The standard definition iPad models use 1024x768 pixels. The high definition iPad uses 2048 x 1536. A 6-pixel area on the right side of the page is cropped on the mobile device. The actual design area is 1018 x 768 (or 762 x 1024) pixels for SD iPad models.

For some Android devices, a menu bar covers part of the design area—either 48 or 75/64 pixels, depending on the model. Content in an Android viewer is not cropped or scaled up. Instead, content is scaled down and letterboxed as required. For dual-orientation folios, we recommend creating folio renditions and documents that are 1232x752 (Xoom and Galaxy 10) or 1205x725 (Nexus 7). See “Creating documents for multiple devices” on page 39.

If you want to allow smooth scrolling, you can specify a custom page size (such as 1024x3000). See “Smooth scrolling articles” on page 33.

4 For Orientation, choose either Portrait or Landscape.

5 For a dual-orientation article, follow the same procedure to create a second document.

When you save the files, include _v and _h suffixes in the filenames if you want to import articles. For example add an _v suffix for the vertical (portrait) document, such as article_v.indd.

6 Design your documents.

Not all InDesign interactivity features are supported in the digital publishing workflow. For details, see “Supported interactivity features” on page 50.

**Create source InDesign documents (InDesign CS6)**

InDesign CS6 includes several new features that simplify the DPS workflow. See the links below for more information on these features. The DPS team will continue to release versions that take advantage of these InDesign CS6 features. Note the following issues:

- Folios you create or edit using InDesign CS6 are not compatible with any viewer version before v20.
- If you create alternate layouts, you can create articles based on these layouts only through the Add Article feature, not through Import Article. If you rely heavily on importing multiple files, continue using different documents for each layout until the Import Article feature supports alternate layouts.
To create an InDesign CS6 document:

1. In InDesign CS6, choose File > New > Document.
2. For Intent, choose Digital Publishing.
3. For Page Size, specify the target device such as iPad. If necessary, change the width and height values.
   The SD iPad models use 1024x768 pixels. The new HD iPad uses 2048x1536. However, you can use a 1024x768 source files in a 2048x1536 folio.
   A 6-pixel area on the right side of the page is cropped on the mobile device. The actual design area is 1018x768 (or 762x1024) pixels for older iPad models.
   For some Android devices, a menu bar covers part of the design area—either 48 or 75/64 pixels, depending on the model. Content in an Android viewer is not cropped or scaled up. Instead, content is scaled down and letterboxed as required. For dual-orientation folios, we recommend creating folio renditions and documents that are 1232x752 (Xoom and Galaxy 10) or 1205x725 (Nexus 7). See “Creating documents for multiple devices” on page 39.
   If you want to allow smooth scrolling, you can specify a custom page size (such as 1024 x 3000). See “Smooth scrolling articles” on page 33.
4. For Orientation, choose either Portrait or Landscape.

Creating a document for a device reader
A. Set Intent to Digital Publishing  B. Specify Page Size  C. Choose Portrait or Landscape orientation

5. Leave Primary Text Frame selected if you want your text to reflow when you create alternate layouts. If your article does not have a main story thread, deselect this option.
   Not all InDesign interactivity features are supported in the digital publishing workflow. For details, see “Supported interactivity features” on page 50.
7. For a dual-orientation article, do either of the following:
   • Create a second document that has a different orientation. When you save the files, include _v and _h suffixes in the filenames if you want to import articles. For example add an _v suffix for the vertical (portrait) document, such as article_v.indd.
   • Create an alternate layout.
Creating documents for multiple devices

You can create folios and custom viewers for platforms to account for multiple device sizes. For example, the Android platform includes devices that appear in a number of different dimensions, including 1280x800 and 1024x600. At this time, the iOS (Apple) platform includes 1024x768 and 2048x1536 models for the iPad and 480x320, 960x640, and 1136x640 models for the iPhone.

Android and iOS viewers have different requirements for displaying folios. Any folio size you create can appear in an Android viewer. The articles are scaled and letterboxed as needed. However, on the iPad, the viewer displays only folios with a 4:3 aspect ratio. The v24 iPhone viewer displays only folios with a 3:2 aspect ratio (content is currently letterboxed on 1136x640 iPhone 5 devices).

Renditions
Multiple versions of the same folio designed for different devices are called renditions. If you create multiple folio renditions, the viewer makes available only the rendition that most closely matches the device’s dimensions. If the viewer displays a rendition that does not match the device’s aspect ratio, it scales the folio proportionally. The viewer can add either letterboxes (black bars top and bottom) or pillarboxes (black bars on the sides) as needed.

See “Create folio renditions” on page 108.

Folio renditions
A. 1024x768 folio  B. 1024x600 folio  C. 1024x768 folio letterboxed on 1024x600 device

Rendition options
You can use a number of different methods to account for the different device dimensions:

• Create a single folio size (such as 1024x768) for the iPad. Layouts are scaled down or letterboxed as needed on Android devices. If you want your content to appear on the iPhone, you need to create at least one additional folio size, such as 480x320.
Create separate source documents for multiple target devices. Create a different folio rendition for each set of source documents. For example, to create folio renditions for an Android viewer app, you could create folios and source files using 1024x768, 1024x600, 1232x752, and 1205x725 sizes. See Creating DPS Folios for Android Devices.

For iPads or iPhones, create multi-rendition PDF articles that display different assets depending on whether the device is SD or HD. See “Creating multi-rendition PDF articles for iOS devices” on page 42.

Use the same source documents, but create different folio renditions for multiple target mobile devices. For example, for the iPad, you can create one set of 1024x768 source documents, and then create two folios based on these documents. When the articles are uploaded, the source files are scaled according to the folio size. Scaling content when the articles are created provides better performance than scaling content when the folio is displayed in the viewer. (See “Creating DPS content for different iPad models” on page 41.) You can take this same approach when creating 480x320 and 960x640 renditions for the iPhone. (See “Creating DPS content for the iPhone” on page 41.)

### Design guidelines for multiple renditions

If you want to repurpose the same document for different devices, note the following guidelines:

- The iPad viewer displays only folios with a 4:3 aspect ratio, such as 1024x768. The iPhone viewer displays only folios with a 3:2 aspect ratio, such as 480x320. (The 1136x640 iPhone 5 rendition is not yet supported.)

- On Android devices, the viewer scales content down but not up. For example, if you view a 960x640 folio on a smaller device, the content is scaled down. If you view that folio on a larger device, the content is both letterboxed (bars top and bottom) and pillarboxed (bars on the sides) but not scaled up.

- If the viewer needs to scale down content, the performance is not as smooth as it is for content that matches the size in a 1:1 ratio. Text and images may appear fuzzy.

- When you add articles to a folio, the aspect ratio of the document’s Page Size setting must match the folio’s Size setting (unless you select a Smooth Scrolling option). For example, you can add 1024x768 InDesign documents to a 2048x1536 folio because the aspect ratios are 4:3. However, you cannot add 1024x768 documents to a 1024x600 folio.

- When designing for a device that uses Android 3.0 or later (Honeycomb), account for the system navigation bar. At this time, the nav bar for the Xoom and Galaxy 10 is 48 pixels and the nav bar for the Nexus 7 is 64/75 pixels. For example, the navigation bar makes the actual size of the layout on the Xoom 1280x752 in landscape and 800x1232 in portrait. For information about targeting different devices, see Creating DPS Folios for Android Devices.

- Objects on hidden layers do not appear in the exported folio. You can create separate layers for different mobile devices and add objects that appear only when that layer is turned on. Before you create an article from a document, show and hide the appropriate layers and change the page size as needed.

- We recommend that you use different Application IDs for iOS and Android platforms unless your apps include custom entitlement.

### Features not supported on other platforms

Some of the features that work on the iPad are not supported in the Android Viewer and other devices. For example, panoramas, inline (non full-screen) videos, and articles with PDF image format are not supported on the Android platform. For HTML content, check to make sure that it works properly in the platform’s browser and in the DPS folio. See “Differences between iOS and Android viewers” on page 44 and “Supported feature list” on page 28.

For information about making DPS apps for Android devices, see Making and deploying Android DPS Viewers.

Last updated 2/8/2013
Creating DPS content for different iPad models

The retina display HD iPad has 2048x1536-pixel dimensions compared to the 1024x768 dimensions of the SD models, including the new iPad Mini. To create folios that target this device, you have the following options:

Create 1024x768 and 2048x1536 renditions When you create folio renditions, the iPad SD models display only the 1024x768 rendition and the iPad HD displays only the 2048x1536 rendition. You can use either the same set of source files (recommended) or two different sets of source files to create the renditions. For additional guidance, see the articles by Bob Bringhurst and Colin Fleming linked below.

Create only 1024x768 folios You can use multi-rendition PDF articles to create a single 1024x768 folio that looks great on all iPad models. For example, you can create slideshows and scrollable frames in which the content is exported in vector format. You can include both SD and HD assets in the same folio. See “Creating multi-rendition PDF articles for iOS devices” on page 42. This approach is especially useful for single-issue viewers, which do not support renditions.

Create only 2048x1536 folios This approach is not recommended. In multi-issue viewers, 2048x1536 folios appear only on the HD iPad. In single-issue viewers, the content is noticeably rasterized and performance problems can occur.

Important considerations:

• If possible, avoid publishing renditions separately. Suppose that you publish a 1024×768 folio and then a week later you publish a 2048×1536 rendition of that folio. If your iPad 3 customers open the library before the larger rendition is available, only the smaller rendition remains available. The only way for them to get the larger rendition is to remove and reinstall the viewer app. (This limitation is scheduled to be fixed in an upcoming release.)

• If you have a Newsstand app, do not trigger a push notification until all renditions have been published and are available.

• When using DPS App Builder to create or update your viewer, create additional icons, splash screens and other images that support the high-resolution iPad. For example, you can specify 1024×768 and 2048×1536 splash screen images.

• The 1024x768 iPad Mini has a smaller view size than the 1024x768 iPad 2. For your 1024x768 folios, use at least 18-point body text.

More Help topics
“Create folio renditions” on page 108
“Creating documents for multiple devices” on page 39

Creating DPS content for the iPhone

The iPhone 3GS, 4, and 4S models as well as the iPod Touch (Generation 4) are supported for DPS. The iPhone 3G is not supported. The iPhone 3GS has a 480x320-pixel dimensions. The iPhone 4 and 4S and the iPod Touch models have 960x640-pixel dimensions. The iPhone 5 (1136x640) displays existing iPhone folios with letterboxing. However, 1136x640 renditions for the iPhone 5 are not yet supported.

You can create a viewer app for both the iPhone and iPad. You cannot create a single-issue viewer app for the iPhone or an iPhone-only viewer app.
Folios you create for the iPad do not appear in the iPhone viewer. The iPhone viewer displays only folios with a 3:2 aspect ratio, such as 960x640. For best results, create folio renditions. If you set up renditions properly and create a custom viewer that supports both iPhone and iPad, you can ensure that your customers are entitled to the same issue on any iOS device. See “Create folio renditions” on page 108.

Bookmarks are not yet supported for the iPhone. Enterprise customers can create as many as three custom icons for the nav bar.

To create folios that target the iPhone, you have the following options:

- **Create 480x320 and 960x640 renditions**  When you create folio renditions, the iPhone 3GS displays only the smaller rendition and the iPhone 4/4S models display only the larger rendition. You can use either the same set of source files (recommended) or two different sets of source files to create the renditions. In addition, create 1024x768 and 2048x1536 renditions for the iPad.

- **Create only one folio**  You can take advantage of a few new v23 features to create a single 480x320 folio with PDF articles that look great on all supported iPhone models. For example, you can create slideshows and scrollable frames in which the content is exported in vector format. You can include both SD and HD assets in the same folio. See “Creating multi-rendition PDF articles for iOS devices” on page 42. If you create only a 960x640 folio, it does not appear in the library of the iPhone 3GS.

Important considerations:

- To avoid problems, publish the renditions at the same time. Suppose that you publish a 480x320 folio and then a week later you publish a 960x640 rendition of that folio. If your iPhone 4S customers open the library before the larger rendition is available, only the smaller rendition remains available. The only way for them to get the larger rendition is to remove and reinstall the viewer app. (This limitation is scheduled to be fixed in an upcoming release.)

- If you have a Newsstand app, do not trigger a push notification until all renditions have been published and are available.

- When using DPS App Builder to create or update your viewer, create additional icons, splash screens and other images that support the iPhone sizes.

**More Help topics**

- “Create folio renditions” on page 108
- “Creating documents for multiple devices” on page 39

**Creating multi-rendition PDF articles for iOS devices**

Publishers face a challenge in that iPads and iPhones include both SD (Standard Definition) and HD (High Definition) models. One approach is to create a single folio that works in all models. However, some content appears pixelated on the HD device, and some overlays behave differently. Another approach is to create different renditions for both the SD and HD models. However, renditions are somewhat difficult to maintain for some publishers, and single-issue apps do not support renditions.
With the v23 release, you can create a single 1024x768 folio (v23 or later only) with PDF articles that look great and perform well on both SD and HD iOS models. When you create an article with a PDF image format, the PDF images now have a higher resolution than in previous versions (108 ppi instead of 72). In addition, you can perform the following tasks to create a multi-rendition PDF article:

**Use a vector format for slideshows and scrollable frames**  When you select a slideshow or scrollable frame object, the Folio Overlays panel displays an Export Format in PDF Articles option that lets you choose either Raster or Vector. If you select Vector, content—especially text—in slideshows and scrollable frames appears crisper on HD devices. However, vector content takes longer to load than raster content. For best results, use the Vector option for text-heavy content and Raster for image-heavy content.

**Use different interactive assets for SD and HD devices**  For panoramas, image sequences, videos, pan and zoom images, and audio controller skins, you can include two different sets of assets. To do this, you create a subfolder called “HD” in the folder containing the SD assets. In the HD folder, use high-resolution images with identical names to the SD assets. In the Folio Overlays panel, link to the folder containing the SD assets. The viewer on the SD iPad displays one set of assets, and the HD iPad viewer displays the assets in the HD folder.

*Note:* The HD assets for pan & zoom, image sequence, and audio skins must have twice the dimensions as the SD assets. For example, if an image sequence includes 300x200 SD images, the HD source files must be 600x400.
To use different panorama assets for HD and SD iPad models, create an HD folder containing high-resolution images with names identical to the lower resolution images.

For videos and pan & zoom images, you can create a single HD folder that includes multiple high-resolution files. For example, if your Links folder includes polarbear.jpg and video01.mp4, you can create an HD folder in the Links folder with high-resolution versions of the polarbear.jpg and video01.mp4 files.

Note that including two sets of assets for overlay types increases the folio size.

It isn’t necessary to create separate SD and HD versions for every overlay type. For example, some publishers create source files for image sequence overlays that fall somewhere between SD and HD resolutions, such as images with a 108 effective ppi. If a high-resolution video plays on an SD iPad, there is no reason to create an additional low-resolution video.

### Differences between iOS and Android viewers

Some of the features that work in the iPad viewer are not supported in the Android viewer.

- Articles with the PDF image format are not supported.
- Panorama overlays and inline videos are not supported.
- Web Content overlays and HTML articles are not fully supported. HTML content that works in mobile Safari might behave differently in other device browsers. See [Creating HTML articles for Android viewers](#).
- Subscriptions are supported for iOS and Amazon Appstore but not Google Play Store.
- iOS viewers display only folios with either a 4:3 aspect ratio (iPad) or a 3:2 aspect ratio (iPhone). The folio content is scaled up or down to fit the screen. However, Android viewers display any folio size. Content is scaled down and letterboxed as necessary but not scaled up.

For a detailed list of supported features, see “Supported feature list” on page 28.

For information about publishing folios for Android devices, see [Creating DPS Folios for Android Devices](#).

For information about making DPS apps for Android devices, see [Making and deploying Android DPS Viewers](#).

### More Help topics

“Creating documents for multiple devices” on page 39
Structuring folders for imported articles

You can use the Import Article command in the Folio Builder panel to import articles from the desktop. To import files properly, you must follow the structure rules and file naming conventions to determine what is included in a folio.

- To import multiple articles simultaneously, create a folio folder that consists of multiple article folders. When you select Import Multiple Articles, navigate to the folio folder that contains article subfolders.
- Article folders for dual-orientation folios must contain two InDesign documents. Create one document with an _h suffix (such as “article1_h.indd”), and one with a _v suffix (such as “article1_v.indd”).
- Article folders for single-orientation folios must contain only one InDesign file with an _h or _v suffix.
- Each article folder can contain a PNG file for table-of-contents thumbnails. If this file is missing, the toc image is generated automatically.

Create folder structure for importing multiple articles

When setting up the folder structure, you can use various methods to organize your article files. Files you link to in InDesign do not have to be in the article folder—they can be in any folder where InDesign can find them.

Keep filenames and folder names simple. Avoid using special characters.

Sample structure for files
A. Folio folder  B. Article folders

If you’re importing multiple articles into a single-orientation folio, make sure that each article folder contains only one document. The InDesign files still require an _h or _v extension in single-orientation folios. You cannot combine single-orientation and dual-orientation articles in a folio.
Create a metadata sidecar file for importing articles

The metadata sidecar.xml file is an optional method for ordering articles and applying metadata when you import the files. Use a text editor or an XML editor to create a sidecar.xml file with metadata for each article. Save the sidecar.xml file in the root folio folder.
You can copy and paste the following text into a text editor and edit it:

```xml
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<sidecar>
<entry>
    <folderName>Article One</folderName>
    <articleTitle>title</articleTitle>
    <byline>byline</byline>
    <kicker>kicker</kicker>
    <description>description</description>
    <tags>tag1, tag2</tags>
    <isAd>false</isAd>
    <hideFromTOC>true</hideFromTOC>
    <smoothScrolling>never</smoothScrolling>
    <isFlattenedStack>false</isFlattenedStack>
    <isTrustedContent>true</isTrustedContent>
    <section>section name</section>
</entry>
<entry>
    <folderName>Article Two</folderName>
    <articleTitle>article 2</articleTitle>
    <byline>byline</byline>
    <kicker>kicker</kicker>
    <description>description</description>
    <tags>tag1, tag2</tags>
    <isAd>false</isAd>
    <hideFromTOC>true</hideFromTOC>
    <smoothScrolling>never</smoothScrolling>
    <isFlattenedStack>false</isFlattenedStack>
    <isTrustedContent>true</isTrustedContent>
    <section>section name</section>
</entry>
</sidecar>
```

Valid `<isAd>` and `<isTrustedContent>` values are “true” and “false.” The `<isFlattenedStack>` value determines whether Horizontal Swipe Only is turned on, and `<isTrustedContent>` determines whether Allow Access to Entitlement Information is turned on for an HTML article.

Valid `<smoothScrolling>` values include “always,” “portrait,” “landscape,” and “never.” The default is “never,” which means scrolling snaps to pages.

You can use either `<byline>` or `<author>` for the Byline metadata.
For <section> entries, specify a string of characters, such as “Lifestyle.” Section values are valid only for v23 folios and later.

The order of the <entry> sections determines the order of the articles in your project when you create your project or when you update it. If an article’s folder name does not appear in the sidecar, it is moved below those that are listed. The order of items within each <entry> is insignificant.

**Use sidecar.xml for importing multiple articles**

1. Use a text editor or an XML editor to create a sidecar.xml file with metadata for each article.
2. Save the sidecar.xml file in the root folio folder.
3. In the Folio Builder panel, select a folio, and choose Import Article from the panel menu. In the Import Article dialog box, select Import Multiple Articles, specify the folder folder containing the sidecar.xml file, and click OK.

**Use sidecar.xml for updating article properties**

If you want to use the sidecar.xml file to update your article metadata or change the order of articles, you can use the Folio Builder panel to import the sidecar.xml file.

This method works only for folios uploaded to the server, not for local folios.

1. Create or edit the sidecar.xml file for your folio. See “Create a metadata sidecar file for importing articles” on page 46.
2. Copy or move the sidecar.xml file to its own folder.
3. In the Folio Builder panel, open the folio you want to edit, and choose Import Article from the panel menu.
4. Select Import Multiple Articles, specify the folder in which the sidecar.xml file is located, and click OK.
Chapter 3: Interactivity

Overview of interactive overlays

Use the Folio Overlays panel to create and edit interactive objects. To open the Folio Overlays panel, choose Window > Extensions > Folio Overlays (InDesign CS5/CS5.5) or choose Window > Folio Overlays (InDesign CS6).

Why are interactive objects called overlays? When you create a folio, all non-interactive items on a page are compressed into a single image—PDF, JPG, or PNG, depending on the article’s image format setting. If you mask or cover interactive overlays that you place in the document, the overlays appear on top of the layout in the folio. Only another overlay can mask an overlay.

The interactive object appears on top of the non-interactive items.

Ways to create overlays

Different overlays require different methods to create them.

- For slideshows, hyperlinks, audio and video, pan & zoom images, and scrollable content, create or place the objects in the InDesign documents, and use the Folio Overlays panel to edit settings.
- For image sequences, panoramas, and web content overlays, draw a rectangle frame as a placeholder or place an image to be used as a poster. Then select it and use the Folio Overlays panel to specify the source and change settings.
Maintaining continuity of interactive objects
When you use the same overlay in both the horizontal and vertical layouts, you want the overlay to maintain its state when the user rotates the mobile device. For example, if the slideshow displays the third slide, that third slide should remain visible when the user rotates the device.

For most overlays, no action is required to maintain continuity. Use the same source files and overlay settings. For slideshows, use the same Object Name in the Object States panel for the multi-state objects in the horizontal and vertical layouts. In addition, make sure that the individual state names are identical between the two layouts.

More Help topics
Troubleshoot Interactive Overlays

Supported interactivity features
InDesign includes many interactivity features for exporting to SWF and PDF. Some—but not all—of these features are supported in the digital publishing workflow.

Supported interactivity features
Multi-State Objects Use MSOs to create slideshows.
Hyperlinks Create URL, Email, and Navto hyperlinks.
Buttons Only the On Release event is supported. You can use multiple button actions. Button actions are played in sequence, not simultaneously.

Supported hyperlink actions include Go To First Page, Go To Last Page, Go To URL, Sound, Video, and Go To Page. Supported slideshow actions include Go To State, Go To Previous State, and Go To Next State.
Audio Placed mp3 files play. You cannot loop or stream audio at this time.
Video Supported video files (mp4 with h.264 encoding) play. You cannot loop video at this time. To stream video, use a web content overlay or HTML article.

Additional interactive overlays You can also create web content overlays, image sequences, pan and zoom images, panoramas, and scrollable frames.

Interactivity features not supported
Animation Animated objects are flattened when the article is created. One workaround is to export an animated InDesign document in FLA format and use the CreateJS plugin in Flash Professional CS6 to export an HTML5 file. You can then use this HTML5 file as a Web Content overlay. Many publishers use Adobe Edge to create animation.

Certain hyperlinks Text Anchor and Shared Destination hyperlinks are not supported.

Certain button actions Go To Destination, Go To Next Page, Go To Previous Page, and Show/Hide Buttons actions are not supported. On Click and On Rollover events are not supported.

Other features not supported Bookmarks, cross-references, and page transitions are not supported.

Best practices for creating overlays

Source files
- When creating the source assets for overlays, it helps to understand which overlays are resampled (compressed), and which ones are simply passed through during upload. The source assets of slideshows, scrollable frames, and buttons are resampled as PNG images. You can use any image format for these overlays.
- The source assets of panoramas, image sequences, pan and zoom images, and audio skins are not resampled on upload—they’re passed through. Use either JPEG or PNG image format for these overlays. To minimize file size, use JPEG images with medium compression (50-80% range) for the source files. Use PNG images only if the images include transparency. Compressing overlay images and video can significantly reduce the size of the folio.
- If the source article files are the same size as the folio, create the source files for panoramas, image sequences, inline videos, pan and zoom images, or audio controllers using the exact dimensions in pixels and 72 ppi. If the source files are a different size from the folio, such as 1024x768 articles used in a 2048x1536 folio, consider creating multi-definition PDF articles that target both SD and HD iOS devices. See “Creating multi-rendition PDF articles for iOS devices” on page 42.

In Photoshop and Illustrator, the File > Save for Web & Devices command is especially useful for saving image files with specific pixel dimensions.

- If you create memory-intensive overlays, the viewer’s performance can slow down significantly to preload these overlays. If possible, spread out the overlays in your design to avoid multiple overlays from being preloaded simultaneously. For example, if you have two articles with nested overlays in slideshows, consider putting an ad or basic article between the two articles.
- Whenever possible, give real names to your overlays to make it easier to interpret analytics data. For example, use “Twitter Link” instead of “Button 4” and “Cricket Slideshow” instead of “multi-state object 2.”
- If you place PDF files in your slideshow state or scrollable frame content, use non-flattened PDF 1.4 or later to avoid white lines.
Setup
• For panoramas, image sequences, audio skins, and local web content overlays, create a separate folder for overlay files. Use the Folio Overlays panel to link to this folder. If you want to create a folio that uses different assets for SD and HD iOS devices, create an HD subfolder with files that use the same names as the SD assets. Link to the folder containing the SD assets.
• Avoid running interactive objects into the bleed area. Keep interactive objects within the page size area.

Tips and guidelines
• When working with overlays, choose Window > Workspace > Interactive (InDesign CS5/CS5.5) or Window > Workspaces > Digital Publishing (InDesign CS6) to make interactive panels more accessible.
• Use a consistent method to let users know which objects are interactive. For example, you can create poster images that use icons to indicate different types of overlays.
• When you place overlay files in InDesign, the frame size determines where you tap to activate the interactive content.
• You can embed overlays within scrollable frames and slideshows. You can embed slideshows within slideshows only by using a trick with anchored frames. See the free DPS Tips app for details.
• In interactive content, only basic transparency effects such as opacity and multiply are supported. Blending modes are not supported.
• In some cases, you want an image to appear over the overlay, such as a mask for a video. To do this, create a “dummy” overlay. For examples of this trick, see examples in the free DPS Tips app by Bob Bringhurst or Creating Super Overlays by Johannes Henseler.

More Help topics
Troubleshoot Interactive Overlays

Hyperlink overlays

You can use the Hyperlinks panel or the Buttons panel to create links that jump to websites, other articles, and more. Not all button actions and hyperlink types are supported in folios.

Hyperlink overlays are supported in scrollable frames and slideshows, but not other overlays.

More Help topics
“Supported interactivity features” on page 50
“Best practices for creating overlays” on page 51

Create links using the Buttons panel
Use the Buttons panel to create links to the first or last page of a document or to a different article.

1 In InDesign, create the object to be used as the button.
   For example, if you want the button to jump to a website, create a text frame or place an image.

2 Open the Buttons panel (Window > Interactive > Buttons), select the object, and click the Convert Object To Button icon.
3 For Event, choose On Release.
   On Release is the only supported button event.

4 Click the plus sign next to Action and select a supported action.

   ![Supported button actions]
   
   Supported button actions  
   A. Supported actions for hyperlink buttons  
   B. Supported actions for slideshow buttons

   Supported hyperlink actions include Go To First Page, Go To Last Page, Go To Next Page, Go To Previous Page, Go To URL, Sound, Video, and Go To Page. Go To Next State, Go To Previous State, and Go To State actions are supported for slideshows.

   Do not use the Go To Destination action to jump to a different article. Instead, use the Go To URL action with a "navto" format.

5 If desired, add additional button actions.
   Actions are played in sequence. For example, if the first action plays a video and the second action displays a different slide, the video plays, and then the slide is displayed.

**Create links using the Hyperlinks panel**

In InDesign, you can use the Hyperlinks panel to add hyperlinks. Hyperlinks are especially useful for text. If you want a frame to be a hyperlink, consider using the Buttons panel instead of the Hyperlinks panel. Buttons are more versatile and less likely to break.

1 Select the frame or text that you want to use as a hyperlink.

2 Open the Hyperlinks panel (Window > Interactive > Hyperlinks).

3 In the Hyperlinks panel, choose New Hyperlink from the panel menu.

4 Deselect Shared Destination.
   Shared Destination lets you name and reuse hyperlinks, but it’s better to avoid using this option in the DPS workflow.
In the Link To menu, specify any of the following options, and then click OK:

**URL** Taping a URL hyperlink displays a web page (http://), an App Store application (itms://), an Amazon Appstore application (amzn://), or a different article (navto://).

Example: http://www.adobe.com

When linking to websites, type the entire URL, including “http://.”

**Note:** When linking to an iTunes URL, deselect Open in Folio in the Folio Overlays panel. Otherwise, a “Cannot Open Page” error message appears when the hyperlink is tapped. Similarly, if you use an itms:// or amzn:// format to link to a store app, turn off Open In Folio.

A navto:// hyperlink jumps to a different article or a different page in that article. Type navto:// followed by the article name as it appears in the Folio Builder panel. Use the Article Name value, not the article’s Title value. If you want to include a page number, add # followed by a number. But keep in mind that the first page is 0, so adding #2 jumps to page 3.

Example: navto://newsarticle

Example: navto://newsarticle#2 (jumps to page 3)

**Email** Tapping an Email hyperlink launches the Mail app with the To field filled in.

**Page** Tapping a Page hyperlink jumps to a different page within the article. Do not use this option for jumping to a different article.

The Text Anchor hyperlink is not supported.

To change hyperlink settings, select the hyperlink objects, and then specify these settings in the Folio Overlays panel:

**Open In Folio** Display the content in a web view within the Viewer. Deselect this option when linking to iTunes, itms://, or amzn:// URLs.

**Open In Device Browser** Display the content outside the Viewer in the mobile device browser, such as mobile Safari on the iPad. Select Ask First if you want a prompt to appear when users tap the link. This option is disabled if Open In Folio is selected.

**Note:** The Folio Overlays panel settings are not available for text hyperlinks. You cannot change settings for text hyperlinks; they are set to Open In Folio by default.

For additional details on creating hyperlinks, see Create hyperlinks in InDesign CS5/CS5.5 Help.

### Create links to other articles

Folio articles are stored on a server, so any link that specifies a path to an InDesign file is broken when previewed. Use the “navto” format to link to other articles.

When creating either a button or hyperlink, you can replace “http://” with “navto://” in the URL field. Then specify the target article name as it appears in the Folio Builder panel. Use the Article Name value, not the article’s Title value. Valid navto formats include navto://[article name] and navto://[article name]#n. Adding #n specifies a page number. The first page of a document is 0, so specifying #2 jumps to page 3.
Navto examples:

navto://biking

navto://biking#2 (jumps to page 3 of biking article)

Note: If you used a previous version of the tools to create a navto link using a folder name or article name that differs from the target article name, your links are broken. To fix the navto links, you can either rename the article (the name, not the title) or edit the navto links to point to the article name as it appears in the Folio Creator panel.

Create navto hyperlinks for HTML articles

When you create a URL-based hyperlink or button, you can use the "navto://" URL to jump to a different article. Navto is especially useful for jumping to HTML articles. You cannot use navto hyperlinks in Web Content overlays.

Jump to HTML article  Type navto:// followed by the HTML article name (not the article title).

Example: navto://newsarticle

Jump to anchor in HTML article  You cannot jump to a specific page within an HTML article, but you can jump to an anchor by typing navto://<foldername>#$<anchor name>.

Example: navto://newsarticle#part4

Note: To define an anchor in an HTML file, open the HTML file in a text editor. Navigate to the text that you want to act as an anchor, and enclose the text with an anchor tag, such as "<a name="part4">This is Part 4 of the Article</a>.

Jump to InDesign article from HTML article  Use the navto format to create a hyperlink from an HTML article to an InDesign article. Example:

<a href="navto://newsarticle">See the News Article</a>

You can also navigate to pages within an InDesign article by adding the page number after the document name. The first page of the document is 0, and the second page is 1, and so on. Example:

<a href="navto://Cycling#3">Go to Page 4 of the Cycling Article</a>
Jump from HTML to HTML  Use the navto format to jump from one HTML article to another using the folder name. Example:

```html
<a href="navto://newsarticle">See the News Article</a>
```

Create goto links to custom icons

If you have an Enterprise DPS account, you can use the goto format to create links from articles to the HTML content associated with custom icons. For example, you can use the DPS App Builder to specify custom icons for “Store,” “Help,” and “Terms.” These buttons appear in the viewer library. To create a button in an article that opens the HTML content for any of these custom icons, use the following format:

```html
goto://ApplicationViewState/[label]
```

For example, the `goto://ApplicationViewState/Store` button action would open the HTML store—just like tapping the custom Store icon in the library.

Use the DPS App Builder to create custom icons and specify labels. See “Navigation Toolbar (Enterprise only)” on page 126.

Link to assets in the HTML Resources folder

You can create a hyperlink or button that displays a local HTML or PDF file or asset in the viewer’s in-app browser.

1  Add a folder containing the local HTML file to the HTMLResources folder. Make sure that the HTMLResources folder is included in the folio. See “Import HTMLResources” on page 104.

2  Create a link to display the HTML file in the in-app browser:

   - **InDesign source document**  In the URL field of either a hyperlink or button, enter the path without http://, navto://, or any other prefix. Example:

     ```html
     HTMLResources/Cartoons/train1.html
     ```

   - **HTML article**  From an HTML article, specify the location. Example:

     ```html
     <a href="/HTMLResources/Cartoons/train1">See Train Cartoon Gallery</a>
     ```

   - **Web Content overlay**  Web Content overlays are nested two levels deeper than an HTML article. Example:

     ```html
     <a href="/..//HTMLResources/Cartoons/train1">See Train Cartoon Gallery</a>
     ```

     **Note:** For best results, avoid spaces and special characters in your HTML folders and files. If you include a space in a folder or file name, use the appropriate HTML code for the space character. For example, use “Cartoon%20Files” for a folder called “Cartoon Files.”

Create links to external apps and services

You can create a link that sends an email message (mailto:), a text message (SMS), or calls a number (tel:) from an iPhone article. You can also create links that open the YouTube app or an iTunes song or album. To learn more about the required formats to use for the iPad, see the Apple URL Scheme Reference.

For information about creating advanced email (mailto:) links, see James Lockman’s article Sending email and email attachments from DPS publications.

If you specify an Optional URL Scheme when using DPS App Builder to create an app, you can link to that app from another app or when viewed from a webpage in mobile Safari. See “App Details panel” on page 114.
Note: Whenever you create a link to an external app or service, select the button and choose the Open In Device Browser option in the Overlays panel.

Control the appearance of hyperlinks and slideshows in the viewer

When users browse through a folio on the mobile device, the horizontal and vertical pages they see are rasterized images of each InDesign page. The page thumbnails that appear when the user taps the Browse button or uses the scrubber at the bottom of the mobile device are also rasterized images. You can control the appearance of the hyperlinks and slideshows in these rasterized images.

To control the appearance of hyperlinks and slideshows, create a config text file and save it in the InDesign application folder. This file, called NativeOverlays.config, lets you include or suppress native hyperlinks and slideshows.

1. Open a text editor.
2. Add one or more of the following lines. ("Asset" refers to the main pages, "Thumbnails" refers to the Browse icon images, and "Scrubbers" refers to images that appear when the user drags the scrubber.)
   
   ```
   SuppressOverlayTypesForAssets: <slideshow, hyperlink>
   SuppressOverlayTypesForThumbnails: <slideshow, hyperlink>
   SuppressOverlayTypesForScrubbers: <slideshow, hyperlink>
   ResetHyperlinksToTopState: <ThumbnailPass, ScrubberPass, AssetPass, All>
   ```

   ResetHyperlinksToTopState means that any button with a Go to URL action displays the [Normal] state instead of the [Click] state.

   ```
   ResetSlideshowsToTopState: <ThumbnailPass, ScrubberPass, AssetPass, All>
   ```

   ResetSlideshowsToTopState resets the multi-state object to the top state of the multi-state object in the InDesign document. If you suppress overlays, reset settings do not apply.

   If ResetHyperlinksToTopState and ResetSlideshowsToTopState are not specified, the default behavior is to reset to top states for both slideshows and hyperlinks.

   Example:

   ```
   SuppressOverlayTypesForAssets: slideshow
   SuppressOverlayTypesForThumbnails: hyperlink
   SuppressOverlayTypesForScrubbers: slideshow, -hyperlink
   ResetHyperlinksToTopState: All
   ResetSlideshowsToTopState: ThumbnailPass, ScrubberPass
   ```

   If you type a minus sign before the overlay type, that overlay type is not suppressed.

3. Save the file with the name, NativeOverlays.config.
4. Move the NativeOverlays.config file to the InDesign application folder using one of these methods:
   
   **Windows** Move the config file to the same level as the InDesign.exe file.

   **Mac OS** Select the Adobe InDesign CS5 application icon, right-click, and choose Show Package Contents. Move the config file to the Content > MacOS folder.
Slideshow overlays

Use the Object States panel to create a set of images for a slideshow. Each state, or slide, can contain multiple objects. For example, if you want a different text frame to appear with each image, combine the image and text frame on the same state.

Slideshow states support any interactive overlay except for slideshows.

Slideshow images are converted into PNG images in the folio.

Currently, you cannot make a slideshow play in full-screen mode without using HTML.

1 In InDesign, use the Object States panel (Window > Interactive > Object States) to create a slideshow. (For details, see “Create a multi-state object slide show” in InDesign Help.)
   When you create a multi-state object, you insert images, align them in an article, and convert the article to a multi-state object.

2 In the Object States panel, specify an object name.
   When your multi-state objects in the horizontal and vertical documents have both the same object name and individual state names, the slideshow maintains continuity when the iPad is rotated. In addition, using a descriptive name makes analytics reports easier to understand.
   
   Note: To avoid errors, do not include punctuation or extended characters in the object name or object state name.

3 Create navigation buttons that browse through the states in the multi-state object.
   Use the Go To State action to refer to a specific slide. Use the Go To Next State and Go To Previous State actions to navigate through slides.
   The Sample Buttons panel in InDesign includes a library of navigation buttons. If you use these sample buttons, delete the existing action and replace with a Go To Next State or Go To Previous State action.

4 If you want the button appearance to change when it’s tapped, click [Click] under Appearance, and change its appearance.
   If a button uses the Go To State action, the [Click] state appears when the specified state is selected. For example, the [Normal] state button can have a black frame, and the [Click] state can have a red frame. The red frame appears when the button is tapped on the iPad. (The [Rollover] state is not supported on mobile devices.)

Last updated 2/8/2013
To change slideshow settings, select the multi-state object, and specify the following settings in the Folio Overlays panel:

**Auto Play** When selected, the slideshow begins playing when users turn to the page.

**Tap to Play/Pause** When selected, this setting lets users tap to play and pause an auto-running slideshow. Double-tapping resets the slideshow.

**Delay** If Auto Play is selected, you can specify the time that elapses between loading the page and the start of the slideshow. Specify a value from 0 to 60 seconds.

**Interval** If Auto Play or Tap To Play/Pause is selected, the Interval value determines the duration of display for each slide.

**Play Time** If either Auto Play or Tap To Play/Pause is selected, you can specify the number of times the slideshow plays. This option is dimmed if Loop is selected.

**Loop** If either Auto Play or Tap To Play/Pause is selected, select Loop to play the slideshow continuously until the user double-taps the slideshow or turns the page.

**Stop At Last Image** If either Auto Play or Tap To Play/Pause is selected, select Stop At Last Image to stop at the last image of the slideshow instead of the first.

**Cross Fade** When selected, this setting provides a fade transition to the next slide. The value is 0.5 seconds by default. You can specify a value between 0.125 seconds and 60 seconds. This value applies to both auto-playing and manually advanced slideshows.

**Swipe to Change Image** When enabled, this setting lets the user swipe to move from slide to slide.

**Stop at First/Last Image** This setting determines whether the slideshow stops playing or continues when the last slide is reached going forward or the first slide is reached going backward. This option affects only swiping.

**Hide Before Playing** If selected, the slideshow remains hidden until the user taps a button to display a slide.

**Play In Reverse** When enabled, the slideshow plays the images in reverse order.

**Export Format in PDF Articles** If your slideshow appears in an article that uses PDF format, you can choose Bitmap or Vector. Choosing Vector is especially useful when you’re creating a single folio for both SD and HD iPads or iPhones. The Vector option provides sharper text when the folio is displayed on an HD iOS device, but it takes a moment to load. For best results, use Vector for text-intensive slideshows, and use Raster for image-based slideshows or when creating separate renditions for SD and HD iOS devices.

When you copy the multi-state object to a different document, the object is renamed. For example, “sea slugs” becomes “sea slugs 2.” To maintain continuity when the device is rotated, make sure that the object names in the horizontal and vertical documents are identical. Don’t leave any spaces at the end of the object name. In addition, the corresponding state names in each layout should be identical.

**More Help topics**

“Nesting interactive overlays” on page 69

“Supported interactivity features” on page 50

“Best practices for creating overlays” on page 51
Image Sequence overlays

The Image Sequence overlay progresses through a series of images. It allows you to create effects such as rotating an object 360° on the mobile device.

- Use png or jpg image files that have the same root name with ascending suffixes, such as Tower001.jpg, Tower002.jpg, and so on. Make your image dimensions correspond exactly to the display area on the mobile device, such as 500 x 400 pixels in 72 dpi.

- For smooth 360° rotation, use at least 30 images. Using too many images increases the file size unnecessarily. To reduce file size, use JPEG images compressed in the 50-80% range. Use PNG files only if you want to include transparency.

- If your source assets include transparent PNG images, the poster you specify continues to display during the image sequence. One workaround is to create a two-state MSO in which the poster is a button on the first state that links to the image sequence on the second state.

Create a set of images to be used for the image sequence

💡 You can use a number of different methods to create images of a 3D object. One method is to use Adobe Photoshop® Extended to export an image sequence of a 3D object. You can use Adobe Flash® Professional or Adobe After Effects® to export frames from an animation or video. You can also use a 3D authoring application to generate images of a 3D model.

1 Create the source assets for the image sequence object, and place them in a folder.

2 Do one of the following:
   - Using the Rectangle tool or Rectangle Frame tool, drag to create a placeholder frame.
   - Place an image that acts as a poster for the image sequence. To avoid skewing, use the same dimensions for the poster image that you use for the image sequence images. (If you use a poster image, double-tapping the image in the viewer hides the image sequence and displays the poster.)

3 Select the placeholder object, open the Folio Overlays panel, and select Image Sequence.

4 In the Folio Overlays panel, click the Load Images folder icon, locate the folder containing the images, and click Open.

5 If necessary, scale the frame and its contents to fit in your layout.

6 Specify the following settings in the Folio Overlays panel:
   - **Show First Image Initially** If this option is selected, the first image is used as the poster. If Play In Reverse is selected, the last image is used as the poster.
   - **Auto Play** If this option is selected, the image sequence begins playing when users turn the page.
   - **Tap To Play/Pause** When selected, this setting lets users tap to play and pause the image sequence. Double-tapping resets the object.
   - **Delay** If Auto Play is selected, you can specify the time that elapses between loading the page and the start of the image sequence. Specify a value from 0 to 60 seconds.
   - **Speed** Change the speed of the object’s progression in frames per second. The minimum value is 1 (1 frame per second) and the maximum value is 30.
**Play Time**  If either Auto Play or Tap To Play/Pause is selected, you can specify the number of times the image sequence plays. This option is dimmed if Loop is selected.

**Loop**  If either Play On Page Load or Tap To Play/Pause is selected, you can select Loop to play the image sequence continuously. Double-tapping the slideshow or turning the page stops the sequence.

**Stop At Last Image**  If either Auto Play or Tap To Play/Pause is selected, select Stop At Last Image to stop at the last image of the sequence instead of the first.

**Swipe To Change Image**  When enabled, this setting lets the user swipe to move forward or backward through the images.

If Swipe To Change Image is not selected, select either Auto Play or Tap to Play/Pause to make the image sequence interactive.

**Stop at First/Last Image**  You can determine whether the object stops playing or continues when the last image is reached going forward or the first image is reached going backward. This option affects only swiping.

**Play In Reverse**  When enabled, the image sequence plays the images in reverse order.

**More Help topics**

“Supported interactivity features” on page 50

“Best practices for creating overlays” on page 51

“Creating multi-rendition PDF articles for iOS devices” on page 42

**Panorama overlays**

The Panorama overlay provides the illusion of viewing an image from the inside out. For example, you can create a Panorama effect that lets users see inside an airplane’s cockpit. They can rotate the view 360° and zoom in on the instrument panels.

The key to creating a panorama is getting the necessary images. Creating a Panorama effect requires a set of six images, which represent the six inner sides of a cube. If you begin with a full panorama image, convert it to six cube images based on that image.
Creating a panorama
A. Original panorama image  B. Panorama image converted to inner six sides of cube  C. Panorama on iPad

If you begin with a horizontal cross image, you can use Photoshop or a screen capture utility to create the six required images.
To divide a panoramic cross image into separate images, follow this pattern.

1. Create the source assets for the panorama, and place them in a folder.
   For best results, use JPEG images saved in 72 dpi. High-resolution images allow customers to zoom in more clearly but require a larger file.

2. Do one of the following:
   - Using the Rectangle tool or Rectangle Frame tool, drag to create a placeholder frame.
   - Place an image that acts as a poster for the panorama.

3. Select the placeholder object, open the Folio Overlays panel, and select Panorama.

4. In the Folio Overlays panel, click the Assets folder icon, locate the folder containing the six images, and click Open.

5. If necessary, scale the frame and its contents to fit in your layout.

6. Specify the following settings in the Folio Overlays panel:
   - **Use First Image For Poster** Selecting this option uses the first panorama image as the poster. Select this image if you have not created a different image to be used as the poster.
   - **Initial Zoom** Specify a value to determine the magnification of the initial image. Use a value between the Min/Max field of view settings, which are 30 and 80 by default.
   - **Vertical/Horizontal** Specify values to determine which area of the panorama is initially displayed. For Vertical, specify a value between -90 (tilted all the way up) and 90 (tilted all the way down). For Horizontal, specify a value between -180 (rotated all the way left) and 180 (rotated all the way right).
   - **Field Of View** If you don’t want users to zoom in or out past a certain point, specify Min and Max values.
   - **Limit Vertical Pan** If you want to allow tilting only two-thirds toward the top, select Limit Vertical Pan and specify -60. Specify 60 to allow tilting only two-thirds toward the bottom. Use a small value such as 1 to prevent vertical panning.
   - **Limit Horizontal Pan** If you want to allow panning only two-thirds toward the left and right, select Limit Horizontal Pan and specify -120 for left and 120 for right.

   **Note:** To see the effect of the different panorama settings, change the settings and click Preview.
More Help topics
“Supported interactivity features” on page 50
“Best practices for creating overlays” on page 51
“Creating multi-rendition PDF articles for iOS devices” on page 42

Audio & Video overlays

Supported video and audio files you place in InDesign play when tapped in the Viewer. For video files, use a format that is compatible with Apple iTunes, such as an MP4 file with h.264 encoding. When creating the video, use Baseline Profile for optimal compatibility with Android devices. Use .mp4 instead of .mov files, which are not supported in Web Viewer. For audio files, use MP3 files.

You can set up a video or audio file to be played by letting users tap the view area or by creating separate buttons with Sound or Video actions.

Currently, you cannot specify a URL to stream audio or video from the web using the Audio & Video overlay. However, you can stream media using a Web Content overlay or an HTML article.

Audio

The mp3 files that you place in InDesign play when tapped in the Viewer. To simulate a controller skin, you can create a simple effect that toggles between a play and pause button. Or, you can create a more advanced effect that displays audio progression.
Video
You can play video inline or in full-screen mode. For best results with inline videos, create a movie in the appropriate dimensions, such as 400 x 300 pixels, and create a separate poster image using those same dimensions. Consider setting full-screen movies to 1024 pixels wide. The maximum video size for the HD iPad is 1920x1080, although creating a video that large increases the folio size. For a good balance between file size and quality, some publishers recommend 10-12 MB per minute of film. To reduce video size, some publishers use Adobe Media Encoder or a third-party application such as HandBrake.

You can also add video (including streaming video) to HTML articles. See “Import HTML articles” on page 81.

You can specify a poster image from one of the movie frames. However, the recommended method is to create a poster image that indicates the object is interactive.

1. Choose File > Place, and place the video or audio file in your document.
2. Select the placed object, open the Media panel (Window > Interactive > Media), and specify a poster.
   For a video file, you can choose an image or specify a frame from the video. For best results, choose an image that indicates the page item is interactive.
3. Select the media frame and specify any of the following options in the Folio Overlays panel.
   **Audio Controller Files** Click the folder icon, and specify the folder containing the play and pause buttons for audio files.
   
   To display a controller skin with Play and Pause buttons while the audio clip is playing, create a set of .png files in a folder. These images each must have either a _pause or _play suffix. You can create a single pair of _play and _pause buttons, or you can create multiple _play and _pause buttons that represent progressive states of a status bar.
   
   AudioAsset001_play.png
   AudioAsset002_play.png
   AudioAsset003_play.png
   AudioAsset004_play.png
   AudioAsset005_play.png
   AudioAsset001_pause.png
   AudioAsset002_pause.png
   AudioAsset003_pause.png
   AudioAsset004_pause.png
   AudioAsset005_pause.png

   In this example, when your audio is played half way, the AudioAsset003_play.png button is displayed. When tapped to pause, the AudioAsset003_pause button is displayed.

   **Show First Image Initially (InDesign CS5.5/CS6 only)** If this option is selected, the audio frame displays the first _play.png file in the specified audio controller assets folder, and the frame resizes appropriately.

   In InDesign CS5, specify the poster image, and then manually resize the frame and the poster image.

   **Auto Play** Select this option to play the audio or video file when the page is loaded on the mobile device. You can also specify the number of seconds to delay. Auto Play is not supported for Android viewers.

   **Play In Background Across Folio** Select this option to play the audio file in the background while users browse through articles. Users can pause or resume the audio clip by tapping the audio icon in the top navigation bar. This feature is available only on the iPad or iPhone.

   **Play Full Screen** If this option is selected, the video plays in full-screen mode. If this option is not selected, the video plays within its bounding area. Note that all videos on Android devices play full screen.

   **Tap To View Controller (iOS only)** If this option is selected, tapping the inline video while it’s playing displays a controller bar with pause and play controls. If this option is not selected, tapping the video pauses and restarts.
**Do Not Allow Pause (iOS only)**  If you select this option, users cannot tap the video to pause or stop it. This option is available only if Auto Play is selected and Play Full Screen is not selected.

**Stop on Last Frame (iOS only)**  Select this option to display the final video image when the inline video stops playing. This option is available only if Play Full Screen is not selected.

When the user initiates the audio, it is played immediately while allowing the user to continue to read the content in the current article. Navigating to another article stops and resets the audio. However, turning the page does not stop the audio.

You can create buttons with Sound or Video actions to control the media clip. The Play, Pause, and Stop options are supported. Resume and Stop All are not supported.

**More Help topics**

“Supported interactivity features” on page 50

“Best practices for creating overlays” on page 51

---

**Web Content overlays**

The Web Content overlay lets you display a web page within a view area. Users can see the web page content in the view area without having to display a separate in-app browser. You can specify a web URL or a local HTML file. Note the following issues:

- If you specify a local HTML file, make sure that the .html file and associated files and folders appear in the same folder. When the article content is created, all the files in the same folder as the .html file are uploaded.
- For any URL that gets redirected to a mobile URL automatically, specify the mobile URL (such as http://mobile.twitter.com/), not the original URL (such as http://twitter.com).
- If you specify an HTML animation for a Web Content overlay, set the overlay to Auto Play with a minimal delay (such as 0.125 seconds) to ensure that the animation plays properly.

To create a Web Content overlay:

1  Do one of the following:
   - Using the Rectangle tool or Rectangle Frame tool, drag to create the frame that displays the web content.
   - Place an image that acts as a poster for the web content.

2  Select the frame, and select Web Content in the Folio Overlays panel.

3  Do one of the following:
   - To specify a URL, type or paste the URL in the Assets field. Type the entire URL, including “http://.”
   - To use local HTML files, click the folder icon and specify the local HTML file. The HTML file (such as index.html) should appear in a folder that includes any images or scripts used in the HTML file.

4  Specify any of the following options:

   **Auto Play**  Select this option to load the web page when the page is loaded on the mobile device. You can also specify the number of seconds to delay. If your target HTML is an animation that plays, specify a minimal delay.

   **Transparent Background**  If this option is selected, the transparent background in a web page is preserved. Users can see through the transparency to view the DPS content in the background. If this option is deselected, the web content background is used.
Allow User Interaction  If this option is selected, users can interact with the web page. For example, they can tap a hyperlink to jump to a different web page.

Scale Content To Fit  If this option is selected, the web page is scaled to fit within the size specified in the overlay file. If this option is not selected, the web page is displayed at the same size it would appear in the device’s browser, and the HTML page can be cropped.

Allow Access to Entitlement Information  If you have an Enterprise account, you can create a Web Content overlay that displays different content for different users depending on how the folio was obtained. For example, if a user downloads a complimentary (“first issue free”) folio, the overlay can display a subscription offer. If a user obtains the folio through a subscription, the overlay can display an offer for additional products.

In addition to selecting this option for the overlay, add a custom JavaScript API to your HTML code. For more information, contact your Adobe representative.

You can also create this type of conditional HTML content for an HTML article instead of a Web Content overlay. For an HTML article, select the Allow Access to Entitlement Information in the Folio Producer Editor.

More Help topics
“Import HTML articles” on page 81
“Supported interactivity features” on page 50
“Best practices for creating overlays” on page 51

Pan and Zoom overlays

You can display a large image in a small area and allow the user to pan and zoom the image within that area.

1  Place a JPEG or PNG image.

2  Using the Selection tool, drag the a selection handle to crop the frame without resizing the image. Make the frame the size of the view area. Position the image within the frame to determine the initial view area.

Make sure that the container frame is smaller than the image. If the width or height of the frame and image are the same size, the object is treated as scrollable content.

To add a poster to the Pan and Zoom overlay, create a frame the same dimensions as the image pan, and place it over the Pan and Zoom overlay. When the user taps the poster, the image pan is activated and hides the poster. When the user double-taps the image pan, the poster is displayed again.

3  To change the initial view magnification, use the Direct Selection tool to select the image (not the frame), and scale the image.

You can change the image size to 100% or lower. The maximum scale is 100%.

4  Select the image frame, and open the Folio Overlays panel. Click the Pan & Zoom tab, and then select On.

To make an entire page of an article pinch and zoom, create an article with PDF image format. See “Enabling pinch and zoom for articles” on page 35.

Pan and zoom guidance

Note the following:

• Currently, the view area must be rectangular.
For best results, use JPEG images.

If you create a pan-and-zoom overlay that is larger than 2000x2000-pixels in 72 ppi, test it thoroughly on the mobile device. Large images increase the file size and can cause memory problems on mobile devices.

As a general rule, make sure that the image has the exact dimensions you want to use. For example, to pan a 1024-by-1024 pixel image within a 200-by-200 pixel view area, create a 1024-by-1024 image in 72 ppi. However, if you are using 1024x768 source documents in a 2048x1536 folio, using 72 ppi images can result in a different initial view experiences on different iPad models. To avoid this, create a high-resolution version of the image in an HD subfolder. See “Creating multi-rendition PDF articles for iOS devices” on page 42.

The Pan and Zoom feature is not designed to work with transparent images. When a page with an image pan is loaded, the poster appears, and the actual overlay is invisible until it is tapped. When users double-tap the overlay, it disappears and the poster is displayed. If the image pan contains transparency, the poster shows through and appears to be a duplicate image. One workaround is to create a two-state MSO in which the poster is a button on the first state that links to the pan and zoom image on the second state.

More Help topics
“Scrollable Frame overlays” on page 68
“Supported interactivity features” on page 50
“Best practices for creating overlays” on page 51

Scrollable Frame overlays

You can create a scrollable frame that lets users scroll to view more content. For example, you can create a cooking page with a list of ingredients and a set of instructions. Rather than turning to the next page to see the full set of ingredients or instructions, users can swipe to scroll.

By default, the initial view for scrollable content is the upper-left corner of the container frame. However, you change the initial view so that it’s based on the location of the content frame.

You can add all interactive overlays to scrollable frames (see “Nesting interactive overlays” on page 69). The previous method of creating scrollable frames using layers is no longer supported.

1 To make a frame that scrolls vertically, create a content frame and a container frame.
   • The content frame can be a text frame, an image, or a group of objects.
   • You can include any interactive object except a slideshow in your content frame. Either add the interactive objects to the text frame as anchored objects or group interactive objects with other objects.

2 Move the content frame to its initial view area in relation to the container frame.
   If you use the default settings, the content frame will align to the upper left corner of the container frame. However, you can use the document location of the content frame to determine the initial view.

3 Select the content frame, and choose Edit > Cut.
   To avoid erratic behavior, make sure that the content appears in the layout page area, not the pasteboard.

4 Select the container frame, and choose Edit > Paste Into.

   Note: When you paste the content frame into the container frame, any button with an MSO state action loses its action. Select the button and add the action again. (The selection buttons in the toolbar are especially useful for selecting hidden buttons. The Layers panel is another way to select nested objects.)
5 With the container frame still selected, open the Folio Overlays panel. Click the Scrollable Frame tab, and then specify these options.

**Scroll Direction** Choose Auto Detect to determine the scroll direction based on the height and width of the container frame and content frame. If the heights of the frames are the same but the widths are different, the content scrolls only horizontally. To make sure that the content scrolls in only one direction even if the container frame is narrower and shorter than the content frame, choose Horizontal or Vertical. Choosing the Horizontal & Vertical option offers the same behavior as Auto Detect.

**Scroll Indicators** Select Hide if you don’t want scroll bars to appear when scrolling.

**Initial Content Position** Select Upper Left to align the content frame to the upper left corner of the container frame as the initial view. Select Use Document Position to use the location of the content frame as the initial view.

**Export Format in PDF Articles** If your scrollable frame appears in an article that uses PDF format, you can choose Bitmap or Vector. Choosing Vector is especially useful when you’re creating a single folio for both SD and HD iPads or iPhones. The Vector option provides sharper text when the folio is displayed on an HD iOS device, but it takes a moment to load. For best results, use Vector for text-intensive scrollable frames, and use Raster for image-based scrollable frames or when creating separate renditions for SD and HD iOS devices.

*Note:* See the free DPS Tips app to view examples of scrollable frames, including nested scrollable frames and pullout tab effects.

**More Help topics**

“Supported interactivity features” on page 50

“Best practices for creating overlays” on page 51

“Smooth scrolling articles” on page 33

---

**Nesting interactive overlays**

You can embed interactive overlays in either scrollable frames or slideshows (multi-state objects). However, you cannot embed a multi-state object in scrollable frames or another slideshow.

**Slideshows** You can use a number of different methods to add overlays to a slideshow state. You can select a state and choose Paste Into. You can align the overlay with the multi-state object, select both, and then choose either paste the object into the selected state or create a new state. You can also group the overlay with other objects, align that group with yet more objects, and then create the multi-state object.

**Scrollable frames** Create the interactive overlay, such as an image sequence or button. You can then either group the overlay object with other objects in the content frame or paste the overlay into text to create an anchored object. Then paste the content frame into the container frame and select Pan Only in the Folio Overlays panel.

Note the following guidelines:

- You can add buttons to a scrollable frame that change states in a slideshow. When you paste the button into the content frame, the state-based button action is removed. Select the button again, and then re-create the action. If the button is hidden, use the Select Content and Select Next icons in the Control bar to select the object.
In order for a multi-state object to become an interactive slideshow, an action must trigger one or more of the states to change. Otherwise, only the current state is displayed in the viewer. To make the MSO a slideshow, you can select an option such as Auto Play in the Folio Overlays panel. Or, you can create a button with an MSO state action. However, a button within a state does not make the MSO interactive. If you want to use only buttons within the MSO to change slides, create an invisible “dummy” button outside the MSO to make it interactive.

To create a hot spot effect, combine a button with a two-state multi-state object in which one state is blank. For example, tapping a button can trigger an image sequence or web content overlay.

For additional examples of embedded overlays, see the DPS Tips app.
Chapter 4: Folios and Articles

Create and manage folios

A folio includes one or more digital publishing articles. A folio appears as an issue in the library of either the Adobe Content Viewer or a custom multi-issue viewer. If you create a custom single-issue viewer, the folio includes the contents of that viewer app.

Folio Builder panel overview

Use the Folio Builder panel to create folios and add articles. To open the panel, choose Window > Folio Builder (InDesign CS6) or Window > Extension > Folio Builder (InDesign CS5 or CS5.5). The Folio Builder panel displays the folios to which you have access. The Folio Builder panel includes three views: folio view, article view, and layout view. To navigate, do any of the following actions:

- Double-click a folio or click the arrow to the right of the folio to display the folio’s articles.
- Double-click an article or click the arrow to the right of the article to display the article’s layouts.
- Click the arrow icon in the upper left corner of the panel to move up a level.

Filter displayed folios

To determine which folios are displayed, choose All, All Local, In the Cloud (to hide local folios), Private (to hide shared folios), or Shared from the drop-down menu in Folio view.
Sort folios
Choose an option from the Sort drop-down menu in Folio view to determine the sort order of folios in the Folio Builder panel. Select Reverse List to reverse the order for any folio selected.

Sign in to Folio Builder panel
Signing in to the Folio Builder panel is optional. Signing in to the panel lets you upload folios to the acrobat.com site. You can then download folios to the Adobe Content Viewer on a mobile device and share folios with other users. If you don’t sign in to the panel, you can still create and preview local folios, and you can build a Single Edition app. Use a verified Adobe ID to sign in to the Folio Builder panel.

1 Make sure that your computer is connected to the internet.
2 In the Folio Builder panel, click Sign In, and then sign in using a verified Adobe ID.
3 If you do not have a verified Adobe ID, do one of the following:
   • If you have an Enterprise or Professional subscription to DPS, use the Account Administration tool to create an Adobe ID with an Application role. Use the appropriate Adobe ID to sign in to the Folio Builder panel. See “Account Administration tool” on page 132.
   • To verify an Adobe ID to work with DPS, go to https://digitalpublishing.acrobat.com/ and click Create Account. Sign up for an account using a valid email address. Adobe will send you a verification message. Open that message and verify it. Then use that Adobe ID to sign in to the Folio Builder panel. See “Using Adobe IDs for digital publishing” on page 5.

Create a folio
A folio is a collection of articles. Anyone with InDesign CS5 or later can create folios.

When you sign in and create a folio, a workspace is created on the acrobat.com web server. The content of any article you add to the folio is uploaded to that workspace.

1 To open the Folio Builder panel, choose Window > Extensions > Folio Builder (InDesign CS5 or CS5.5) or choose Window > Folio Builder (InDesign CS6).
2 If you have not already signed in, click Sign In, and sign in using a verified Adobe ID.
   If you do not sign in to the Folio Builder panel, you can create an offline folio. You can then upload that offline folio after you sign in.
3 Click New to create a new folio.
   You can also choose File > New > Folio in InDesign CS6 to create a folio.
4 Specify the following settings, and click OK.
Creating a new folio

**Folio Name**  Specify the folio name. The folio name is different from the Publication Name that appears in the viewer. The maximum number of characters for Folio Name is 60.

**Viewer Version**  Specify the target viewer version. This option is especially useful if either the newest version of the Adobe Content Viewer is awaiting approval or if you’re creating folios for an earlier viewer app. Once you create a folio, you can edit folio properties to increase the version number, but you cannot roll back to an earlier version. Instead, create a new folio. You cannot specify a viewer version earlier than v20.

**Target Device**  Select the target device or specify custom dimensions of the target device, such as 2048x1536 an HD iPad.

When you specify the folio size for the target device, take into account whether the device displays a navigation bar. For example, a 48- or 75-pixel navigation bar appears in some Android devices, causing the viewer to scale a 1280x800 folio. Instead, create a smaller folio size (such as 1205x725) for dual-orientation folios. See “Creating documents for multiple devices” on page 39.

**Orientation**  Indicate whether the folio is portrait-only, landscape-only, or dual orientation. To preview or publish the folio, all articles must match the folio orientation. For example, if a dual-orientation folio includes an article with only a portrait layout, the folio cannot be downloaded in the Adobe Content Viewer library.

**Default Format**  Choose a default option for the folio. Individual articles can have different Article Format settings.

Choose Automatic if you want to let InDesign determine whether to export the pages as JPEG or PNG. Choosing PDF lets users pinch to zoom in and out, preserves vectors, and reduces file size. See Differences Between JPG, PNG, and PDF Image Formats.
**Default JPEG Quality** If Automatic or JPEG is selected for Default Image Format, specify the JPEG Quality. Increased quality increases the file size.

**Cover Preview** A preview image represents each folio added to the viewer in the viewer library. Specify the portrait and landscape cover images. Create cover images as 72-dpi JPG or PNG files using the same pixel dimensions as the target device, such as 1024x768.

**Create Offline Folio** Select this option if you do not want to upload the folio content to the server at this time. You can later choose Upload To Folio Producer from the panel menu to upload folio contents.

For information about troubleshooting the Folio Builder, see Troubleshoot Folio Builder and Troubleshoot article upload failures in Folio Builder panel.

**Change folio properties**

After you create a folio, you can use the Folio Properties dialog box to specify a publication name, change the viewer version, and choose cover preview images. Some folio properties such as orientation, image format, and folio size cannot be edited in the Folio Properties dialog box. If necessary, create a new folio with the appropriate settings.

When you're ready to publish your folio, use the Folio Producer Organizer to specify folio properties for publishing.

1 In the Folio Builder panel, select a folio.

![Folio Properties dialog box](image)

**Change folio properties.**

2 Choose Folio Properties from the Folio Builder panel menu to open the Folio Properties dialog box.

3 Specify the following settings, and then click OK.

**Publication Name** The Publication Name you specify appears in the viewer. The maximum number of characters for Publication Name is 60.

*Note: To avoid problems, use only alphanumeric or numeric characters in the the Publication Name. Do not use special characters such as apostrophes ('), or unexpected results such as an “[svr.InvalidParameter]” error message might occur.*

**Viewer Version** If you want to specify a different viewer version for the folio, select the appropriate version. You can select a newer version, but not an earlier version. To target an earlier version, create a new folio.
Note: If you’re editing a folio that was created before v20, make sure that you specify a Viewer Version setting.

**Right Edge Binding**  Select this option to display articles from right to left rather than left to right in the viewer. This option is especially important for Asian languages.

**Cover Preview**  A preview image represents each folio added to the viewer in the viewer library. Specify the portrait and landscape cover images. Create cover images as 72-dpi JPG or PNG files using the same pixel dimensions as the target device, such as 1024x768.

4 To change additional folio properties for publishing a folio, choose Folio Producer from the Folio Builder panel menu, and specify settings in the Folio Producer Organizer. See “Folio Producer Organizer” on page 99

**Folio Name**  The Folio Name appears in the Folio Producer and in the Folio Builder panel, but it does not appear in the viewer. If you are creating renditions for different devices, make sure that the Folio Name settings are the same among renditions.

**Publication Name**  The Publication Name appears in the viewer library and in the viewer navigation bar. The maximum number of characters for Publication Name is 60.

**Folio Number**  The Folio Number can be a number or a description, such as “May 2013.” The maximum number of characters for Folio Number is 60.
Publication Name and Folio Number appear in the viewer.

Publication Date  The Publication Date setting determines the order of folios in the library. The newest folios appear at the top. The Publication Date setting is especially important for subscription viewers in which customers are entitled to folios within a specific duration as determined by the Publication Date settings. For best results, manually select a Publication Date setting.

Product ID  The Product ID specified when you published the folio is displayed. You cannot edit this field directly. The Product ID is especially important for retail folios. It ties the folio to the in-app purchase Product ID in the app store. The maximum number of characters for Product ID is 60.

Published  A check mark appears in the Published column if the folio is published.

Locked  Select this option to prevent anyone from uploading a new version of the article or changing article metadata. A locked icon appears next to the article in the Folio Builder panel of anyone who has access to the folio.

Cover Previews  Specify .png or .jpg files for the images that appear in the viewer library.

Description  The Description appears in the viewer library and in the viewer navigation bar.
Library Filter  Type the filter name for each folio in your app. The maximum number of characters for Library Filter is 60. See “Create library filters” on page 100.

Right Edge Binding  Selecting this option in the Folio Details area displays articles from right to left rather than left to right in the viewer. This option is especially important for Asian languages.

Cover Date  Cover Date is an additional metadata control that gives certain Enterprise publishers more control over direct entitlement.

Create offline folios

An offline folio, or local folio, is not uploaded to the acrobat.com service on the web. Creating an offline folio is especially useful when you’re not connected to the Internet, or if the acrobat.com service is temporarily out of service.

You cannot convert an uploaded folio to an offline folio.

1  To create an offline folio, do either of the following:
   •  Click Create New Folio in the Folio Builder panel when you are not signed in.
   •  Click Create New Folio in the Folio Builder panel, and then select Create Offline Folio.

2  Add articles and edit the folio.

   You can preview offline folios on your desktop or using Preview on Device. See “Preview folios and articles” on page 89.

   When you preview or upload an offline folio, the folio is updated automatically to account for changes to the source InDesign documents. Choosing Update to update an offline folio is not necessary.

3  To upload the folio, sign in to the Folio Builder panel, select the folio, and choose Upload To Folio Producer from the panel menu.

   You can upload an offline folio only if the source files are available.

   Once you upload a folio, you cannot make the folio local.
Share folios
Share a folio if you want to let other people review the folio you’re working on or to make it available to them. For example, if you’re creating an ad for a publisher, you can share the folio that contains your ad with the publisher. Or, if you’re a publisher, you can share a folio with different designers to let them upload articles.

Whenever you update an article in the shared folio, recipients are notified that an update is available when they open the library in the Adobe Content Viewer. If you don’t want recipients to view updates, unshare the folio.

1 In the Folio Builder panel, select a folio.
2 Choose Share from the Folio Builder panel menu.
3 In the Share dialog box, type the email addresses of the people with whom you want to share your folio. Use a comma or semi-colon to separate the email addresses. Press Tab to move to the next field.
4 Type the subject and message, and then click Share.

When recipients open the Adobe Content Viewer on a mobile device, the shared folio is available for downloading.

If recipients open the folio in the Folio Builder panel, a share icon appears next to the folio name in the Folio Builder. Recipients can open the folio and add articles. However, they cannot edit existing articles.

Unshare folios To unshare a folio that you shared with others, select the folio in the Folio Builder panel, and choose Unshare from the panel menu. Select the recipients with whom you want to unshare, and click OK. Unsharing makes the folio unavailable for downloading and removes it from shared recipients’ Folio Builder panel, but it does not remove folios that have been downloaded to devices. Deleting a shared folio also makes it unavailable for downloading.

Remove a folio shared with you If someone has shared a folio with you and you no longer want access to it, select the folio in the Folio Builder panel and click the trash icon. Deleting the shared folio removes your information from the owner’s shared recipients list.

Delete a folio
When you delete a folio, you remove the workspace from the server, and you delete all articles in that folio, but not the source documents. If you published a folio to the Distribution Service, use the Folio Producer Organizer to remove that folio before deleting it. Avoid removing and deleting retail folios.

1 If the folio is published, use the Unpublish button in the Folio Producer Organizer to remove the folio from the Distribution Service.
2 Select a folio in the Folio Builder panel, and then click the Trash button.

If a folio was downloaded in a viewer before it was deleted, it remains in the viewer library until it’s removed.

Create articles and layouts
Folios consist of articles. You can create articles that are either based on InDesign documents or HTML files. You can use two methods to add articles to a folio: use the Add Article button to create articles based on open documents, or import articles from a folder.

Create an article from an open document
Articles can include either one or two layouts for portrait and landscape orientation on the mobile device. However, you must be consistent within the published folio. All articles in the published folio must be portrait only, landscape only, or dual orientation.
Open the InDesign document that is designed for digital publishing. See “Designing digital publications” on page 32.

The document dimensions can be different from the folio size in two situations.

- The aspect ratios of the folio and document page size are identical. For example, you can add 1024x768 documents to a folio that is set to a 2048x1536 folio size because both aspect ratios are 4:3.
- The document is designed for smooth scrolling. For example, if you create a 1024x2000 document with a single page, the added article should be set to Smooth Scrolling.

In the Folio Builder panel, create or open the folio in which the article will appear.

In the Articles view of the Folio Builder panel, click Add.

Specify the following options, and click OK.

- **Article Name**: Specify the article name. The article name does not appear in the viewer. The Article Name is used for creating links between articles, so use a name such as “City_Guide” instead of a filename such as “city_guide_h.indd.” The maximum number of characters for Article Name is 60.

- **Article Format**: Specify an image format setting for the article. For example, you can choose PDF for an article to allow pinching and zooming. See Differences Between JPG, PNG, and PDF Image Formats.

- **JPEG Quality**: If Automatic or PNG is selected for Image Format, specify the JPEG Quality. Increased quality increases the file size.

- **Smooth Scrolling**: Set the Smooth Scrolling for the article, not for just the layout you’re adding. For example, if you’re adding only the vertical layout in a dual-orientation folio, choose Both Directions if both layouts are smooth scrolling. Select Horizontal Only or Vertical Only if it’s a single-orientation article or if only one layout is smooth scrolling.

**Note:** When you select a Smooth Scrolling option in InDesign CS6, you can specify alternate layouts. If your smooth scrolling document has only one layout, choose it for the appropriate layout, and choose None for the other layout that you will add later.
Add a layout to an article

InDesign CS6 documents can include multiple layouts. When you add an article, you can specify both horizontal and vertical layouts. If you’re using InDesign CS5 or CS5.5, or if you created only one layout in InDesign CS6, you can add a layout from a different document. If the article appears in a dual-orientation folio, the article requires a second layout.

1. Open the InDesign document that is designed in a different layout orientation from the existing article layout.
2. In the Folio Builder panel, double-click the article to which you want to add the second layout.
3. In the Articles view of the Folio Builder panel, click Add Layout. If the document includes multiple layouts, specify the appropriate layout.

Import InDesign articles

If you use the appropriate structure and filing conventions, you can import either a single article or a set of articles. Currently, if your InDesign CS6 document includes multiple layouts, you cannot import it as an article. Use the Add Article option instead.

When you import articles, the aspect ratio of the articles must match the aspect ratio of the folio unless you select a Smooth Scrolling option.

1. Create one or more folders containing InDesign documents. See “Structuring folders for imported articles” on page 45.
2. In the Folio Builder panel, open the folio in which the article or articles will appear.
3. In the Articles view of the Folio Builder panel, choose Import Article from the panel menu.

4. Do either of the following:
   - Choose Import A Single Article, click the Location folder icon, and specify an article folder.
• Choose Import Multiple Articles, click the Location folder icon, and specify a folio folder containing article folders.

5 Select a Smooth Scrolling setting for the article. For example, if you’re importing an article for a dual-orientation folio, but you want only the horizontal layout to be smooth scrolling, choose Horizontal Orientation.

6 Specify the image format settings, and click OK.

If your article folders include .png images on the same level as the InDesign documents, the images are used as table of contents icons. If you import multiple articles in which the folio folder includes a sidecar.xml file, the file determines the order of articles and populates the article properties. See “Create a metadata sidecar file for importing articles” on page 46.

If your articles fail to import properly, see Troubleshoot article upload failures in Folio Builder panel.

Import HTML articles

You can import HTML-based articles into a folio so that it can be displayed in the viewer as an article. One advantage of HTML articles is a much smaller file size that is better suited for weekly publications and simple, text-intensive articles. HTML articles can also include interactivity not available in the Folio Overlays panel.

For information about using Adobe Edge to create HTML for DPS, see Raghu Thricovil’s article Enhance your DPS Folios with HTML animations using Adobe Edge.

1 Create a folder containing HTML files.

Make sure that you include only the assets you’re using in the folder. All assets in the folder are uploaded, even if they’re not used.

2 If you are importing the HTML article into a single-orientation folder, add an _h or _v suffix to the .html file, such as index_h.html.

If you don’t add a suffix, the article is imported as a dual-orientation article. If you try to preview or publish the single-orientation folio, an error message appears.

3 In the Folio Builder panel, open the folio in which the HTML article will be included.

4 In the Articles view of the Folio Builder panel, choose Import Article from the panel menu.

5 Choose Import A Single Article, click the Location folder icon, and specify the HTML folder.

6 Specify additional settings, such as Smooth Scrolling, and click OK.

If you edit the HTML files, select the HTML article in the Folio Builder panel and choose Update.

Note: If you’re editing a folio that was created before v20, open the Folio Properties dialog box and specify a Viewer Version setting. If Unspecified is selected, you cannot import an HTML article at this time.

HTML article requirements

• You can create a single HTML file that works for both portrait and landscape orientations, or you can create separate HTML files for the two orientations. To use separate HTML files for portrait and landscape, add the _v and _h suffixes to the end of the HTML filenames, such as “index_h.html.” If you’re creating a single-orientation folio, you need only one HTML file. Include the _h or _v suffix for the HTML file in a single-orientation folio.

• Dynamic HTML (DHTML) files currently are not fully supported.
For file structure, one method is to place all associated graphics and scripts for the HTML file in the individual article folders. Another option is to place associated graphics and scripts for the entire folio in an HTMLResources.zip file. You import the HTMLResources.zip file into the folio from the Folio Builder panel or the Folio Producer on the web. See “Import HTMLResources” on page 104.

Example of an HTMLResources folder

- Make sure that you use relative paths in your HTML code. If you’re linking to an image on the same level as the HTML file, use this approach:

  `<img src="GlobalImage.jpg"/>

  If you’re linking to an image in the HTMLResources folder, use this approach:

  `<img src="../HTMLResources/GlobalImage.jpg"/>

  For information on creating hyperlinks to and from HTML articles, see “Create navto hyperlinks for HTML articles” on page 55.

Creating HTML articles for Android Viewers

For guidance and requirements on creating HTML articles for Android Viewers, see Create HTML articles for Android Viewers.

HTML5 resources

- For information about creating articles using HTML5, see Johannes Henseler’s article A single file HTML5 framework.
- For information about using CreateJS to create HTML5 using Flash Pro, see Toolkit for CreateJS.
- For information on which fonts are available in HTML articles and Web View overlays on the iPad, see www.michaelcritz.com/2010/04/02/fonts-for-ipad-iphone/.
- Rufus Deuchler created a video tutorial about using Adobe Muse to create HTML content for digital publications.

Creating scrubber thumbnails for HTML articles

For InDesign articles, the viewer automatically generates the thumbnails that appear when you drag the scrubber. However, generating thumbnails for HTML articles takes more time, sometimes resulting in poorly rendered thumbnails. To improve thumbnail performance in HTML articles, you can manually add image files to the HTML article folders.
Create png files that are named “scrubberthumbnail_h.png” and “scrubberthumbnail_v.png” (you can also use _l and _p suffixes). Add these files to the HTML article folder. There is no size restriction for these images, but note that they are scaled down proportionally to a height of 166 pixels. As a point of reference, when thumbnails are generated, landscape thumbnails are 221x166 pixels, and portrait thumbnails are 125x166 pixels.

Allowing videos in HTML articles to behave like full-screen video overlays
When you create a single-orientation HTML article with video links, rotating the device can cause the playing video to rotate as well. In addition, when the video is finished playing, the in-app browser playing the video can be dismissed. To enable this behavior, use a “videofile://” prefix in your HTML video link.

For examples of video behavior, see the Effects issue of the free DPS Tips app.

**Standard video behavior**  With this example, the video plays within an in-app browser and does not rotate in a single-orientation folio.

```html
<a href="Links/video.mp4">Play Video</a>
```

or

```html
<a href="../HTMLResources/videos/video.mp4">Play Video</a>
```

**Enhanced video behavior**  With this example, the video rotates properly in a single-orientation folio and returns to the article when the video finishes.

```html
<a href="videofile://Links/video.mp4">Play Video</a>
```

or

```html
<a href="videofile://../HTMLResources/videos/video.mp4">Play Video</a>
```

**JavaScript**  You can also trigger this behavior via JavaScript using the playFullscreenVideo function on the window object.

```html
<a onclick="window.playFullscreenVideo('Links/video.mp4');">Play Video</a>
```

or

```html
<a onclick="window.playFullscreenVideo('../HTMLResources/videos/video.mp4');">Play Video</a>
```

**Streaming video**  This example plays a streaming video.

```html
<a href="videohttp://www.mysite.com/video.mp4">Play Video</a>
```

More Help topics

“Link to assets in the HTML Resources folder” on page 56

“Embed fonts in HTML articles” on page 104

**Create and manage articles**

Use the Folio Builder panel menu to update, copy, and rename articles.
Folio Builder panel menu

**Change article properties**

The article properties you specify determine how the article appears in the viewer. You can change article properties using either the Article Properties option in the Folio Builder panel or the Folio Producer Editor.
1 In the Folio Builder panel, select an article.

2 Choose Article Properties from the Folio Builder panel menu.

3 Specify the following options and click OK.

   **Title** Specify the article title as it should appear in the viewer. The Title value is different from the Article Name, which appears in the Folio Builder panel. The Article Name is used for creating links between articles. The Title appears in the table of contents and in folio navigation views. The maximum number of characters for Title is 60.

   **Byline** Specify the author’s name. The maximum number of characters for Byline is 40.

   **Kicker** The section title of a magazine, such as “Reviews,” “Features,” or “Editorial.” The kicker appears in the table of contents and in folio navigation views. The maximum number of characters for Kicker is 35.

   **Description** Describe the article. The description appears when the folio is viewed in browse mode. The Description appears in the table of contents and in folio navigation views. The maximum number of characters for Description is 120.

   **Advertisement** Select this option to mark the article as an advertisement for analytics reporting.

   **Hide From TOC** Select this option to prevent the article from appearing when users tap the TOC button in the viewer nav bar.

   **Smooth Scrolling** In the Smooth Scrolling column, specify whether each article scrolls continuously or by snapping to the page. Smooth Scrolling works only in the vertical direction for swiping up and down. The document cannot include multiple pages. You can apply the Smooth Scrolling setting to landscape only, portrait only, or both layout orientations. See “Smooth scrolling articles” on page 33.
**Horizontal Swipe Only**  When you select Horizontal Swipe Only for an article, users browse through the article by swiping left and right instead of up and down. This option was previously called “Flatten.” See “Swiping articles horizontally” on page 34.

**Table of Contents Preview**  When users tap the Table of Contents button in the viewer’s navigation bar, a 70x70-pixel table of contents icon appears next to each article. A default table of contents icon is generated automatically from the first page of the article. To use a different icon, click the folder icon and choose a PNG file. To reduce folio size, use 70x70-pixel files in 8-bit PNG format.
4 To change additional article properties not found in the Article Properties dialog box, use the Folio Producer Editor. Choose Folio Producer from the panel menu to open the Folio Producer Organizer. Select the folio, and then choose Open. Then select the article and edit the following properties. See “Folio Producer Editor” on page 101.

**Order** Enter numbers to re-order the articles.

**Locked** Lock an article so that it cannot be updated.

**Download Priority** When customers download the custom viewer, they can view the file while it’s still being downloaded. Unless you change the download priority, the articles are downloaded from first to last.

**Tags** Tags appear in Browse Mode of the viewer. The maximum number of characters for Tags is 75.

**Protected** This option determines whether an article is included with social sharing. When an article is protected, it is not uploaded to the web server for viewing in a desktop browser. When you deselect Protected, the article is uploaded to a server for viewing. See “Using social sharing” on page 139.

**Allow Access to Entitlement Information** If you have an Enterprise account, you can create an HTML article that displays different content for different users depending on how the folio was obtained. See “Web Content overlays” on page 66.

**Section** If you divide a folio into sections such as Sports, Business, and Style, specify a section name for each article in the folio. The maximum number of characters for Section is 60. See “Create Sections” on page 103.

### Edit and update an article

When you create an article or an article layout, the content of the InDesign document is uploaded to the workspace on the server. When you edit and save a document that is part of an article, changes are saved only locally until you update the article. You can select and update multiple articles.

1 To edit a document, double-click a layout in the Folio Builder panel, and make changes. You can use any method to open the document.

   You don’t need to be signed in or connected to edit an article document.

2 After you edit and save the document, sign in to the Folio Builder panel, and select the article containing the document you edited.

   If you have edited the source files of multiple articles, you can hold down Shift or Ctrl/Command to select multiple articles for updating.

3 Choose Update from the Folio Builder panel menu.

When you update an article, both layouts are updated. If you want the updated article to be available in a published viewer app, use the Folio Producer Organizer to update the folio.

*If you use the same source document in multiple folios, remember to update the article in each folio.*

### Copy an article to another folio

Once you create an article based on a document, you don’t need to create another article if you want it to appear in a different folio. Instead, copy the article from one folio to another.

1 In the Folio Builder panel, open the folio containing the article, and select the article.

2 Choose Copy To from the Folio Builder panel menu.

3 In the Copy To dialog box, choose the target folio, and then click OK.
You can also use the Folio Producer to copy articles between folios.

**Rename an article**
When you rename an article, you risk breaking links that target the renamed article.

1. In the Folio Builder panel, select an article.
2. Choose Rename from the Folio Builder panel menu, and then enter a different name.

**Delete an article**
When you delete an article, you remove it from the folio and from the workspace on the server. However, the source InDesign documents are not deleted.

1. In the Folio Builder panel, select an article.
2. Click the Trash button, and then click Delete.

**Change the order of articles**
To change the order of articles, drag and drop them in the Folio Builder panel, or use the Folio Producer Editor to change the article order. See “Folio Producer Editor” on page 101.

You can also use the sidecar.xml file to rearrange articles and update metadata. See “Create a metadata sidecar file for importing articles” on page 46.

**Relink articles to source files**
If you move the source documents for an article to a new location or transfer them to a different computer, you can reconnect the source files to the article layouts in the Folio Builder panel.

1. If you transfer the files to a different computer, make sure that broken links are resolved. Also make sure that interactive overlays point to the appropriate file or folder.
   - If the overlay no longer points to the appropriate location, an “invalid asset location” error message occurs when you create the article.
2. In the Folio Builder panel, choose Relink from the panel menu.
3. Specify the file locations to relink with one or both layouts.

**Preview folios and articles**
Use Adobe Content Viewer to preview folios. The Adobe Content Viewer is available as a desktop application (called the “Desktop Viewer”) or as a mobile device application. The Desktop Viewer is installed automatically when you install the Folio Producer tools. The viewer for mobile devices is available for download in the iPad App Store, Google Play Store, and Amazon Appstore. Search in the device store for “Content Viewer.”

As soon as you create a folio or article, you can preview it using the Desktop Viewer or the viewer on your mobile device. However, to preview a folio, the articles in the folio must have the same aspect ratio and layout orientation. For example, if your folio includes a horizontal-only article mixed with dual-orientation articles, you cannot preview the folio. Instead, preview only the article.
More Help topics
“DPS App Builder” on page 113

Use the Desktop Viewer to preview content
The Adobe Content Viewer for the Desktop (also called the Desktop Viewer) is an AIR app that lets you preview folios on your desktop.

Articles exported with PDF image format are currently not supported in the Desktop Viewer.

1 In the Folio Builder panel in InDesign, select the folio or article that you want to preview.
   If you select a folio, all the articles in that folio are available for preview. If you select an article, only that article can be previewed.

2 Use the Preview button at the bottom of the panel. Choose an option from the View menu to rotate or resize the content. To simulate zooming in on an overlay such as a panorama, press the + or - keys.

   You can also preview a document by choosing File > Folio Preview or clicking Preview in the Folio Overlays panel. It isn’t necessary to create an article beforehand. This method is especially useful when your computer is not connected to the Internet. However, only one layout is previewed. To preview both layouts, preview using the Folio Builder panel.

Preview folios on the iPad or iPhone
The Adobe Content Viewer for the iPad/iPhone is a generic version of the viewer used for testing the digital content you create on the iPad or iPhone. This viewer is updated whenever the Folio Producer tools are updated.

   Note: However, when a new set of tools is released, folios you create using the newest viewer version may not work properly until Apple approves the new Adobe Content Viewer version. If you try to open the folio, a “Please update your app” message appears. If you have a Professional or Enterprise account, you can create a custom version of the Adobe Content Viewer. See "Create a custom Adobe Content Viewer for iPad and iPhone" on page 127. Otherwise, create a folio using a previous supported viewer version.

The Adobe Content Viewer library checks two locations for folios—the Folio Producer server and the Distribution Service. The Folio Producer (hosted by acrobat.com) contains all folios that appear in your Folio Builder panel. The Distribution Service contains all published folios. A blue stripe with a lightning bolt icon in the folio thumbnail indicates a folio downloaded from the Folio Producer server. A blue strip with a plug icon indicates a folio loaded through Preview on Device. Any folio published as Retail does not appear in the Adobe Content Viewer.
A blue stripe with a lightning bolt icon indicates a folio hosted on the Folio Producer server.

1. On your device, download or update the Adobe Content Viewer from the App Store.
2. Start Adobe Viewer on the iPad, and sign in using the same Adobe ID you use to sign in to the Folio Builder panel. The folios to which you have access are available for downloading and previewing.

Note: If your folio does not appear in the viewer library, check to make sure that the folio does not include articles that do not match the orientation of the folio, such as a landscape-only article in a dual-orientation folio.

More Help topics
“Use Preview on Device” on page 93

Navigate using the viewer
The following navigation techniques work whether you’re using the generic Adobe Content Viewer or a custom viewer. With the v25 release, several UI changes were made to the viewer.

- Rotate the mobile device to display either the horizontal or vertical version of the file.
- Swipe up and down to read an article. Swipe left and right to switch to a different article (or to switch to different pages of a flattened article).
- Tap interactive areas to play movies, rotate 360 images, and activate other interactive items.
• Tap a non-interactive area to display the navigation bars. Tap the Library button to jump to the library in a multi-issue app. Tap the Back button to return to the previous view. Tap the Table of Contents icon to view the table of contents. Drag the Scrubber to scroll through thumbnail images in browse mode.

• Tap the title in the navigation bar to return to the first article. Double-tap the title to toggle between the title and title plus version display. Triple-tap the title to reset the issue so that each article starts at the first page instead of the previously viewed page.

Remove folios from the viewer

To delete a folio from the viewer, tap the gear icon in the upper right corner of the library, choose Remove Issues from iPad, and then select and delete folios. (In pre-v25 viewers, tap the Archive button.) If the folio is still available on the server, the folio is still available to download in the viewer. If the folio is no longer available on the server, the folio disappears from the library.

To delete a folio from the iPhone library, swipe across the folio’s name from right to left. As you swipe, the View button changes to an Archive button.

Use the Android Viewer to preview content

The Adobe Content Viewer for the Android is a generic version of the viewer used for testing the digital content you create on the mobile devices running Android 2.2 or later. The Android Viewer is updated whenever the Folio Producer tools are updated.
Viewers are currently available only on Large and XLarge Android tablets, not Small or Normal.

1. Download Adobe Content Viewer from the Android Market or Amazon Appstore.

2. Start Adobe Viewer on the Android device, and sign in using the same Adobe ID you use to sign in to the Folio Builder panel.

   The folios to which you have access are available for downloading and previewing.

**More Help topics**

“Differences between iOS and Android viewers” on page 44

**Use Preview on Device**

Instead of downloading folios from the server, you can use the Preview on Device feature to copy a folio directly from your computer to the mobile device.

**Preview on Device for iPad and iPhone (Mac OS only)**

1. Connect your iPad or iPhone to your computer.

2. On your iPad or iPhone, start the custom Adobe Content Viewer created using DPS App Builder.

   It isn’t necessary to sign in.

3. To preview a folio, in the Folio Builder panel in InDesign, select the folio you want to preview, and then choose Preview on [device name] from the Preview menu at the bottom of the panel.

   The previewed folio is copied from your computer to your device. The folio remains on your device when you disconnect it. When you archive the folio, it’s removed from the library.

4. To preview only the current layout, open the Folio Overlays panel and choose Preview on [device name] from the Preview menu at the bottom of the panel.

   The previewed layout remains on your device when you disconnect it. When you return to the library, the previewed layout is removed.

   Previewing on Device from the Folio Overlays panel displays only the pages of the current layout. Alternate layouts in InDesign CS6 are not included in the preview.

**Preview on Device for Android**

1. Do the following to make sure that your Android device can communicate properly with your computer.
   - Turn on USB Debugging. The location of the USB Debugging option varies depending on your Android device. For some devices, it’s located in Settings > Applications > Development.
   - (Windows only) Install the necessary device drivers to allow your Android device to communicate with your computer. The Flash Builder help includes useful information at Debug an application on a Google Android device and Install USB device drivers for Android devices (Windows).

2. Connect your Android device to your computer.

3. Start Adobe Content Viewer (v1.9 or later).

4. In the Folio Builder panel in InDesign, select the folio you want to preview, and then choose the device name from the Preview menu at the bottom of the panel.

   The folio is copied from your computer to your Android device.
Chapter 5: Assemble and Publish

Produce and publish folios

The Digital Publishing Suite Dashboard includes the tools Professional and Enterprise subscribers need to publish folio and build custom viewer apps. Use the Folio Producer to put the finishing touches on your folio and then publish it. Use the DPS App Builder to create a custom viewer app for Apple App Store, Google Play, or Amazon Appstore.

Professional and Enterprise subscribers can publish folios and create custom viewer apps. If you are not a DPS subscriber, you can use your Creative Cloud membership or a Single Edition license to publish single-issue viewers.

Related Articles

<table>
<thead>
<tr>
<th>To do this</th>
<th>Go here:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up account IDs for publishing (subscription only)</td>
<td>“Account Administration tool” on page 132</td>
</tr>
<tr>
<td>Understand the types of viewer apps</td>
<td>“Types of custom viewer apps” on page 94</td>
</tr>
<tr>
<td>Organize, edit, and publish folios</td>
<td>“Folio Producer Organizer” on page 99</td>
</tr>
<tr>
<td>Arrange articles and edit metadata</td>
<td>“Folio Producer Editor” on page 101</td>
</tr>
<tr>
<td>Create a Single Edition viewer app</td>
<td>“Single Edition overview” on page 9</td>
</tr>
<tr>
<td>Create a custom viewer app to submit to a store</td>
<td>“DPS App Builder” on page 113</td>
</tr>
</tbody>
</table>

DPS publishing overview

Anyone who has installed the Folio Producer tools can create a folio and share it with other people. To create a custom viewer app and submit it to the Apple App Store, Google Play, or Amazon Appstore, you need either a Professional or Enterprise subscription to the Digital Publishing Suite, or you need a Creative Cloud membership or a Single Edition license.

For information on subscribing to the Digital Publishing Suite, see www.adobe.com/products/digitalpublishingsuite/.

Types of custom viewer apps

The Adobe Content Viewer lets you preview folios and share them with individuals. To make your folios available in a store, you use the DPS App Builder to create a custom viewer app.

Single-folio viewer app

In a single-folio viewer app, the folio is built in to the viewer app. The viewer has no library. To create a single-folio app, you select the folio in the Folio Builder Panel and choose Create App from the panel menu. Then you build the app and upload it to the Apple Store. Professional and Enterprise subscribers can also export a .zip file using the Folio Producer Organizer and specify that .zip file using DPS App Builder.

At this time, you can create a single-folio viewer app for iPads but not for iPhones or Android devices.
A single-folio viewer does not have a library.

**Multi-folio viewer app**

In a multi-folio viewer app, you use the DPS App Builder to create a viewer that is essentially a shell. You then use the Folio Producer Organizer to publish folios to the Adobe Distribution Service. Customers use the viewer’s library to download folios to which they’re entitled. Use a different Adobe ID for each multi-folio viewer app you create. See “Using Adobe IDs for digital publishing” on page 5.
Assemble and Publish

The library of a multi-folio viewer lets customers download, view, and purchase folios.

You can create two kinds of folios for a multi-folio viewer app—free and retail. Any folio you publish that is set to Free and Public automatically appears in the custom viewer’s library with a Download button.

Any folio you publish that is set to Retail and Public must be tied to an in-app purchase you set up in iTunes Connect, Amazon Appstore, or Google Play. Use the same Product ID when you publish the folio that you use when you set up the in-app purchase. Retail folios appear in the custom viewer’s library with a Buy button. When customers tap Buy, they can purchase the folio.

Multi-folio subscription viewer app
A viewer app with subscriptions includes a Sign In button and a library option that lets customers select the type of subscription they want. For example, they can select a 3-Month, 6-Month, or 1-Year option. When they sign in, the viewer checks with the store to determine which folios they’re entitled to download.

You can set up a subscription that works with the Apple App Store or Amazon Appstore (Google Play subscriptions are not yet supported). In addition, if you’re an Enterprise customer, you can set up a custom entitlement server and give customers the choice of subscribing through the store or through your service.
Enterprise signed viewer app
Enterprise subscribers can create iPad apps for internal distribution only. An enterprise signed iPad viewer app is distributed within the company rather than downloaded from the Apple Store. See “Creating an enterprise-signed viewer app” on page 128.

Types of app distribution
Use the following methods to distribute your DPS content.

Through public app store Create an app and submit it to the Apple App Store, Amazon Appstore, or Google Play Store.

Through public app store with restricted distribution (Enterprise only) Create and submit a subscription app to the Apple, Google, or Amazon store. Use a custom entitlement server to determine which folios users can download and view based on their sign-in account. See Using restricted distribution with Digital Publishing Suite.

Through private server (Enterprise only) Create an in-house app and host it behind a firewall. See “Creating an enterprise-signed viewer app” on page 128.

About entitlement and fulfillment
Entitlement is the permission to download an item. Fulfillment is the process of making entitled content available to customers for downloading. The store (such as the Apple App Store or Google Play Store) is where viewer apps are available for downloading. You use the DPS App Builder to create custom apps for the store. The Distribution Service is where folios are available for downloading. You use the Folio Producer to publish folios to the Distribution Service.
Single-folio apps are downloaded entirely from the App Store. When customers download a multi-folio app and open
the library, the viewer checks the Adobe Distribution Service for folios that are available for downloading.

**DPS Dashboard**

Anyone with a valid Adobe ID can sign in to the Digital Publishing Suite Dashboard and edit folios. The Adobe ID you
use to sign in determines which features you can use.

DPS subscribers have access to the publishing tools on the Dashboard
A. Folio Producer for assembling and editing folios  B. DPS App Builder for create custom viewer apps  C. Analytics page for tracking user data
D. Download publishing guide

**Digital Publishing Suite subscription types**

There are two Digital Publishing Suite edition types: Enterprise and Professional.

**Professional** Users with a Professional account can use the authoring tools and the Dashboard tools and services to create
an unlimited number of custom viewer apps.

**Enterprise** Users with an Enterprise account have access to all the tools and services that a Professional is entitled to, plus
the ability to customize the viewer UI, create custom entitlement servers, create in-house enterprise apps, and more.

You can also use the Single Edition option to create a single-issue viewer app that you can submit to the Apple App
Store.

**Digital Publishing Suite account types**

When you subscribe to the Digital Publishing Suite, an Adobe representative sets up a master account. You can then
use the Account Administration service to assign roles to different Adobe IDs.

**Admin account** An Admin account is used to assign account types.
**Application ID account**  An Application ID ties published folios to a specific multi-folio custom viewer. For example, if a publisher creates magazines about outdoor sports, one Adobe ID should be created for each viewer app, such as “cycling@publisher.com” and “hiking@publisher.com.”

Avoid using an individual’s name (such as “johnsmith@publisher.com”) for the Application ID unless you have an existing custom viewer tied to that individual’s Adobe ID.

**DPS App Builder ID account**  Use the DPS App Builder ID to sign in to the DPS App Builder and create custom viewer apps.

**More Help topics**

“Using Adobe IDs for digital publishing” on page 5  
“Account Administration tool” on page 132

### Folio Producer Organizer

Clicking the Folio Producer link on the Dashboard ([https://digitalpublishing.acrobat.com](https://digitalpublishing.acrobat.com)) displays the Folio Producer. With the Folio Producer, you can organize and edit folios. If you sign in using a subscription account, you can publish folios. The Folio Producer includes an Organizer page that displays available folios and an Editor page that displays the articles in a folio.

![DPS Folio Producer: Organizer](image)

**Available folios displayed in Organizer panel**

*To open the Folio Producer Organizer directly, choose Folio Producer from the Folio Builder panel menu.*
Assemble folio articles

Any article that you create or import into a folio in the Folio Builder panel appears in the folio. In addition, you can use two other methods to add articles to a folio.

**Share**  In the Folio Builder panel, select the folio, and choose Share from the panel menu. Anyone with whom you share the folio can add articles to the folio. See “Share folios” on page 78.

**Copy To**  In the Folio Builder panel, select the article, and choose Copy To from the panel menu. Then copy the article to a different folio. You can also copy an article using the Folio Producer Editor. See “Copy an article to another folio” on page 88.

More Help topics
“Structuring folders for imported articles” on page 45

Change folio settings

Use the Organizer panel to specify folio information and change settings. Some of these settings are for internal tracking purposes. Settings marked with an asterisk (*) are necessary for publishing the folio.

1 Sign in to the Adobe Digital Publishing Suite Dashboard using the appropriate Adobe ID.
2 In the Dashboard, click Folio Producer.
   You can also choose Folio Producer from the Folio Builder panel menu in InDesign.
3 Change the properties of the folio. See “Change folio properties” on page 74.

Create library filters

If you specify filter names for each folio in the Folio Producer Organizer, the filter options appear in a drop-down menu in the viewer library.

For example, if you create different editions of the same folio for different languages, you can let your customers view folios only for one language and hide the folios for other languages. Or, you can create filters that display only the folios for a specific time period, such as “2011 Issues” and “2012 Issues.”

You can create only one level of filters. However, your customers can select multiple options in the drop-down list. For example, customers can display French and German folios and hide English and Spanish folios.
In this app, only the Basics and Info folios are displayed.

1. Create folios using the v22 viewer version or later.
2. In the Folio Producer Organizer, select the folio, and specify a filter name in the Library Filter text box.
   
   Make sure that you use the same filter names for folios that belong to a specific category. For example, if you specify “German” and “german” filters for different folios, these will appear as different options in the library.
3. Use DPS App Builder to create a viewer. Test the filters in the library to make sure that they work as intended.

**Folio Producer Editor**

With the Folio Producer Editor, you can edit article settings, some of which are not available in the Folio Builder panel. The Editor includes two views: a Thumbnail view for previewing articles and changing properties and a List view for ordering, locking, and changing other settings.
Assemble and Publish

Available articles in folio
A. Selected article  B. List view and Thumbnail view  C. Show horizontal or vertical layout

Use the List view to reorder articles manually, change download priorities, and edit other settings.

Folio articles displayed in List view

**Use Thumbnail view to preview articles**

HTML articles and InDesign articles that use JPEG or PNG image format display thumbnail images in the Folio Producer Editor. However, no thumbnails appear in articles that use the PDF image format.

2. Select the folio you want to edit and click Open.
3. Do any of the following:
   - **Change the order**  Drag an article to change its order.
   - **Edit article properties**  Changes you make to the Article Properties settings are reflected in the Folio Builder panel. See “Change article properties” on page 84.
   - **View horizontal and vertical layouts**  Click the Horizontal and Vertical buttons to change the layout. Drag the Thumbnail Size slider to resize article thumbnails.
   - **Add an article**  Click Add, and then choose article in the folio from which you want to copy. You can also copy an article to another folio by choosing Copy To from the article pop-up menu.
   - **Import HTMLResources.zip file**  Click to import the HTMLResources.zip file. See “Import HTMLResources” on page 104.
**Rename an article**  Choose Rename from the article pop-up menu, and then rename the article. Renaming an article changes the Article Name, not the Article Title that appears in the viewer. Renaming an article can result in broken navto links between articles.

**Edit article settings**

1. Select and open a folio in the Folio Producer Editor.
2. Using either Thumbnail View or List View, change any of the article settings. See “Change article properties” on page 84.

**Create Sections**

The Sections feature lets your customers download individual sections of a folio that you define. For example, you can divide a folio into News, Sports, Business, Style, and Money sections, and your customers have the option to download articles in only certain sections or all sections at once.

**Assigning Sections**

Specify Section information for each article in the Folio Producer Editor. Use the same Section name for at least two articles. For best results, create a v24 folio or later, and use the Folio Builder panel to update the articles in the folio to generate section cover images. Use a v24 viewer or later to view sections.

You can also specify sections for articles using the `<section>` tag in the sidecar.xml file. See “Create a metadata sidecar file for importing articles” on page 46.

**How Sections work**

When you specify Section information for articles in a folio, a View button appears in the viewer library instead of a Download or Buy button. Tapping the View button displays the sections available in that article. The first page of the first article in each section is used as the section cover image. When a user taps the section cover image, all the articles in that section are downloaded or displayed.

Any article that does not have Section information specified is downloaded with any section. For example, if you don’t specify Section information for the cover article and the table of contents article, those articles are downloaded with the first section the user downloads.

In a folio with sections, tapping the TOC button displays only the section titles at this time, not the articles. Tapping a section name in the TOC jumps to the first article in that section.

The original article order is preserved in folios with sections. For best results, group articles in the same section next to each other within the folio.

**Note:** Once a user downloads a single section, it counts as a complete folio download. Subsequent downloads of sections in that folio do not count as downloads.

**Testing Sections**

To test the Sections feature, create a v24 or later development app. Sections are not fully implemented in the Adobe Content Viewer.
Import HTMLResources

When you create articles based on HTML instead of InDesign documents, you can set up a resources folder for sharing images, scripts, and CSS files. The resources folder must be named "HTMLResources.zip." You can import only one HTMLResources folder in a folio. The HTMLResources.zip file is not an article that can be previewed. It’s a file for shared resources. For information on creating HTML articles, see “Import HTML articles” on page 81.

Important: To create the .zip file, select the contents of the HTMLResources folder, not the folder itself.

If several people are working on HTML articles, make sure that they have a up-to-date copy of the HTMLResources folder so that they can refer to it.

1  Open the folder containing the HTML resources, select the contents, and compress it into a .zip file.
3  Select a folio, and choose Open.
4  In the Folio Producer Editor, click the Import HTML Resources button [Import].
5  Click Browse, select the HTMLResources.zip file, and then click Open.

If you need to edit the HTMLResources.zip file, make the changes, create a new zip file, and import it again.

You can also import the HTMLResources.zip file by choosing Import HTML Resources in the Folio Builder panel menu.

More Help topics
“Link to assets in the HTML Resources folder” on page 56
“Embed fonts in HTML articles” on page 104

Embed fonts in HTML articles

Make sure that your font license permits you to embed fonts in an HTML article. In the source folder of your HTMLResources.zip file, include a fonts folder that contains fonts and a CSS folder that contains the CSS styles file. In the .html file, refer to these files and fonts using relative paths. See “Import HTMLResources” on page 104.

You can also use a DPS App Builder setting to embed fonts in the app itself rather than in the article.

Sample HTML article structure
When folios and articles are created, they’re uploaded to the Folio Producer server powered by acrobat.com, but they do not yet appear on the Distribution Service (sometimes called the “fulfillment server”). The Distribution Service stores all the folios that customers can download.

To publish folios as retail or public, you must sign in to the DPS Dashboard using a subscription account. However, anyone can publish folios as private to improve downloading performance.
Publish Folio

<table>
<thead>
<tr>
<th>Status:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
</tr>
</tbody>
</table>

1. **Sign in to the Adobe Digital Publishing Suite Dashboard.**
2. In the Dashboard, click Folio Producer. In the Folio Producer Organizer, select a folio and click Publish.
3. **Set the status of the folio.**
   - **Private or Public** When you set a folio to Public, customers can download it as soon as the folio is available in the store. A DPS subscription is required to publish a folio as Public. If a folio is set to Private, it is not available for customers to download in a custom viewer app. It is available only in the Adobe Content Viewer.
   - **Free or Retail** Set a folio status to Retail to allow customers to download it only if they pay for it through an in-app purchase or a subscription. For retail folios, go through the In App Purchase process on the Apple developer site or the In App Billing process in the Google Play developer site to determine the price of the retail folio download.
   
   Any folio published as Retail does not appear in the Adobe Content Viewer. Preview retail folios using the custom development app you create.
   
   **Important:** For retail folios, do not set the status to Free and set it to Retail later. Doing so can prevent the folio from being available in the custom viewer. Unpublish and re-publish such folios as Public and Retail.
4. **Specify the Product ID.**
   
   For best results, use the `com.publisher.publication.issue` format (such as `com.adobepress.dpstips.july2012`) to specify the Product ID. For best results, avoid uppercase letters in your Product ID. Uppercase letters may not work with Amazon in-app purchases.
   
   For retail content, make sure that you use the same Product ID in the Publish Folio dialog box and in store, such as the In App Purchase Process for the iPad.
   
   **Note:** Use different Product IDs for each separate folio in your app. However, if you are creating folio renditions, use the same Product ID for all renditions.
5. **Click Publish.**
   
   The folio is not published if it includes articles with conflicting orientations or aspect ratios. If the folio is published, the Publish button is replaced by an Update button, and the Remove button is active.
When you publish or update a folio, the job is sent to the queue, allowing you to continue working in the Organizer and publish or update additional folios. Choose View > Publish Requests to see the queue status. If a job fails, see the DPS Status page for information about ongoing server outages.

Unprotected articles are uploaded to a web server for viewing on the desktop.

If your custom viewer has push notifications enabled, click the Notify button to trigger a push notification. See “Push notifications” on page 137.

**Update published folios**

After you publish a folio, use the Update button in the Folio Producer Organizer to update the published folio. When the Adobe Content Viewer detects that a downloaded folio has been updated, it prompts users to download the updated folio. Make sure that the Publication Name, Folio Number, Product ID, and Size values remain unchanged. If you need to change any of these values, unpublish and re-publish the folio instead of updating it.

1. Make the necessary changes to the folio and articles.
   - If you edit the source documents of an article, use the Update command in the Folio Builder panel.

2. Navigate to the Folio Producer Organizer.

3. Make sure that the Publication Name and Folio Number settings of the folio are identical to those of the existing folio.
   - If either of these settings are different, the new folio is treated as a separate issue.

4. Select the folio and choose Update.

5. Specify the appropriate status settings and Product ID.
   - Do not change the Product ID. If you need to use a different Product ID, use the Unpublish option, and then publish the folio again.
   - If your folio is a retail version, make sure that your Product ID matches the Product ID specified during the In App Purchase process for iPad apps or related process for Android and Amazon apps. If you specify a different Product ID, the folio fails to appear in your custom viewer app.
   - If Update Content is selected, the folio content and metadata is updated. If you deselect this option, only the status changes when you click Update. For best results, leave the Update Content option selected.

**Remove folios from the server**

The Folio Producer Organizer includes both an Unpublish command and a Delete command.

- The Unpublish command removes the published folio from the Distribution Service. If you have a multi-folio viewer app in the store, the removed folio is no longer available for downloading.
- The Delete command erases the folio and its contents. A deleted folio no longer appears in the Folio Producer Organizer or Folio Builder panel.

A removed or deleted folio is not deleted from any device to which it’s been downloaded. Tapping the Archive button removes the deleted folio from the viewer library.
Export folios for single-folio viewers

To create a single-folio viewer, you can select a folio in the Folio Builder panel, choose Create App from the panel menu, and build the app based on that folio. If you’re a Professional or Enterprise customer, you can export a folio as a .zip file that you can specify in the DPS App Builder. Before you can export a folio, you must publish it.

2. In the Dashboard, click Folio Producer. In the Folio Producer Organizer, publish the folio. See “Publish folios to the Distribution Service” on page 105.
3. In the Folio Producer Organizer, select the published folio and click Export.
4. Specify the name and location of the .zip file, and then click Save.

You specify this .zip file when using the DPS App Builder to create a single-folio viewer app. See “Create a custom viewer app for the iPad and iPhone” on page 113.

Create folio renditions

Renditions are important for the platforms in which devices have multiple dimensions. For example, the iPad is available in 1024x768 (SD or Standard Definition) and 2048x1536 (HD or High Definition) dimensions, and popular Android devices include 1280x800, 1024x768, and 1024x600 formats.

When you publish content, two settings determine whether a folio is a rendition or a different issue. These settings are Folio Name and Size. The Folio Name values for the different renditions must be the same, and the Size values must be different. You specify these settings when using the Folio Builder panel to create a folio. In addition, if the folio renditions belong to a retail app, we recommend that you use the same Product ID for all renditions. For renditions in a subscription app, the Publication Date values must be identical—choose the date from the calendar widget.

Note: When you create folio renditions for a subscription viewer, choose the same Publication Date setting for each rendition from the calendar widget.
Creating multiple folio renditions that have the same Folio Name settings and different Size settings

When the viewer checks the Distribution Service, it offers only the rendition that most closely matches the mobile device.

For iPad devices, if you upload one folio rendition with 2048x1536 Size setting and another folio with a 1024x768 setting, the HD iPad model downloads the 2048x1536 folio while the SD models download the smaller rendition. iPad viewers download only folios with a 4:3 aspect ratio. iPhone viewers download only folios with a 3:2 aspect ratio. If you create a viewer app that supports both the iPad and iPhone, create four renditions for best results. See “Creating DPS content for different iPad models” on page 41 and “Creating DPS content for the iPhone” on page 41.

For Android devices, if you upload one folio with a 1205x725 Size setting and another folio with a 1024x600 setting, the Nexus 7 viewer downloads only the 1205x725 rendition while the Kindle Fire viewer downloads only the 1024x600 rendition. See “Creating documents for multiple devices” on page 39.

**Note:** For best results, use the same folio metadata settings for the folio renditions, including Folio Name, Publication Name, Folio Number, and Publication Date. When you publish the renditions, use the same Product ID. If you are enabling Social Sharing, make sure that you use the same Article Name values.
Updating folios published with prerelease tools

If you used the Content Bundler to publish folios for a multi-folio viewer, the folio does not appear in the Folio Builder panel or the Folio Producer. However, published folios are still available for your customers to download and view. You can continue to edit and update these folios using the Content Bundler as long as it is available.

When you update your workflow to use the Folio Builder panel, you can create folios that are available along with the existing folios. Make sure that you use the same Adobe ID that you use in the Content Bundler. Also, update and re-submit your custom viewer so that it can display folios created using the newer tools.

At this time, if you want to edit an existing folio published using the Content Bundler, continue to use the Content Bundler.

Checklists for custom viewer apps

Using the DPS App Builder to create a custom viewer app is a straight-forward process if you have all the files and information you need. Use the appropriate checklist to make sure that you have the required files.

Checklist for single-folio viewer (iPad only)
The following files and information are required to create a single-folio viewer for the iPad.

For information on creating certificates and images to submit a custom viewer to the Apple App Store, download the Step-by-Step Publishing Guide from the Adobe Digital Publishing Suite Dashboard or from the DPS App Builder.

General
• Adobe ID used for application
• Creative Cloud membership account or Single Edition serial number (Single Edition only)

Files required to secure your app
• Distribution P12 certificate (and password)
• Distribution mobileprovision file
• Developer P12 certificate (and password)
• Developer mobileprovision file

Artwork required to brand your app
• SD App Icons: 29x29, 50x50, 72x72, and 512x512 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
• HD App Icons: 58x58, 100x100, 144x144, and 1024x1024 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
• SD Splash Screens: 1024x768 and 768x1024 pixel images in PNG format.

More Help topics
“Single Edition overview” on page 9
“Create a custom viewer app for the iPad and iPhone” on page 113

Last updated 2/8/2013
Checklist for multi-folio viewer (iPad and iPhone)

The following files and information are required to create a multi-folio viewer for the iPad.

### Folios
- Adobe ID used for application
- At least one free folio published as public using application Adobe ID
- In-app purchases for all published retail folios. Use the same Product ID when creating the in-app purchase and publishing the folio.

### Files required to secure your app
- Distribution P12 certificate (and password)
- Distribution mobileprovision file
- Developer P12 certificate (and password)
- Developer mobileprovision file
- Production push P12 certificate and password (optional)
- Developer push P12 certificate and password (optional)

### Artwork required to brand your app
- SD iPad App Icons: 29x29, 50x50, 72x72, and 512x512 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
- SD iPhone App Icons: 29x29 and 57x57 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
- HD iPad App Icons: 58x58, 100x100, 144x144, and 1024x1024 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
- HD iPhone App Icons: 58x58 and 114x114 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
- SD Splash Screens: 1024x768 and 768x1024 pixel images in PNG format.
- HD Splash Screens: 2048x1536 and 1536x2048 pixel images in PNG format. Use 8-bit PNG format to reduce file size.

More Help topics

“Create a custom viewer app for the iPad and iPhone” on page 113

Checklist for subscription viewer (iPad and iPhone)

Certain files and information are required to create a multi-folio subscription viewer for the iPad.

### Folios
- Adobe ID used for application
- At least one free folio published as public
- In-app purchases for all published retail folios. Use the same Product ID when creating the in-app purchase and publishing the folio.
- In-app purchases for all subscription durations. If you’re creating a free subscription app, you need to create an in-app purchase for the free subscription.
• Shared secret associated with application Adobe ID (see “Account Administration tool” on page 132)

Files required to secure your app
• Distribution P12 certificate (and password)
• Distribution mobileprovision file
• Developer P12 certificate (and password)
• Developer mobileprovision file
• Production push P12 certificate and password (required for Newsstand)
• Developer push P12 certificate and password (required for Newsstand)

Artwork required to brand your app
• SD iPad App Icons: 29x29, 50x50, 72x72, and 512x512 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
• SD iPhone App Icons: 29x29 and 57x57 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
• HD iPad App Icons: 58x58, 100x100, 144x144, and 1024x1024 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
• HD iPhone App Icons: 58x58 and 114x114 pixel icons in PNG format. You do not need to add the shine effect or rounded corners.
• SD Splash Screens: 1024x768 and 768x1024 pixel images in PNG format.
• HD Splash Screens: 2048x1536 and 1536x2048 pixel images in PNG format. Use 8-bit PNG format to reduce file size.
• SD Newsstand icon: 96x128 pixel icon in PNG format (required for Newsstand)
• HD Newsstand icon: 192x256 pixel icon in PNG format (required for Newsstand)
• SD Subscription Tiles: 964x184 and 708x250 pixel images in PNG format.
• HD Subscription Tiles: 1928x368 and 1416x500 pixel images in PNG format.
• Custom navigation icons (Enterprise only): 75x43 (SD) and 150x86 (HD) pixel images in PNG format. For each icon, create separate images for Up, Down, and Disabled states.

More Help topics
“Create a custom viewer app for the iPad and iPhone” on page 113

Checklist for multi-folio viewer (Android and Amazon)
The following files and information are required to create a multi-folio viewer for the Google Play Store and Amazon Appstore. For information about creating these files, see Publishing Process for Android Devices.

Folios
• Adobe ID used for application
• At least one free folio published as public using application Adobe ID (recommended)
• In-app billing for all published retail folios. Use the same Product ID when creating the in-app billing and publishing the folio.
• Shared secret associated with application Adobe ID (see “Account Administration tool” on page 132)
Files required to secure your app  
• Valid P12 certificate (and password)

Artwork required to brand your app  
• App Icons: 36x36, 48x48, 72x72 pixel icons in PNG format.  
• Splash Screens: 1280x800/800x1280, 1920x1200/1200x1920, or 2048x1536/1536x2048 pixel images in 8-bit PNG format.

More Help topics  
“Create a custom viewer app for Android and Amazon devices” on page 123

DPS App Builder  

DPS App Builder (previously called Viewer Builder) lets you build a custom viewer app that you can submit to the stores such as the Apple Store and Google Play Store. The DPS App Builder is currently available only for Mac OS.

Use the DPS App Builder to create viewer apps for single-folio, multi-folio, and subscription viewer apps. You cannot create single-folio viewer apps for the Google Play Store or Amazon Appstore at this time.

To download the newest version of the DPS App Builder, go here: www.adobe.com/go/digpubsuite_vb_mac. Or, you can delete the existing version of the DPS App Builder from the Applications folder and click the DPS App Builder link on the DPS Dashboard.

More Help topics  
“DPS publishing overview” on page 94  
“Checklists for custom viewer apps” on page 110  
“Create a custom viewer app for the iPad and iPhone” on page 113  
“Create a custom viewer app for the iPad (Single Edition)” on page 122  
“Create a custom viewer app for Android and Amazon devices” on page 123

Create a custom viewer app for the iPad and iPhone  

Use the DPS App Builder to create a custom viewer app for the iPad, the iPhone, or both. If you specify valid files and information, DPS App Builder generates both a development app and a distribution app. The development app is for testing. If it works properly, submit the distribution .zip file to the Apple Store.

The information such as certificates and passwords that you provide is not stored on the Adobe server. Only the application files are stored on the Adobe server.

DPS App Builder requirements for creating iPad viewer apps

System requirements:
- Mac OSX 10.6 Snow Leopard or later for iOS viewer apps
- Internet connection
- A valid Adobe ID provisioned to use the DPS App Builder

Create a custom viewer app
1. Obtain the required files and information. See “Checklists for custom viewer apps” on page 110.
2. Download and install the DPS App Builder.
   The DPS App Builder is available on the Digital Publishing Suite Dashboard. If you use InDesign CS6, the DPS App Builder is installed when you update the DPS Desktop Tools.
3. Start the DPS App Builder and sign in using a valid Adobe ID.
   The Adobe ID you use to sign in to the DPS App Builder may be different from the Adobe ID you use to specify the Title ID in the App Details panel.
   The Account Administration tool lets you or the administrator assign the DPS App Builder role to an Adobe ID. See “Account Administration tool” on page 132.
4. Click New, select iOS, and then select iPad, iPhone, or both. Click Next.
5. Specify the requested files and information.

   **Note:** If you’re creating a single-folio app, you can select the folio in the Folio Builder panel and choose Create App from the panel menu.

App Details panel
The App Details panel lets you provide your viewer names and account ID information.

**App Name** Provide a viewer name that appears below the App icon on the iPad. As a general rule, use 13 characters or fewer to avoid truncating the name.

   **Tip:** To test your App name on the iPad, open a website in iPad Safari, choose Add to Home Screen from the Safari menu, and then type the desired Viewer name. If the name is truncated, use a smaller name.

**App Version** Specify the most recent viewer.

The DPS App Builder includes a previous version for backup purposes.

**App Type** Specify the viewer type (see “Types of custom viewer apps” on page 94). The availability of some options depends on the type of account.

- **Multi-Issue** A multi-folio viewer app includes a library that lets users download content that is hosted on the Adobe Distribution Service.
- **Built-in Single Edition App** A single-folio app includes built-in content. When you select this option, the Exported Folio option appears. Specify the .zip file created using the Export option in the Folio Producer Organizer. This option is not available if iPhone is selected.
- **Multi Folio with Entitlement** (Enterprise only) Create a viewer app that uses a custom entitlement server to determine which customers can download content. If you select this option, you use your own subscription service. Consult with Apple. Entitlement only apps cannot be enabled for Newsstand.
• **Multi Folio with iTunes Subscription**  Create a viewer app that uses the Apple App Store subscription model.

• **Multi Folio with Entitlement and iOS Subscription**  (Enterprise only) Create a viewer app that uses a custom entitlement server to determine which customers can download content. Customers can subscribe either through your subscription service or through the Apple App Store.

• **Adobe Content Viewer**  Create a version of the Adobe Content Viewer instead of downloading it from the App Store. See “Create a custom Adobe Content Viewer for iPad and iPhone” on page 127.

**Available Library Views**  This option has no effect in v25 apps. In the v24 viewer library, users can tap a button in the upper right corner to view folios in either Grid View or Cover View, which displays only one folio cover. Selecting Grid View disables Cover View.

**Title (Library View)**  Provide the title that will appear at the top of the viewer library. For best results, use no more than 35 characters.

**Title ID/Password**  Provide the appropriate Adobe ID and password for your app. Specify the same Adobe ID you use to create folios for this title. Make sure that the Adobe ID is assigned the Application role in the Account Administration tool. The Title ID for the app can be different from the Adobe ID used to sign in to DPS App Builder.

**Optional URL Scheme**  Specify the custom URL scheme that launches the viewer app from Safari and other apps. To ensure uniqueness, Apple recommends that you use the reverse-DNS format (com.publisher.publication). For best results with Twitter social sharing, use 32 characters or fewer.

For example, suppose you specify “com.sportspub.kayaking” as the URL scheme. If you embed a “com.sportspub.kayaking://” link on your webpage, clicking the link from the mobile browser opens the viewer app. For more information, see Apple’s developer website.

**Exported Folio**  If you selected Built-in Single Edition App for App type, specify the .zip file or .folio file to be built in with the viewer. To create a .zip file, use the Export option in the Folio Producer Organizer. See “Export folios for single-folio viewers” on page 108. (Instead of using the exported .zip file, you can select the folio in the Folio Builder panel and choose Create App.)

**Optional iPhone Welcome Screen**  (Enterprise only) You can create a .zip file that includes HTML assets for your iPhone viewer. This HTML page is displayed only the first time your customers start the iPhone viewer. The HTML page can contain links for restoring previous purchases and dismissing the welcome screen. For details on creating these links, see Custom HTML Store API Reference.

**Advanced Options**

**Enable PDF Zooming**  Select this option to allow your users to pinch and zoom non-interactive pages. Make sure that you select the PDF image format option when creating your folio.

**Enable Bookmarks**  Select this option to allow your users to bookmark their favorite articles in the app. If enabled, a Bookmarks icon appears on the upper right area of the viewer nav bar. Bookmarks are not yet available in the iPhone viewer.

**Enable Auto Hiding of Folio Scrollbars**  By default, a 6-pixel scrollbar area appears on the right side of articles in a folio. If you select this option, the scrollbar appears only when the user is scrolling in the article.

**Always Open Background Downloaded Issue**  When this option is selected, any folio that has been downloaded in the background since the previous viewing session opens on launch. If this option is not selected, the most recently viewed folio is opened in its previous reading position. This option is especially useful for daily and weekly magazines.

**Enable Left and Right Hot Zone Navigation**  If you select this option, invisible hot zones appear on the left and right sides of every article (or page if the article scrolls only horizontally). Tapping a hot zone jumps to the next or previous article. Hot zones are especially useful for full-screen overlays, such as slideshows. Hot zones are not available for iPhone viewers.
If a button appears in the hot zone area, tapping the area triggers the button. For any other overlay that appears in the hot zone area, tapping the area triggers the hot zone.

Enable Bottom Hot Zone to Display Folio View Controls If you select this option, tapping in the hot zone area at the bottom of the page displays the navigation bars (also called the "HUD"). Tapping anywhere above the bottom hot zone does not display the navigation bars.

Buttons take precedence over the bottom hot zone, the bottom hot zone takes precedence over the left and right hot zones, and hot zones take precedence over all non-button overlays.

Hide Top Navigation Bar in Folio View If you select this option, only the bottom navigation bar is displayed when a user taps an article. This allows publishers to create a custom navigation bar on all article pages to navigate within the folio.

Enable Auto Folio Archiving Select this option enable auto-archiving of folios when the customer downloads the maximum number of folios allowed. Indicate whether the archiving is turned on by default. Customers can use the device settings to turn auto-archiving on or off. Also specify the maximum number of downloaded folios (between 6 and 90) for your viewer app. When the threshold number is reached, the least recently updated folios are archived automatically. Customers cannot change the threshold number. Customers can re-download any archived folio.

Enable Caching of Library Information Select this option to cache folio information such as the price of a folio. Selecting this option improves performance for apps with large libraries because the viewer does not check the Apple server each time the library is loaded. However, selecting this option can cause folio information to become out of date. For example, if you select this option and change the cost of retail folios, your library will display misleading information. This option is currently available only for subscription apps.

Hide Sign In Button in Library (Enterprise only) By default, the Sign In button appears in the upper left corner of the library in subscription apps with custom entitlement. You can hide the Sign In button if your custom library provides a different method for signing in.

Hide Subscribe Button in Library (Enterprise only) By default, the Subscribe button appears in the upper left corner of the library in subscription apps. You can hide the Subscribe button.

Auto-Download Latest Entitled Issue for New Readers If this option is selected, the most recently entitled folio is downloaded automatically when the app is launched. Use the Account Administration tool make the first retail folio free to first-time downloaders. If you don’t make the first retail folio free, the most recent free folio is downloaded automatically.

Enable Rate the App Dialog Select this option to display a “Rate the App” prompt after your customers have launched the app a specified number of times. For example, if you set the "Rate the App Dialog Count" value to 5, users are prompted to rate the app on the fifth launch of the app. If they select “Remind me later,” they’re prompted on the next launch.

Specify the 9-digit Application ID for your app. To obtain this ID, sign in to itunesconnect.apple.com, click Manage Your Applications, and then click your app. Copy the 9-digit Apple ID string (not the Bundle ID).

Show Analytics Opt-in Dialog If you select this option, your customers can opt out of data tracking when they first launch the app. To edit the default text that appears, select Use Customized Strings, and download and edit the values for "Analytics Opt-In Dialog Title" and "Analytics Opt-In Dialog Text."

Supported Languages iTunes displays the languages in which the viewer app is available. The viewer interface is translated into multiple languages, but your folio content most likely isn’t. Select at least one language in which your viewer should appear.

Use Customized Strings You can customize all strings stored in the viewer in all supported languages. For example, you can customize button text in the library and text in dialog boxes. Select this option, and then click Generate Template to download an XML template to your Documents folder. You can then edit this XML file and specify it in
DPS App Builder. If you’re editing a viewer created for a previous version, download and edit the newest template for best results.

When you edit the XML file, each UI element includes a <key name> and one or more language strings (such as <en> for English). Edit the text in the language code (such as <en>); do not change the <key name> string.

**Entitlement Details (Enterprise only)**

The following options appear if you choose one of the entitlement options for Viewer Type.

*Note: For detailed information about setting up a custom entitlement server, contact your Adobe representative.*

**Service URL** Specify the main URL for your entitlement service. An entitlement service is required for enabling subscriptions.

**Service Auth URL** Specify the URL where the authentication service is hosted. The authentication service indicates when users have signed in.

**Integrator ID** Adobe provides the Integrator ID when your entitlement account is provisioned within our servers.

**Optional Create Account URL** Specify the URL where customers can sign up for a subscription through the publisher, not through the Apple subscription process. This URL is used when users tap a “Subscribe” button that links to your entitlement service.

**Forgot Password URL** Specify the URL where customers can retrieve their forgotten password.

**Optional Existing Subscription URL** Specify the URL where customers can indicate an existing print subscription while signing up for a digital subscription. Leave this field blank to disable the print subscription link button in the viewer.

**Send App ID and Version** This option allows the Viewer app’s ID and Version strings to be sent in entitlement API calls.

**Entitlement Banner Enabled** Select this option to display a full-width subscription banner in the viewer library instead of the subscription tile. If this option is not selected, only the subscription tile appears in the library. If you use a banner instead of the tile, your HTML content should include links to subscription options.

**Banner Page URL** Specify the URL that displays the subscription banner if the user is connect to the internet. This full-width banner appears in the upper section of the viewer library above the subscription tile and available folios.

**Offline Banner Assets** Select the .zip file containing the assets to be used as the banner if the user is not connected to the internet. The .zip file should include a single HTML file, one or more image files, and optional CSS files. The .zip file should not contain subfolders; all content should be on the same level.

**Banner Height** Specify the height of the banner that appears in the viewer library.

**Subscription Details**

The following options appear if you choose one of the subscription options for Viewer Type.

**Subscription Tiles** Specify background images that describe the Apple subscription options. For landscape tiles that appear when the device is rotated sideways, specify a 964x184-pixel image for iPad 1&2, and specify a 1928x368-pixel image for iPad3. For portrait tiles, specify 708x250 and 1416x500-pixel images for the two different iPad sizes.

Tapping any part of the tile launches the iOS subscription options. These options are determined by the subscription in-app purchase information you specify in iTunes Connect.

**Optional Library Subscription Tile URL** Specify a URL that is displayed in an in-app browser window when the customer taps the subscription tile. This webpage can include messaging that is not necessarily related to subscriptions.
Optional Remote Custom Dialog URL  This URL loads when the customer completes the subscription process. For example, you can request user information or provide additional details about your products.

Subscription Type/Subscription Products  Select Paid if you have a retail subscription app. For Subscription Products, click the plus icon to specify at least one Apple iTunes Connect product ID and corresponding duration. These options appear when customers tap the subscription tile or the Subscribe button.

Select Free if you are creating a Newsstand app with Apple’s Free Subscription option. Specify the Free Subscription Product ID you specified in iTunes Connect.

Use Customized Subscription Strings  To customize subscription strings, use the Use Customized Strings option in the App Details panel.

**Important:** Shared secret information is required for subscription apps. Use iTunes Connect to create or view your shared secret. Use the Account Administrator tool to specify the shared secret characters for the application account. Then sign in to the Folio Producer Organizer to trigger the shared secret update.

Icons and Splash Screens panel

Use this panel to specify app icons and splash screens that will appear in iTunes and the iPad.

Instead of specifying each icon file one at a time, select the files in a Finder window and drag them into the Icons and Splash Screens panel.

**App icons**  The icons that you specify will be used on the iPad home screen when installed, and on the device App Store when viewed from the iPad. Specify 29x29, 50x50, and 72x72 pixel icons in PNG format for iPad 1&2 devices. Specify 58x58, 100x100, and 144x144 pixel icons in PNG format for iPad3 devices. Specify 29x29, 57x57, 58x58, and 114x114 icons for the iPhone. Apple rounds the corners automatically. Do not scale up smaller artwork. Use 72ppi, RGB, flattened, high-quality PNG files.

**Note:** Always include a .png extension in your image filenames.

**Splash Screens**  When the Viewer is started, a splash screen appears for approximately three seconds. For splash screens, specify the following images using 72 ppi, RGB, flattened, high-quality PNG files. To reduce file size, use Save for Web & Devices in Photoshop to save 8-bit PNG files.

- 1024x768 and 768x1024 pixel images for iPad 1&2
- 2048x1536 and 1536x2048 pixel images for iPad3
- 320x480 pixel image for iPhone 3GS
- 640x960 pixel image for iPhone 4/4S

For best results, make your splash screen image different from your cover. If the cover and the splash screen are identical, users may think the app is frozen when they first start it. Some publishers add “Loading . . .” to the splash images.

**Optional artwork**  The large app icon will be displayed for your app on the desktop App Store and if needed, will be used to feature your app on the App Store. Specify a 512x512-pixel image for low-resolution iPad and iPhone devices and a 1024x1024-pixel image for high-resolution iPad and iPhone devices. For best results, use Save for Web & Devices in Photoshop to create a 8-bit PNG files. You can also specify this image while submitting your app to the Apple Store. Do not scale up smaller artwork. Use 72ppi, 8-bit, RGB, flattened, high-quality PNG files. To reduce file size, create 8-bit instead of 24-bit PNG files.

**Enable shine effect on app icon**  Indicate whether you want your application icons to include the shine effect, which looks like a light is shining on the upper portion of the icon.

Last updated 2/8/2013
Optional Fonts ZIP for HTML  If you apply fonts to text in your HTML stacks or web view overlays, you can include them in either the .folio file or the Viewer. If you choose to include them in the Viewer, compress the fonts in a .zip folder. The .zip file should not contain subfolders; all content should be on the same level.

Newsstand
If you enable Newsstand, your viewer app appears in the Newsstand folder of iPads with iOS5 installed. To enable Newsstand, you must create a viewer app with iTunes subscription—either iTunes Subscription only or Entitlement with iTunes Subscription, but not Entitlement only. In addition, you must enable push notifications.

Enable Newsstand  Select this option to allow your viewer to appear in the Newsstand folder.

Magazine/Newspaper  Determine whether Newsstand should classify your viewer app as a magazine or newspaper.

Binding Edge  Select an option to determine the adornment appearance on the Newsstand icon when a customer double-taps the Home button to display the active apps. For example, choosing Left binding displays a binding edge on the left and page adornments on the right.

Newsstand Icon  Specify a PNG icon that appears in the Newsstand folder. Use a 72 ppi, RGB, flattened, high-quality PNG file at 96x128 pixels for the iPad 1&2 and 192x256 for iPad3. This icon is used as the cover image in Newsstand. This icon is replaced by the cover image of the most recently published folio.

Navigation Toolbar (Enterprise only)
This panel lets you customize the Navigation Toolbar that appears in your custom viewer at the bottom of the library.

Hide Home Button  If the Navigation Toolbar is displayed, tapping the Library button on the bottom navigation bar does the same thing as tapping the Home button (now called the Library button) in the upper left navigation bar. To avoid this redundancy, you can hide the Home (Library) button.

Show Navigation Toolbar  Select this option to display the Navigation Toolbar at the bottom of the viewer.

Specify whether the Navigation Toolbar should appear in all views, including the library and folio view, or if it should be hidden when folios are viewed.

Hide Viewer Icon  If Show Navigation Toolbar is selected, you can hide the Viewer icon that appears by default. Tapping the Viewer icon displays the previously viewed folio.

Hide Buy Buttons  Select this option if you want folios to be available for purchase only through a subscription and not through individual purchase.

Hide Free Folios  Select this option to hide free folios from your library. This option is especially useful if you want to use your custom server to entitle customers to specify folios based on their sign in account information.

For information on restricting folios, see Using restricted distribution with Digital Publishing Suite.

Hide Sign In Button  Select this option if you want a Sign In button to appear in the upper left corner of the web page that appears when users tap any of the custom icons.

Customize and Test the Toolbar and Custom Icons  Use this section to specify custom icons for the navigation toolbar of the default library or to specify a custom HTML library.
**Use Custom Viewer Library** When you click the Library icon in the Navigation Toolbar section of DPS App Builder, the Use Custom Viewer Library option appears. If you click the option icon, you can specify the .zip file that includes your HTML code. See “Creating a custom library (Enterprise)” on page 129.

**Icon Up State** Click the plus icon on the right side of the panel to create a custom button for the Navigation Toolbar. Or, select the Library or Viewer icons to replace the default Library and Viewer icons with default icons. Specify PNG files to be displayed as the normal button appearance. Use a 75x43-pixel image for iPad 1&2 and a 150x86-pixel image for iPad3.

When users tap a custom icon, an in-app browser displays the contents of the HTML file you provide, such as a website for a store, a news feed, or help page. Customers can tap a Close button to return to library view. You can specify as many as three custom toolbar buttons.

**Icon Down State** Specify PNG files to be displayed when the button is tapped. Use a 75x43-pixel image for iPad 1&2 and a 150x86-pixel image for iPad3. For example, you can change the image border from black to red.

**Icon Disabled State** Specify PNG files to be displayed when the button is not available, such as during a download. Use a 75x43-pixel image for iPad 1&2 and a 150x86-pixel image for iPad3. For example, you can display a dimmed version of a shopping cart for a “Store” button.

**Type** Select WebView to display the contents of an HTML file you specify. Select Navigation only if you’re publishing a Woodwing-based app in which you can use the Intent metadata to jump to a cover, table of contents, or help article. Specify the intent in the Label field.

**Label** This option lets you create article links that open the HTML content associated with the custom icon. For example, if your Label is “Store,” creating a button with a goto://ApplicationViewState/Store action opens the Store HTML. See “Create goto links to custom icons” on page 56.

**Icon HTML Resources ZIP** Specify a .zip file containing the assets to be used for the web view that appears when users tap the toolbar button. The .zip file should include a single HTML file and any required image and CSS files. The .zip file should not contain subfolders; all content should be on the same level.

**Lock Orientation** If you want the web view that appears when users tap the toolbar button to display in only one orientation, choose Horizontal or Vertical.

**Hide Title Bar** Select this option to hide the title bar that appears at the top of the viewer library when the custom icon’s HTML content is displayed.

**Auto Launch** One of the custom toolbar buttons can be set to Auto Launch. When Auto Launch is turned on, opening the viewer library displays the HTML page automatically.

**Show Navigation Controls** Display navigation controls such as a Back button and a Refresh button for the web page. These options appear in the title bar above the HTML content.

**Note:** Click the plus icon on the right side of the Navigation Toolbar panel to add as many as eight custom buttons. You can also replace the default Library and Viewer buttons. Click the buttons in the preview bar to switch between buttons.

**Social Sharing**

These settings control whether customers can share articles from your app through Facebook, Twitter, email, or copy/paste. Social Sharing is available for iPad and iPhone viewers. However, this feature is not available for single-issue apps or Android viewers.

To understand the Social Sharing workflow, see “Using social sharing” on page 139. To learn how to configure Facebook for social sharing, see Setting up a DPS App for Social Networking.

**Enable Email Sharing** Select this option to add Email to the social sharing menu in the upper right area of the viewer nav bar. Customers can select this option to send an email message with a link to the article or Publication URL.
Enable Twitter Sharing  Select this option to add Twitter to the social sharing menu. Customers can select this option to post a message to their Twitter feed.

Enable Copy Link Sharing  Select this option to add Copy Link to the social sharing menu. Customers can select this option to copy the URL of the shared article or publication and paste it in a web page or other location.

Enable Facebook Sharing  Select this option to add Facebook to the social sharing menu. Customers can select this option to leave a comment and link on their Facebook wall.

Facebook App ID  Specify the App ID obtained from the Facebook developer site.

Publication URL  Specify the URL that contains information about your publication. The link to the Publication URL appears when customers share a protected article.

Provisioning
Apple requires all applications to be signed by a valid certificate and provisioned before they can be run on the iPad. In the Provisioning section, you specify the mobileprovision files. You specify the certificates when you download the generated viewer apps.

For information on creating certificates and mobileprovision files, see the iPad Publishing Companion Guide PDF, which is available on the Dashboard or from the Help menu in the DPS App Builder.

Enterprise Signed Viewer App  Select this option only if you want to use an enterprise provisioning certificate for a viewer to be distributed only within your organization. Specify an App ID and your enterprise mobileprovision file. See "Creating an enterprise-signed viewer app" on page 128.

Developer Mobileprovision  The mobileprovision file determines which iPads can install and use your viewer app. The mobileprovision file for the development app includes a list of iPad IDs called UDIDs.

Distribution Mobileprovision  The mobileprovision file determines which iPads can install and use your Viewer app.

Sideloadable Developer Build  Select this option so that you can manually add .folio files to the development viewer through iTunes. You can use only .folio files, not .zip files created using the Export button in the Folio Producer Organizer.

Enable Push Notifications  Select this option to enable Adobe push notifications. If you select this option, a red badge appears on the viewer app icon and indicates the number of available folios, or Newsstand activates a push notification process. This option is required when Newsstand is enabled.

Use Adobe Push Server  If you select this option, push notifications are handled through the Adobe server. Specify the production certificate and password that you create on the Apple developer site. To set up push notifications, configure your App ID, create new mobileprovision files, and create a productin push certificate. For detailed instructions, see the iPad Publishing Companion Guide PDF, which you can download from the Help menu in the DPS App Builder.

If you deselect this option (Enterprise only), you can specify a third-party push server. Specify the server in the Push URL field. Specify any additional server requests your server requires in the Custom Push Parameters field. For basic requirements in setting up your push server, see “Push notifications” on page 137.

Build Details
If you signed in using an Adobe ID provisioned for Omniture tracking, settings for tracking user data appear on the Build Details page. This data is populated automatically. If you have an enterprise account and these options do not appear, contact your Adobe representative.

After you specify information or files for all mandatory fields, click Submit Build, and then click Finish.
The amount of time it takes to create the development and distribution apps depends on how busy the server is.

**Downloading and testing the viewer apps**

Certificates are required for two different Viewer apps—a development app and a distribution app. The development app is for testing; the distribution app is what you submit to Apple once you test and approve the development app.

1. Select your viewer app in the Manage page where your custom viewer builds appear.
2. Click Developer Viewer (.ipa) to download the developer app.
3. Specify your developer p12 certificate and password, and then click Download And Sign.
   - **Developer P12 Certificate** The .p12 file saves your certificate private key information. Creating the .p12 certificate requires you to use the Apple Developer site to create and download a certificate and then use the Keychain Access utility to export the private key of that certificate as a .p12 certificate.
   - **Developer P12 Password** When you create the .p12 certificate, you are prompted to create a password. Blank passwords do not work. If you used a blank password, create the .p12 certificate again with a real password.
4. Add the development app (.ipa) to your iTunes library, and follow the instructions in the “iPad Publishing Companion Guide.pdf” to test your app.
5. If the developer app works as designed, return to the Manage page in DPS App Builder and click Distribution Viewer (.zip). Specify the distribution certificate information, and click Download And Sign.

**Submitting and managing the viewer app**

After you download and test your custom viewer, submit the distribution viewer (.zip) to Apple.

- **Submitting the development app** If your developer app works as designed, submit the distribution app (.zip) to the Apple Store. For details, see the iPad Publishing Companion Guide PDF.
- **Changing the approval status** When your submitted app is approved and appears in the store, please open DPS App Builder and click the Approval Status next to the custom app. Enter the information and click Submit. A link to your app will be added to the **Digital Publishing Gallery**.
- **Updating a build** If you need to create different icons or make other changes, select the viewer app on the main page, and click Edit. Your information and selections remain intact. Make the necessary changes, and then submit the build again. Your app will be updated.
- **Deleting a build** If you no longer need the developer and distribution apps, select the viewer app on the main page, and click Delete.

**Create a custom viewer app for the iPad (Single Edition)**

For information on creating a custom app for the iPad using a Single Edition license, download the **Step-by-Step Guide for Single Edition iPad Publishing**.
Create a custom viewer app for Android and Amazon devices

Use the DPS App Builder to create a custom Viewer app for Android and Amazon devices. You can create multi-folio viewer apps, not single-folio viewer apps. In-app purchases for Google Play Store (previously called Android Market) are available. In-app purchases and subscriptions for Amazon Appstore should be available when the Amazon Fire becomes available. See Publishing Process for Android Mobile Devices.

The steps for creating viewer apps for the Google Play Store and Amazon Appstore are similar. For both workflows, you create an .apk file for submitting. You can create the same app for each store, and the apps can allow the same content to be downloaded. For example, the “DPS Tips” app appears in both Google Play Store and Amazon Appstore and offers the same folios for downloading. On an Android device, you can download the app from either store. On the Amazon Fire, you can download the app only from the Amazon Appstore.

If you specify valid files and information, DPS App Builder generates an .apk file. If it works properly, submit the .apk file to the Google Play Store.

The information such as certificates and passwords that you provide is not stored on the Adobe server. Only the application files are stored on the Adobe server.

Create a custom viewer app
2 Download and install the DPS App Builder.
   The DPS App Builder is available on the Digital Publishing Suite Dashboard, and it’s installed with InDesign CS6 when you update the DPS Desktop Tools.
3 Start the DPS App Builder and sign in using a valid Adobe ID.
   The Adobe ID you use to sign in to the DPS App Builder may be different from the Adobe ID you use to specify the Title ID in the App Details panel.
4 Click New, select Android, and then click Next.
5 Specify the requested files and information.

App Details panel
The App Details panel lets you provide your viewer names and account ID information.

App Name Provide a viewer name that appears below the App icon. As a general rule, use 13 characters or fewer to avoid truncating the name.

To test your viewer name, add a bookmark to the Android home screen.

App Version Specify the most recent viewer.

The DPS App Builder includes a previous version for backup purposes.

App Type Specify the viewer type (see “Types of custom viewer apps” on page 94). The availability of some options depends on the type of account.

- Multi Folio A multi-folio viewer app includes a library that lets users download content that is hosted on the Adobe Distribution Service.
• **Multi Folio with Entitlement** (Enterprise only) Create a viewer app that uses a custom entitlement server to determine which customers can download content. If you select this option, you use your own subscription service.

• **Multi Folio with Amazon Subscription** Create a viewer app that uses the Amazon Appstore subscription model. At this time, Google Play subscriptions are not supported.

• **Multi-Issue with Entitlement and Amazon Subscription** (Enterprise only) Create a viewer app that uses a custom entitlement server to determine which customers can download content. Customers can subscribe either through your subscription service or through the Amazon Appstore.

**Marketplace** Choose an option to determine where your app can be submitted: Google Play Store or Amazon Appstore for Android. You can also choose None to create an app that you don’t intend to submit to a store.

**Show in Library View** Indicate whether you want the library to display in Grid View only, Cover View only, or both. In the library, Grid View displays eight folios per page. Cover View displays only one folio per page. For smaller devices, some publishers prefer displaying the Cover View only.

**Title (Library View)** Provide the title that will appear at the top of the Viewer library. For best results, use no more than 35 characters. At this time, use only alphanumeric or numeric characters. Do not use special characters such as apostrophes (’), or unexpected results may occur on Android devices.

**Title ID/Password** Provide the appropriate Adobe ID and password for your app. Specify the same Adobe ID used for publishing the folios for this app. Make sure that the Adobe ID is assigned the Application role in the Account Administration tool.

**Advanced Options**

**Strict Rendition for 7” Android Devices** By default, viewers on Android devices display folios of any size. To ensure that the viewer displays only folios that match the device size, you can select an option in DPS App Builder. At this time, strict renditions displays only 1024x600 folios for devices such as the Kindle Fire and 1280x800 folios for XLarge Android devices. This option is primarily useful for preventing unwanted folio renditions from appearing on Kindle Fire devices. If you have created Android renditions such as 1232x752 folios, do not turn on strict renditions when you create the viewer for the Google App Store.

**Enable Bookmarks** Select this option to allow your users to bookmark their favorite articles in the app. If enabled, a Bookmarks icon appears on the upper right area of the viewer nav bar. Bookmarks are not yet available in the iPhone viewer.

**Enable Auto Hiding of Folio Scrollbars** By default, a 6-pixel scrollbar area appears on the right side of articles in a folio. If you select this option, the scrollbar appears only when the user is scrolling in the article.

**Enable Left and Right Hot Zone Navigation** If you select this option, invisible hot zones appear on the left and right sides of every article (or page if the article scrolls only horizontally). Tapping a hot zone jumps to the next or previous article. Hot zones are especially useful for full-screen overlays, such as slideshows. Hot zones are not available for iPhone viewers.

If a button appears in the hot zone area, tapping the area triggers the button. For any other overlay that appears in the hot zone area, tapping the area triggers the hot zone.

**Enable Bottom Hot Zone to Display Folio View Controls** If you select this option, tapping in the hot zone area at the bottom of the page displays the navigation bars (also called the “HUD”). Tapping anywhere above the bottom hot zone does not display the navigation bars.

Buttons take precedence over the bottom hot zone, the bottom hot zone takes precedence over the left and right hot zones, and hot zones take precedence over all non-button overlays.

**Show Analytics Opt-in Dialog** If you select this option, your app customers can opt out of data tracking.
Use Customized Strings You can customize all strings stored in the viewer in all supported languages. For example, you can customize button text in the library and text in dialog boxes. Select this option, and then click Generate Template to download an XML template to your Documents folder. You can then edit this XML file and specify it in DPS App Builder.

Entitlement Details (Enterprise only)
The following options appear if you choose Entitlement for Viewer Type.

Note: For detailed information about setting up a custom entitlement server, contact your Adobe representative.

Integrator ID Adobe provides the Integrator ID when your entitlement account is provisioned within our servers. This option is available only to DPS Enterprise customers.

Create Account URL Specify the URL where customers can sign up for a subscription through the publisher. This URL is used when users tap a “Subscribe Now” button in your Viewer.

Forgot Password URL Specify the URL where customers can retrieve their forgotten password.

Send App ID and Version This option allows the Viewer app’s ID and Version strings to be sent in entitlement API calls.

Entitlement Banner Enabled Select this option to display a full-width subscription banner in the viewer library. For Android viewers, the entitlement banner appears above the subscription tile.

Banner Page URL Specify the URL containing content that appears in the upper section of the viewer library.

Offline Banner Assets Select the .zip file containing the assets to be used as the banner if the user is not connected to the web. The .zip file should include a single HTML file, one or more image files, and no CSS files. The .zip file should not contain subfolders; all content should be on the same level.

Banner Height Specify the height of the banner displayed in the viewer library.

Subscription Details panel
Use this panel to configure your viewer for Amazon subscription.

Landscape Subscription Tile Specify a 467x120-pixel (recommended) button image with a .png extension. This image appears in the library when the device is sideways.

Portrait Subscription Tile Specify a 255x145-pixel (recommended) button image with a .png extension. This image appears in the library when the device is upright.

Default Subscription SKU Specify the default subscription SKU for your Amazon subscription. This SKU can contain as many as 150 characters. Use the subscription SKU that you specify in the Amazon Appstore Developer Portal (https://developer.amazon.com). You can specify either the parent SKU or one of the child SKUs that identifies the term, or duration, of the subscription. If you specify a child SKU, it becomes the default selection.

Custom Subscription Dialog URL (Optional) Specify a URL that is displayed in an in-app browser window when the customer taps the subscription tile. This webpage can include messaging that is not necessarily related to subscriptions. Indicate whether this dialog box should be displayed before or after the customer purchases the subscription.
Icons and Splash Screens panel
Use this panel to specify app icons and splash screens that will appear in Google Play Store, Amazon Appstore, and on Android devices.

36x36/48x48/72x72 icons  The icons that you specify will be used on the Android home screen when installed, and in the app store. Provide 36x36, 48x48, and 72x72 pixel icons in PNG format. Do not scale up smaller artwork. Use 72ppi, RGB, flattened, high-quality PNG files.

Note: Always include a .png extension in your image filenames.

Landscape Splash Screen  When the Viewer is started, a splash screen appears for approximately three seconds. Specify a 1280x800, 1920x1200, or 2048x1536 72-ppi 8-bit PNG file.

Use the same splash screen for all Android devices. Make sure that the core design fits within the smaller target device region, such as 800x600. Treat the outer area as a bleed. When the splash screen appears on smaller devices, the outside areas of the image are cropped.

For best results, make your splash screen image different from your cover. If the cover and the splash screen are identical, users may think the app is frozen when they first start it.

Portrait Splash Screen  Specify an 800x1280, 1200x1920, or 1536x2048 72-ppi 8-bit PNG file.

Optional Fonts ZIP for HTML  If you apply fonts to text in your HTML stacks or web view overlays, you can include them in either the folio or the viewer. If you choose to include them in the viewer, compress the fonts in a .zip folder. The .zip file should not contain subfolders; all content should be on the same level.

Navigation Toolbar (Enterprise only)
This panel lets you customize the Navigation Toolbar that appears in your custom viewer at the bottom of the library. See “Navigation Toolbar (Enterprise only)” on page 119.

Provisioning
Application ID  Specify an application ID unique to the application. If possible, use the reverse domain syntax, such as “com.publisher.publication.” Use only periods, hyphens, and basic alphanumeric characters (a-z, A-Z, 0-9).

Note: In previous versions, the DPS App Builder added an “air.” prefix to the Application ID (example: “air.com.adobe.dpstips”). If an app you already submitted to the Amazon Appstore includes the “air.” prefix, add it to your Application ID in DPS App Builder. To view your existing Application ID in Amazon Appstore, sign in to the Amazon Developer Portal, open your app, and click the Binary File tab to view the “Package” setting.

Build Details
After you specify information or files for all mandatory fields, click Submit Build, and then click Finish.

The amount of time it takes to create the development and distribution apps depends on how busy the server is.

Testing the development app  Download the .apk build, add it to one or more Android devices, and test the app. Follow the instructions in Publishing Process for Android Mobile Devices.
**Downloading and testing the Android viewer app**

When you download the generated .apk file, you are prompted to specify certificate information. Google requires all applications to be signed by a valid certificate before they can be run on Android devices. For instructions on creating this certificate, see *Publishing Process for Android Mobile Devices*.

1. Select your viewer app in the Manage page where your custom viewer builds appear.
2. Click Android Installer (.apk) to download the Android viewer app.
3. Specify your developer p12 certificate and password, and then click Download And Sign.
4. Add the .apk file to one or more Android devices.

**Submitting and managing the viewer app**

After you download and test your custom viewer, submit the distribution viewer (.zip) to Google Play Store or Amazon Appstore.

*Submitting the development app* If your developer app works as designed, submit the app (.apk file) to the Google Play Store or Amazon Appstore. Follow the instructions in *Publishing Process for Android Mobile Devices*.

*Changing the approval status* When your submitted app is approved and appears in the store, please open DPS App Builder and click the Approval Status next to the custom app. Enter the information and click Submit. A link to your app will be added to the *Digital Publishing Gallery*.

*Updating a build* If you need to create different icons or make other changes, select the viewer app on the main page, and click Edit. Your information and selections remain intact. Make the necessary changes, and then submit the build again. Your app will be updated.

*Deleting a build* If you no longer need the developer and distribution apps, select the viewer app on the main page, and click Delete.

**About custom viewer apps for PlayBook devices**

The DPS App Builder no longer includes support for PlayBook devices.

**Create a custom Adobe Content Viewer for iPad and iPhone**

If you have a Professional or Enterprise account, you can use the DPS App Builder to create your own version of the Adobe Content Viewer for the iPad. The ability to build your own custom Content Viewer offers two advantages. First, when a new version of the Folio Producer tools becomes available, you can test the new features while the Adobe Content Viewer is awaiting approval. Second, the Preview on Device feature is enabled in the custom Adobe Content Viewer.
If you sign in using an Enterprise account, you can create an Enterprise signed app that you can distribute within your company. If you don’t create an Enterprise signed app, the Adobe Content Viewer is available only on iPads in which the device IDs (UDIDs) are specified in the developer mobileprovision file. For information on creating mobileprovision files, see the “Publishing Companion Guide for the iPad PDF” available for download on the DPS Dashboard or from the Help menu in the DPS App Builder.

1. Sign in to the DPS App Builder using a Professional or Enterprise account.
2. In the DPS App Builder, click New, and then select iPad and click Next.
3. For Viewer Version, choose Adobe Content Viewer. Click Next.
4. Do either of the following, and then click Next:
   - (Professional) Specify the developer mobileprovision file.
   - (Enterprise) If you select Enterprise Signed Build, specify the Intended Application ID (such as “com.publisher.viewer”) and Enterprise Mobileprovision file. Use the same Intended Application ID that you used on the Apple Developer site to create the Enterprise Mobileprovision file. For information on enterprise-signed apps, see “Creating an enterprise-signed viewer app” on page 128.
5. Click Next, and follow the prompts.
6. Download and sign the Adobe Content Viewer.
7. If necessary, make the Adobe Content Viewer (content-viewer.ipa) available for distribution.

To install the Adobe Content Viewer, drag the content-viewer.ipa file into your iTunes library, and then sync your iPad.

It isn’t necessary to delete the App Store version of the Adobe Content Viewer. You can have different versions of the Adobe Content Viewer on your iPad. In fact, you can sign in to the two different viewers using different accounts.

The Adobe Content Viewer stops working when your developer mobileprovision expires. Non-Enterprise mobileprovision files are set to expire after three months.

More Help topics
“Use Preview on Device” on page 93

Creating an enterprise-signed viewer app

If you have an Enterprise edition of the Digital Publishing Suite, you can create iPad and iPhone apps for internal distribution only. An enterprise signed viewer app is distributed within the company rather than downloaded from the Apple Store.

A subscription to Apple’s iOS Developer Enterprise Program is required to create an enterprise signed viewer app. An Apple enterprise subscription removes the 100-device limit for development apps. For more information on using the Developer Enterprise Program, see the Enterprise Deployment Guide.

1. Sign in to the Apple iOS Dev Center using an enterprise ID, and create an enterprise .p12 certificate and mobileprovision files.
2. In the Folio Producer web client, publish folios to be included in your in-house app using Free and Public settings.
3. In the DPS App Builder, specify details in the Basic Details and Splash Screen panels.
4. In the Certificates section of the DPS App Builder, specify your development and distribution .p12 certificate, password, and mobileprovision file information.
   The distribution details are not used for your in-house app and should not be submitted to the Apple Store.
Select the Enterprise Signed ID option, and specify the Intended Application ID.
The Intended Application ID is usually in the "com.publisher.publication" format.

Build the app, and download the development Test Viewer (.ipa) file.
Distribute the mobileprovision file and the .ipa file through email or a server. Instruct users to install both files by dragging them into their iTunes library and syncing with the iPad.

For more detailed instructions, see Distributing enterprise iOS viewer applications with Digital Publishing.

Creating a custom library (Enterprise)

If you’re an Enterprise publisher, you can replace the default viewer library with a custom library that you create.

Create the .zip file containing the HTML code you want to use for the custom library. For information on creating the HTML files, see Implementing separate library and store functionality.

In DPS App Builder, create or edit an entitlement viewer.
In the Navigation Toolbar section of DPS App Builder, click the Library icon in the black bar under Customize and Test the Toolbar and Custom Icons.
Click the icon next to Use Custom Viewer Library, and specify the .zip file containing the HTML code you created.

For additional information about creating custom libraries, see Creating an HTML implementation of the DPS default library by Derek Lu.
Chapter 6: Analytics and Services

Omniture analytics

The Analytics page of the DPS Dashboard lets you track the user data of your custom viewer app. When you subscribe to the Adobe Digital Publishing Suite with a Professional or Enterprise account, you get access to base-level analytics powered by Omniture for all your apps. This data includes the number of issues downloaded and purchased, the top content and ads, and the number of application installations. If you have an Omniture SiteCatalyst account, you can get access to more detailed user data.

To avoid analytics data that displays "::unspecified::," specify titles for all articles in article properties. Also, whenever possible, give real names to your overlays to make it easier to interpret analytics data. For example, use "Twitter Link" instead of "Button 4."

Analytics White Papers
For basic details about analytics, see Digital Publishing Suite analytics tutorial (PDF).

For details about optimizing analytics, see Adobe Digital Publishing Suite, Analytics Service (PDF).

For details on using SiteCatalyst analytics, see Adobe SiteCatalyst Digital Publishing Report Guide.

Setting up Omniture Analytics

When you sign up for a Digital Publishing Suite subscription (Professional or Enterprise), you are assigned a master account ID that lets you use the Account Administration tool. Use this tool to assign the “Application” role to an Adobe ID. As part of that process, you provide the necessary information to enable Omniture analytics. Once you provide this information, it can take as long as five days to enable analytics. See "Account Administration tool" on page 132.

If you believe that your analytics account is not set up properly, contact an Adobe representative. Gold support contact information appears on the DPS Dashboard.

If you have an account with Omniture SiteCatalyst, you get access to the full set of Omniture SiteCatalyst features at my.omniture.com.

View analytic data

1 Sign in to the Adobe Digital Publishing Suite Dashboard.

Only an Adobe ID account provisioned with the application role lets you view the Analytics page. To view analytics, use the same Adobe ID that is used in the Folio Builder panel to upload content for your custom Viewer app.

2 Click Analytics.

Reports for your custom Viewer app are loaded.

3 To analyze your data, do any of the following actions:

View a different report On the left side of the Analytics page, click a different report type, such as Individual Purchases or Ads.

Change the date range Use the From and To calendar icons to specify a range of dates. Then click Update.

Specify the folio After you specify a date range, select the folio to view the data.
Sort data  Click the column heading in any table to sort the data by that column. Click again to reverse direction, such as from A to Z or Z to A.

To download a .csv file containing information about billable downloads that can be viewed in a spreadsheet application, click Fulfillment Report.

This .csv file includes the number of downloads from the Adobe Distribution Service charged against your download count.

Sell digital content

You have a variety of different ways to sell your digital content through app stores, from a one-time sale of a single-issue viewer to an ongoing subscription model. Available options vary based on which edition you have.

You can create and sell digital content using the Apple App Store, Google Play Store, and Amazon Appstore.

Related Articles

<table>
<thead>
<tr>
<th>To do this</th>
<th>Go here:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understand the types of viewer apps</td>
<td>“Types of custom viewer apps” on page 94</td>
</tr>
<tr>
<td>Create folios for mobile devices of different sizes</td>
<td>“Creating documents for multiple devices” on page 39</td>
</tr>
<tr>
<td></td>
<td>“Create folio renditions” on page 108</td>
</tr>
<tr>
<td>Create a Single Edition viewer app</td>
<td>“Single Edition overview” on page 9</td>
</tr>
<tr>
<td>Create a custom viewer app to submit to a store</td>
<td>“DPS App Builder” on page 113</td>
</tr>
<tr>
<td>Create an enterprise-signed iPad application for internal distribution only</td>
<td>“Creating an enterprise-signed viewer app” on page 128</td>
</tr>
</tbody>
</table>
Account Administration tool

Before the Account Administration tool was available, an Adobe representative provisioned Adobe IDs to work with DPS tools. With the Account Administration tool, an administrator in your company can create and provision accounts. You can create assign three types of roles to accounts, all of which are based on Adobe IDs. For background information about Adobe IDs, see "Using Adobe IDs for digital publishing" on page 5.

<table>
<thead>
<tr>
<th>Name</th>
<th>Account ID</th>
<th>Administrator</th>
<th>Application</th>
<th>Viewer Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bob Bringham</td>
<td><a href="mailto:bobbringham@yahoo.com">bobbringham@yahoo.com</a></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>A</td>
<td>DSM Tips</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>B</td>
<td>Max Bringham</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

Account Administration tool
A. Delegate accounts assigned Application roles  B. Delegate account with no roles assigned (not recommended)

Master and delegate accounts
When you subscribe to the Digital Publishing Suite, one account from your company is assigned the Administrator role. This is called the master account. The master account does not appear in the Account Administration tool. You cannot remove or edit the master account.

When you use the master account to sign in to the Account Administration tool, you can assign delegate roles to other accounts. A delegate role is directly tied to the master account. Each delegate account requires its own email address. You can assign delegate roles based on an existing Adobe ID which has not yet been verified to work with DPS, or you can create a new delegate Adobe ID based on an existing email account. However, you cannot create a delegate account from an Adobe ID that has already been verified to work with DPS.

Once an Adobe ID (and its associated email address) is used for a delegate account, it is difficult to untie the Adobe ID from the delegate account.

Important: Be cautious about using individuals’ email addresses for delegate accounts. Once you use an Adobe ID as a delegate account, that Adobe ID can be used for digital publishing only with your company. Removing the Adobe ID disables it from using any DPS features.

An Adobe ID that is not assigned to any specify company account is called a designer account. Designer accounts can be created at https://digitalpublishing.acrobat.com/CreateAccount.html.

To change an email account associated with an Adobe ID, see Changing the email associated with Adobe ID.

Types of delegate roles
After you add a delegate account to your company, you can assign as many as three roles to that account.

Administrator The master account is assigned the Administrator role, but you can assign the Administrator role to other accounts. An account that is assigned an Administrator role can use the Account Administration tool.

Application With an application role, you can associate a custom viewer with published folios. Use a different Adobe ID for each custom viewer you create. Avoid using the Adobe IDs of individuals. For example, if you publish multiple
cooking magazines, you can create one Adobe ID for grill cooking (dps.grillcooking@cooktoday.com), one for Creole
cooking (dps.creolecooking@cooktoday.com), and so on.

Use the Application account to create and publish folios and view analytics. When you specify the Application ID in
the DPS App Builder, the custom viewer you create displays the folios published with that account.

**DPS App Builder** With a DPS App Builder account, you can sign in to the DPS App Builder and create custom viewer
apps. You can use the same Adobe ID for both the Application account and the DPS App Builder account, or you can
create a DPS App Builder account that lets you create apps using one or more Application accounts.

**Best practices for account administration**
For best results, create dedicated email addresses for delegate accounts using a company domain. For example, the
following accounts could be used for a company that publishes cooking magazines:

- Application accounts: dps.grillcooking@cooktoday.com, dps.creolecooking@cooktoday.com, and
dps.frenchcooking@cooktoday.com
- DPS App Builder account: dps.builder@cooktoday.com
- Administrator account: dps.admin@cooktoday.com
- Delegate account with no role: dps.janedoe@cooktoday.com

In this example, one DPS App Builder account would be used to sign in and publish all three magazine viewer apps.
Another approach is to assign both an Application role and a DPS App Builder role to the same account.

In this example, a special delegate account was created for Jane Doe. Jane uses this account to publish proprietary
information for the company. Jane should use this account only to create content for this particular publisher.

Do not use the admin tool to create or assign Adobe IDs of individual designers to your company account unless you
want to limit those accounts to using DPS tools only for your company. Individual designers can create valid Adobe
IDs using the DPS Dashboard ([https://digitalpublishing.acrobat.com/CreateAccount.html](https://digitalpublishing.acrobat.com/CreateAccount.html)).

Delegates are directly affected by the master account. If a master account is closed, all delegate accounts are also closed.
Content downloaded from a delegate account is charged against the master account. Any content published by the
delegates will be charged as downloads against the master account.

**Using the Account Administration tool**
2. Click Account Administration.
   - If the Account Administration option is dimmed, the account you used to sign in does not have Administrator
     privileges. If you sign in using your primary account ID and don’t have access to the Account Administration tool,
     please send a message to dmpubsup@adobe.com to request that your account be enabled. Once the primary
     account is enabled, that user can sign in and enable additional administrator accounts.
3. In the Account Administration panel, click Add New Users.
4. In the New Users dialog box, do either of the following:
   - For an existing Adobe ID that has not yet been verified to work with DPS, specify the Adobe ID of the user you
     want to modify, and click Submit. If the Adobe ID has been verified to work with DPS, it cannot be added.
   - To create a new Adobe ID, first create a valid email account, but don’t sign in to any DPS service. Click Create
     A New Adobe ID, specify the information, and click Create Account. A message is sent to the email account.
     Click the link in this message to specify a password and verify the account.
5. In the Account Administration panel, select the user, and click Configure User.
Under Add Roles, specify the role type—Application Accounts, DPS App Builder Accounts, or Account Administrator—that you want to assign to the account. Click Enable, and fill out the necessary information.

### Assigning an Application account to an Adobe ID

#### Specifying Store Settings for an application

When editing the Application account, you can specify shared secret information. Shared secret information is required in iOS for subscription viewer apps and for all Amazon viewer apps that have retail folios.

While Apple calls this information code a “shared secret,” Android calls it a “public key,” and Amazon calls it a “shared key.” If you offer any retail content for a viewer that appears in Amazon Appstore, the shared key is required. For details on obtaining a shared secret, see the publishing guide associated with the platform.

Use the same shared secret information for all apps. Avoid changing the shared secret.

**Note:** After you specify the shared secret information, sign in to the DPS Dashboard using that Application account. Signing in to the Dashboard authenticates the shared secret.

Under Store Settings, you can also specify the iTunes Application URL once your app is published in iTunes. This URL is used in the social sharing workflow to let share recipients download the app if it’s not installed.

### Enabling first retail folio free for an application

Select the option under First Issue Entitlement to make the most recently published retail folio available to users who download the app for the first time.

If users remove the promotional retail folio, they can download it again. If they uninstall and reinstall the app, they are entitled only to the original promotional folio, not to the most recently published retail folio.
Specifying Web Viewer information
In the Web Viewer section of the Application section, specify the following options:

**Application Name** The Application Name you specify appears in the title bar when a shared article is viewed in a Web Viewer browser.

*Note:* Also specify the iTunes Application URL under Store Settings so that share recipients are prompted to download the app if it’s not installed.

**Enable Web Viewer** Select this option to let users view your articles in the Web Viewer in a desktop browser. If you enable Web Viewer, article views are counted against your download fulfillments as described in “Social media download counts” on page 142.

If you deselect this option and enable Social Sharing in DPS App Builder, social sharing links point to the Publication URL you specify in DPS App Builder, not to Web Viewer articles. The Enable Web Viewer setting has no effect when Social Sharing links are tapped on an iPad or iPhone.

*Note:* Web Viewer is disabled for trial accounts.

**Redirect URL** If the shared article cannot be found, the Redirect URL you specify appears. Create a Web page with information about your app.

**Enable Fulfillment Limit** This option is useful for putting a limit on the overall number of articles that can be viewed in Web Viewer. Once this limit is reached, any user who tries to view a shared article in Web Viewer on the desktop is redirected to the Fulfillment Limit Reached URL that you specify. Create a Web page with information about your app.

**Enable Paywall** You can set up a paywall for Web Viewer articles of free or retail folios. When users click links to view articles you marked as unprotected, they can continue viewing all unprotected articles in that folio unless you set a limit, or threshold. When users hit the limit, a paywall page appears with a button that links to a URL you specify. Create a Web page with information about your app.

**Paywall Button URL** Specify the URL where you can give users information about downloading and purchasing your app.

**Paywall Text** Specify a brief message that appears on the paywall page. For example, you can state that the maximum number of articles has been viewed and that users can click the link to learn more about the app.

Specifying Analytics information
When editing the Application account, you can specify information to set up an Omniture analytics account. User data of your content is automatically collected and is available to Professional and Enterprise customers. The configuration of the Analytics integration is slightly different for Professional account owners and Enterprise account owners.

**Professional** Entering data in the Analytics field is optional. Professional account owners who are already SiteCatalyst customers can have all the analytics data sent to a dedicated report suite under their SiteCatalyst account. If you do not have a SiteCatalyst account, do not enter report data. The analytics data is collected in an Adobe internal account.

**Enterprise** Enterprise accounts are asked to specify a report suite name and can optionally specify the name of the company if they already have a SiteCatalyst account.

*Note:* When you specify a report suite, do NOT specify any of the following reserved prefixes: adp.in, adp.da, or adp.sj.

When you submit the SiteCatalyst information, it can take as long as five business days to set up Omniture analytics for your app. See “Omniture analytics” on page 130.
Maintaining your DPS subscription

If you have an up-to-date DPS subscription with Adobe, you can submit viewer apps to app stores and publish folios, and your customers can download the folios you publish. However, if your account with Adobe becomes out of date or if you run out of fulfillment downloads, services can be restricted or cancelled.

Adobe sends email messages to the admin user in your account to notify you when your account is nearing termination date or when your maximum number of download fulfillments is approaching. These email messages include instructions for keeping your account up to date. If you suspect that you are not receiving these emails, please contact your Adobe representative. Gold support contact information appears on the DPS Dashboard.

Restricted Publishing and Folio Fulfillment

You can be restricted from publishing folios, and your customers can be prevented from downloading folios in either of the following situations:

- If you have not renewed your Professional or Enterprise subscription within 30 days of your subscription termination date.
- If you have exceeded your maximum number of purchased downloads.

If you have fulfillment downloads available but fail to renew your subscription, your customers can continue downloading folios for 30 days after your termination date. Thirty days after your termination date, Adobe reserves the right to restrict your customers from downloading your folios.

When folio downloads are restricted, any free folio, archived free folio, or retail folio becomes “temporarily unavailable.” A customer who taps the Download or Buy button is informed that the content is unavailable and asked to try again later.

Paid subscriptions are honored. Published folios that any subscriber has not yet downloaded are available for subscribers to download. Those downloads are counted against the publisher’s account.

Customers are entitled to any folio they paid for. A customer who taps the Download button of an archived retail folio is allowed to download the folio. Those downloads count against the publisher’s account.

Canceled Account

If you have not renewed your DPS subscription or if you do not purchase a download bundle within sixty days of your termination date, Adobe reserves the right to remove your content from the Distribution Service and downgrade your account. All single-issue viewer apps remain available in the App Store.

Updating Your Account

To avoid a restricted account, keep your subscription updated and purchase additional download fulfillment bundles. If necessary, contact your Adobe representative.

Viewing fulfillment download counts

You can generate reports to view download data from the Adobe Distribution Service. If you sign in to the DPS Dashboard using an Application account, you can choose the Fulfillment Report option to download a .csv file that includes billable download statistics from the Adobe Distribution Service for that app. If you sign in using an Admin account, you can click a link in the Dashboard to obtain a report that shows the fulfillment download balance for your account. For details, see Understanding Folio Download Counts.
Subscriptions and entitlement

In-app subscription options are now available on iOS and Amazon. You have a variety of subscription options available, including Apple’s subscription model (Professional and Enterprise) and a custom entitlement server (Enterprise only).

Apple and Amazon subscriptions
When users subscribe to your app through iOS or Amazon subscription, they are entitled to all folios in which the Publication Date falls between the start date and end date. They’re also entitled to the most recently published folio when they first subscribe. For example, if a user signs up for a six-month subscription on November 10, the start date is November 10 and the end date is May 10. After subscribing, the user can download the most recently published folio as well as any folio in which the Publication Date is between Nov. 10 and May 10. If users don’t renew the subscription, they are still entitled to those six months of content.

As a best practice, you should use the Folio Producer Organizer to manage your Publication Date settings for your folios. If you publish a quarterly magazine, use consistent publication date settings, such as January 1, April 1, July 1, and October 1, even if you actually publish those folios on different dates. As long as you continue publishing consistently, your subscribers will be entitled to the appropriate amount to content.

For information on setting up subscriptions and entitlement for custom iPad viewer apps, obtain the iPad Publishing Companion Guide PDF from the DPS Dashboard. For information on setting up subscriptions for Amazon Appstore apps, see the Amazon Appstore developer site.

Custom entitlement servers
For information on setting up a custom entitlement server to control subscriptions through your own site, contact your Adobe representative. Developer content is also available at the Digital Publishing Suite Developer Center.

Restricted distribution
Restricted distribution is the method to make content available only to a small group of readers based on their user profiles or credentials. By default, a limited set of folios are presented to the user. Only after the user has signed into the app will additional folios be shown. The list of selected folios to be shown is based on the user’s authorizations. For details about restricted distribution, see Using Restricted Distribution with Digital Publishing Suite.

Push notifications
You can let customers know about new or updated folios before they open your viewer app. If you set up push notifications using the Adobe push server, a push notification can inform the user that a new issue is available, or it can trigger a background download of the new issue if the app is in the iOS Newsstand.

Publishing a folio no longer triggers an automatic push notification. After you publish or update a folio, you can trigger a push notification when you’re ready by clicking the Notify button in the Folio Producer Organizer. To make content delivery to devices more reliable, Adobe’s push server sends notifications at a constant rate over time, not all once.

The push notification experience is different for Newsstand and non-Newsstand apps:

**Non-Newsstand apps** When the publisher clicks the Notify button to indicate a new or updated folio, users see the red badge on the app icon.

Last updated 2/8/2013
**Newsstand apps** When the publisher clicks the Notify button to indicate a new or updated folio, only subscribers to the app see a red badge on the Newsstand icon that indicates the number of folios downloaded in the background. A blue “New” sash appears on the app cover in Newsstand until the subscriber opens the app. For both subscribers and non-subscribers, the cover image is updated to reflect the newest folio cover. Push notifications are required for Newsstand apps.

For information on creating the push notification certificates that Apple requires, download the iPad Publishing Companion Guide PDF from the DPS Dashboard.

**Setting up third-party push notifications (Enterprise only)**
When using DPS App Builder to create your custom viewer app, you can use the Adobe push notification server, or you can specify your own push notification server.

Many different options are available for creating a third-party push notification server. When setting up your server, note that the viewer sends the following information:
newsstandEnabled => 0 (this is '0' when newsstand is enabled)
badgeEnabled => 1
token => <device specific token>
soundEnabled => 2
devId => <device specific guid>
alertEnabled => 4
targetDimension => <device specific string>

Besides accounting for these basic properties, you can create additional properties. For example, if you use the same push server for multiple applications, specify an additional name/value property (such as “app => cycling”) when setting up the server. In the DPS App Builder, specify these additional properties in the Custom Push Parameters field of the Provisioning panel.

HTTP Status message of 417
If you receive an HTTP 417 status message when attempting a push notification, an SSL connection with Apple APNS cannot be made using the push notification certificate. Make sure that the push notification certificate is valid and not expired.

Using social sharing

When you create a custom multi-issue viewer app for the iPad or iPhone, you can enable Social Sharing. Your customers can choose an option in your viewer app to share the article through Facebook, Twitter, email, or copy and paste. This message includes either a link to the publication URL or to the article, depending on whether you protected the article. Anyone who clicks the article link can view the article contents in the Web Viewer of a desktop browser or on an iPad or iPhone.

If you enable Social Sharing, views of the shared articles on the Web Viewer desktop are included in download fulfillment counts. For details, see "Social media download counts" on page 142.

Social media customer workflow
For best results, take the following actions when you set up your folios:

- Create a 1024x768 folio using any image format. PDF articles are now uploaded to the Web Viewer server using PNG format.
- Create folio renditions for all device models. Any article shared from an iPhone or iPad HD maps to the iPad SD (1024x768) rendition in Web Viewer, and the article link maps to the appropriate rendition on the device.
- If you’re creating renditions, use the same Article Name values for the corresponding articles in each rendition to make sure that the shared article maps properly in Web Viewer and across devices. Also make sure that your folio renditions are set up properly. See “Create folio renditions” on page 108.

When your customers open an article in your viewer app, they can tap the sharing icon and select any enabled social media option: Facebook, Twitter, Email, or Copy Link.
Depending on which option they selected, customers can sign in, type a comment, and specify other information. For example, if they chose Email, they specify recipients and type a message.

If the article is protected, the link on the Facebook wall, Twitter feed, or email message goes to the publication URL you specify in DPS App Builder. If you unprotected the article, the link goes to the article.

Users can either click the article link in a desktop browser or tap the link on an iPad or iPhone. What happens when users click or tap the article link depends on the following factors:

**When shared from 2048x1536 (HD) folio** If the customer shared the unprotected article from a 2048x1536 folio, the article link is available for the desktop Web Viewer only if you set up a 1024x768 rendition with a matching article name.

When the link is tapped on an iPad or iPhone, users can purchase (if retail), download, and view the article if renditions are set up properly. If there is no 1024x768 or iPhone rendition, only users with the HD iPad can view the article.

**When shared from 1024x768 (SD) folio** If the customer shared the unprotected article from a 1024x768 folio, anyone who clicks the link on a desktop computer should be able to view the article in a supported browser.

Anyone who taps the link on any iPad should be able to purchase, download, and view the article. Anyone who taps the link on any iPhone model can purchase, download, and view the article only if iPhone renditions are set up properly.

**When shared from an iPhone** If the customer shared the unprotected article from an iPhone, the article link is available for the desktop Web Viewer only if you set up a 1024x768 rendition with a matching article name.
Anyone who taps the article link on an iPhone can see the iPhone SD version if the article was shared from an iPhone SD folio or from an iPhone HD folio with a matching SD rendition. If there is only an iPhone HD version, it cannot be viewed on iPhone SD.

**When user taps article link on an iPad or iPhone** In most cases, a landing page with a “Read the Article” button appears. (If Facebook deep linking is enabled, the landing page is bypassed.)

- If your app isn’t downloaded on the user’s device, the app appears in the App Store. Once downloaded, the app opens as usual. Customers can then purchase and download the folio.
- If your app is already downloaded on the user’s device, tapping Read the Article on the landing page prompts the user to purchase or download the folio. When the folio is downloaded, the linked article is downloaded first and appears when the user taps View.
- If both the app and the folio are downloaded, tapping Read the Article displays the article.

**When user has reached the article limit in Web Viewer** A paywall page appears with a Learn More button. This information is displayed in the Account Administration tool.

**When the app’s article limit is reached** The Fulfillment Limit Reached URL specified in the Account Administration tool is displayed.

**Supported Web Viewer features**

Supported browsers include Internet Explorer 9, Explorer 10, Safari, Firefox, and Chrome. Internet Explorer 8 is partially supported, but it doesn’t handle HTML articles, videos, and other overlays properly. Mobile browsers cannot display the Web Viewer versions of articles.

Customers who share the article must have iOS 5 or higher on their iPads for article sharing to work.

Not all overlays are supported at this time in the web viewer. Panoramas are not yet supported, and certain Web Content overlays might behave unexpectedly. Articles set to Horizontal Swipe Only are not flattened in the Web Viewer. For best results, use DPS App Builder to create a development app and test your unprotected articles in Web Viewer.

**Setting up social sharing for your viewer app**

To set up social sharing, do the following tasks:

- To enable social sharing to work with Facebook, register your app with Facebook. Enabling social sharing for Twitter, email, and copy/paste requires no setup tasks. For instructions registering with Facebook, see [Setting up a DPS App for Social Networking](#).

- Use the Folio Producer Editor to indicate which articles are protected. When you publish or update the folio, the contents of unprotected articles are uploaded to a website on an Adobe server. The content should be available soon after the folio is published, but not immediately. If the folio you unprotect is retail, users who click the article link can view the folio in the desktop Web Viewer. However, iPad users who click the link must pay for the folio to view it unless they’re already entitled to it. See “Folio Producer Editor” on page 101.

- Use the Account Administration tool to enable social sharing and, if desired, limit the number of unprotected articles customers can read and set up paywall information. See “Account Administration tool” on page 132.

- Enable social media in the DPS App Builder when creating or updating your viewer app. See “Create a custom viewer app for the iPad and iPhone” on page 113.

**More Help topics**

“Social media download counts” on page 142
Social media download counts

If you use DPS App Builder to enable Social Sharing in your viewer app, DPS allows readers to view your articles in browsers using the DPS Web Viewer. These views count against your fulfillment count as follows: when the number of article views within the Web Viewer reaches the number of articles (both protected and unprotected) in the folio, this is counted as one fulfillment against your Fulfillment Bundle.

For example, suppose that you enable Social Sharing in an app that includes a folio with 50 articles. If one person reads all 50 articles of that folio in the Web Viewer, this counts as one fulfillment. Or, if 50 different people each read one shared article, this counts as one fulfillment. In this example, any combination of article views that adds up to 50 within that folio is counted as a fulfillment. This example is for clarification purposes only. See Section 3.4 of the DPS Terms of Use for the specific terms and restrictions related to use of the DPS Social Sharing features and Web Viewer.

For details, see Understanding Folio Download Counts.

More Help topics
“Using social sharing” on page 139